User Guide for

O. E. E. MANAGEMENT
SOFTWARE

Version B.4 and B.4S

Supporting Data Storage via...

: i ﬂn Microsoft
e, PS8BT server

A CAPSTONE
METRICS

2001-2015 Capstone Metrics LLC

www.capstonemetrics.com



Table of Contents

CHAPTER 1. SOFTWARE FUNCTIONAL OVERVIEW 5
CHAPTER 2: OEE AND TEEP EXPLAINED 6
OEE OVERVIEW 6
AVAILABILITY 6
PERFORMANCE 7
QUALITY 7
WHAT Is TEEP? 7
OEE CALCULATION METHODS 9
CHAPTER 3: NAVIGATING OEE MANAGEMENT 11
GETTING HELP 11
USING THE TOOLBAR MENUS 12
USING THE MAIN WINDOW 13
USER LOGON 14
VIEW AUDIT REPORT 14
FiscAL YEAR TREND WINDOW 16
QUICKTREND WINDOW 18
ANDON VIEW WINDOW 20
SEQUENCED OPERATIONS WINDOW 23
MANAGING OEE ALERT NOTIFICATIONS 25
CREATE OEE DATA FORMS 27
Copy OEE DATA TO EXCEL WORKSHEET 27
Exit OEE 28
CHAPTER 4: FILTER / REPORT MENU 29
GENERAL 29
FILTER SET UP PAGE 29
MULTIPLE SELECTION 30
REPORT MENU PAGE 31
OEE SNAPSHOT REPORTS 32
PAYNTER CHARTS 34
SEND TO MICROSOFT® EXCEL 35
CONVERT TO MICROSOFT® WORD 36
MULTIPLE REPORTS 36
REPORT SCRIPTS 37
ANALYSIS PAGE 39
SLIDE SHOW FEATURE 41
CHAPTER 5: ENTER OR EDIT PRODUCTION ACTIVITY DATA 43
ENTER A NEw PRODUCTION ACTIVITY - STEP 1 43
ENTER A NEW PRODUCTION ACTIVITY - STEP 2 (PART LEVEL) 46
ENTER A NEW PRODUCTION ACTIVITY - STEP 2 (TOOL LEVEL) 49
UsSING THE ACTIVITY OEE DISPLAY 52
EDIT OR DELETE A PRODUCTION ACTIVITY 52
PART NUMBER ASSOCIATIONS 54
IMPORTING OEE DATA 54
ENTER AND REPORT BULK UNITS 55
CHAPTER Al: ADMINISTRATION OVERVIEW 58
GENERAL 58
SETTING OEE GoALs 58
WORK CENTERS — OPTIONS FOR CONFIGURATION 60
USER SETUP 64

CHAPTER A2: APPLICATION INSTALLATION (ACCESS VERSION) 65

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 2



CONTENTS OF OEE MANAGEMENT SOFTWARE SYSTEM ZIP FILE 65
QuickK INSTALL FOR OEE MANAGEMENT SOFTWARE 65
INSTALLATION OF OEE MANAGEMENT SOFTWARE ON YOUR NETWORK 65

CHAPTER A3: APPLICATION INSTALLATION (SQOL SERVER VERSION)67

CONTENTS OF OEE MANAGEMENT SOFTWARE SYSTEM ZIP FILE 67
QUICK INSTALL FOR OEE MANAGEMENT SOFTWARE 67
INSTALLATION OF OEE MANAGEMENT SOFTWARE ON YOUR NETWORK 67
CHAPTER A4: MISCELLANEQUS INSTALLATION NOTES 69
PREPARE A USER PC FOR OEE MANAGEMENT SOFTWARE 69
USING MICROSOFT® Access 2007 — 2010 RUNTIME VERSION 70
CHAPTER A5: APPLICATION SETUP, 72
SETUP FOR DEFAULT VIEWS 72
SETUP FOR DATE AND TIME FORMATS 73
SETUP FOR USER DEFINED FIELDS 74
SELECTION OF OPTIONAL FEATURES 76
LINKING PARTS AND ToOLS TO WORK CENTERS 76
SETUP FOR DOWNTIME EVENT START/STOP TIMES 78
SETUP FOR STANDARD DOWNTIME EVENTS 78
SETUP FOR AUTO SPEED LOSS DOWNTIME 81
SETUP FOR AUTO UNIDENTIFIED TIME DOWNTIME 82
SETUP FOR REWORK DOWNTIME EVENTS 83
SETUP FOR FACTORED DOWNTIME EVENTS 83
SETUP FOR DEFECT OR DOWNTIME COSTING 86
SETUP FOR LABOR TRACKING 87
SETUP FOR SLIDE SHOWS 87
SETUP FOR FISCAL YEAR REPORTING 88
SETUP FOR EQUIPMENT HIERARCHY 89
SETUP FOR TOOLING 91
SETUP FOR OEE COMBINATION RULES 96
SETUP FOR TIME LOSS CATEGORIZATION 99
SETUP FOR BULK UNITS TRACKING 101
SETUP FOR CREATE FORMS OPTIONS 102
SETUP FOR COPYING OEE DATA TO EXCEL 102
SETUP FOR EMAIL MESSAGING OF ALERTS 104
SETUP FOR LocAL DB PATH 105
SETUP FOR IMPORTING PRODUCTION DATA 107
UNDERSTANDING THE OEE DATA TABLES 107
INITIAL LOADING OF OEE TABLES 107
OPTION 1 - MANUAL TABLE LOADING... 108
OPTION 2 - AUTOMATIC TABLE LOADING 114
EDITING OEE TABLES 116
CHAPTER A6: TABLES AND FILES (ACCESS VERSION) 118
OEE APPLICATION FILES 118
UPDATE LINKS TO DATA FILES 119
ARCHIVING & DELETING RECORDS 120
COMPACTING APPLICATION FILES 121
REPAIRING OF DATA FILES 123
CHAPTER A7: TABLES AND FILES (SOL SERVER VERSION) 124
OEE APPLICATION FILES 124
MANAGE SQL SERVER CONNECTION 125
COMPACTING APPLICATION FILE 126
CHAPTER A8: IMPORTING DAILY DATA 128
IMPORTING DATA - OVERVIEW 128

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 3



IMPORTING DATA - FILE STRUCTURE 128

IMPORTING DATA - INDEX VALUES 130
MATCHING IMPORTED RECORDS 132
SET OPTIONS FOR IMPORTING DAILY DATA 133
CHAPTER A9: MAINTENANCE 136
UPDATING OF OEE PART TABLE 136
CHAPTER A10: MICROSOFT® TRUSTED LOCATIONS 139
OVERVIEW OF TRUSTED LOCATIONS (MICROSOFT® ACCESS 2007 AND 2010) 139
MANUALLY SET USER’S LOCAL DRIVE AS A TRUSTED LOCATION 141
MANUALLY SET A NETWORK FOLDER AS A TRUSTED LOCATION 145
CHAPTER Al1l: USING THE MICROSOFT® ACCESS RUNTIME 146
DOWNLOADING THE ACCESS RUNTIME 146
USING THE ACCESS RUNTIME 147

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 4



Chapter 1: Software Functional Overview

This section provides an overview of the function and features of Capstone OEE
Management Software. Further information on these items may be found in the later
chapters of the User Guide.

Multi-User Network installation allows shop floor data entry or import
o Software Licensed for unlimited Users and Work Centers at a single site
o Initial install allows import of Part Tables, Downtime & Quality Loss Codes, etc.
o Optional definable email notification of OEE Alert conditions

Flexible Configuration to Fit Your Specific Operational Needs
o Standard Work Center
o Multi-Flow Work Centers (i.e. different part numbers flowing together)

o Parallel-Path Work Centers (i.e. grouping similar machines configured as a single
Work Center)

o Tooled Work Centers (Supporting Multi-Cavity and/or Multi-Part Tooling)
o Equipment Hierarchy allows optional tracking of equipment and sub components
o Optional capture and reporting of Actual Work Center Labor vs. Standard

Capturing Loss Events... Downtime Handling
o Optional use of Event Start & Stop Times (vs. Duration Only)
o Standard (Preplanned) Downtime Events automatically created
o Calculated Downtime Events (Speed Loss or Non-Reported Events)
o Optional Automatic Generation of Downtime for Rework Activities
o Optional Costing of Downtime Losses based on Work Center hourly cost

Capturing Loss Events... Quality Losses
o Selectable Scrap or Rework and Scrap Events
o Optional Costing of Quality Losses (Scrap or Rework) based on Part cost

Processing and Reporting OEE Information...

o OEE Data is combined to provide results at all levels of the factory
TEEP Reporting provides accurate assessment of Factory Utilization
Report Filtering allows drill down to any Work Center, Part, Tool, etc.
Scripted Reports allow sets of pre-defined reports to be run automatically
Definable Slide Shows display information on shop floor, in lunchroom, etc.
Analysis Feature finds and reports trends at Part or Work Center levels
Extensive ability to export data to Excel for further analysis.

000D 00D
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Chapter 2: OEE and TEEP Explained

OEE Overview

Overall Equipment Effectiveness (or OEE) is a top-level metric that defines how well a
manufacturing unit performs relative to its design capacity, during the times that it is
scheduled to run.

OEE breaks the performance of a manufacturing unit into three separate but measurable
components: Availability, Performance, and Quality. Each component points to an
aspect of the process that can be targeted for improvement.

OEE can be applied to any individual Work Center, or rolled up to Department or Plant
levels. OEE Management Software also permits drilling down for very specific detail
analysis, such as a particular Part Number, Production Activity, or any of several other
parameters.

It is unlikely that any manufacturing process can run at 100% OEE. Many manufacturers
benchmark their industry to set a reasonable target, 85% is not uncommon.

Calculation: OEE = Availability x Performance x Quality
»» Example:

» A given Work Center experiences Availability of 86.7%.
» The Work Center Performance is 93.0%.

» Work Center Quality is 95.0%.

» OEE = 86.7% x 93.0% x 95.0% = 76.7%

Availability
The Availability portion of the OEE Metric represents the percentage of scheduled time
that the operation is available to operate.

The Availability Metric is a pure measurement of Uptime that is designed to exclude the
effects of Quality, Performance, and Scheduled Downtime Events.

Calculation: Availability = Available Time / Scheduled Time
»» Example:

» A given Work Center is scheduled to run for an 8 hour (480 minute) Production
Activity.

» The normal Production Activity includes a scheduled 30 minute break when the Work
Center is expected to be down.

» The Work Center experiences 60 minutes of unscheduled downtime.
Scheduled Time = 480 min - 30 min break = 450 Min

Available Time = 450 min Sched - 60 min Unsched Downtime = 390 Min
Availability = 390 Avail Min / 450 Sched Min = 86.7%
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Performance

The Performance portion of the OEE Metric represents the speed at which the Work
Center runs as a percentage of its designed speed.

The Performance Metric is a pure measurement of speed that is designed to exclude the
effects of Quality and Availability.

Calculation: Performance = Actual Rate / Standard Rate
»» Example:

» A given Work Center is scheduled to run for an 8 hour (480 minute) Production
Activity with a 30 minute scheduled break.

» Available Time = 450 Min Sched - 60 Min Unsched Downtime = 390 Minutes
» The Standard Rate for the part being produced is 40 Units/Hour.

» The Work Center produces 242 Total Units during the Production Activity. Note: The
basis is Total Units, not Good Units. The

Performance metric does not penalize for Quality.
Actual Rate = 242 Units / (390 Avail min / 60 min/hr) = 37.2 Units/Hour
Performance = 37.2 Units/Hour / 40 Units/Hour = 93.0%

Quality
The Quality portion of the OEE Metric represents the Good Units produced as a
percentage of the Total Units Started.

The Quality Metric is a pure measurement of Process Yield that is designed to exclude
the effects of Availability and Performance.

Calculation: Quality = Good Units / Units Started

»» Example:

» A given Work Center produces 230 Good Units during a Production Activity.
» 242 Units were started in order to produce the 230 Good Units.

Quality = 230 Good Units / 242 Units Started = 95.0%

What is TEEP?

TEEP (Total Effective Equipment Performance) is another top-level metric. Where OEE
measures effectiveness based on scheduled hours, TEEP measures effectiveness against
calendar hours, i.e.: 24 hours per day, 365 days per year.

Calculation: TEEP = Loading x OEE

Where Loading = Scheduled Hours / Calendar Hours
»» Example:

» A given Work Center experiences OEE of 76.6%.
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» The Work Center Schedule is 5 Days per Week, 24 Hours per Day.
TEEP = (5x 24) / (7 x 24) X 76.7% = 54.7%

Stated another way, TEEP adds a fourth metric 'Loading’, as shown:
TEEP = Loading x Availability x Performance x Quality
TEEP, therefore, reports the 'bottom line' utilization of assets.

Overall OEE / TEEP - Cascade Chart of Equipment Utilization (15 Work Centers)
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The cascade chart shown above visually demonstrates that TEEP is the combined effect
of Loading and OEE.
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OEE Calculation Methods

The following description of calculation methods provides an outline for how the results
are calculated. With this information the user is able to verify and duplicate the results.

» Availability = Available Hours / Scheduled Hours

» Performance (Units Based) = Sum (Gross Units) / Sum (Standard Units)
» Performance (Time Based) = Sum (Gross Earned Hours) / Sum (Available Hours)

The method used for calculating Performance is selected by way of the Application
Setup Window.

» Quality = Good Units / Gross Units

» OEE = Availability X Performance X Quality

» Efficiency = Sum (Earned Hours) / Sum (Scheduled Hours)

Where:

Scheduled Units = Sum (Scheduled Hours / Standard Rate)
Standard Units = Sum (Available Hours / Standard Rate)

Gross Units = All Units Produced

Good (Net) Units = Gross Units - Reject Units + Reworked Units

Scheduled Hours = Total Hours - Scheduled Downtime Hours
Available Hours = Scheduled Hours — Unscheduled Downtime Hours
Gross Earned Hours = Sum (Gross Units / Standard Rate)

Earned Hours = Sum (Good Units / Standard Rate)

Note: Standard Rate is a value for each Production Activity, stated in Units/Hour. The
Standard Rate is found in the ‘Part Master’ and the ‘Work Center Activity’ tables

Note on Reworked Material: Any defect entries which are checked as Rework will be
treated as good product for the Quality and OEE calculations and reporting. It is
assumed, for the purposes of OEE, that the reworked material has been returned to the
value stream.

Rework penalties will typically appear in the Downtime, Performance, or Labor
Efficiency, as the rework activity generally has some negative impact on the
manufacturing process.
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The Rework data is available for review in many of the Defect based reports. To view

Rework data, make the appropriate setting in the Select Defect Events section of the
Filter Report Menu.

See Setup for OEE Combination Rules for more information on how OEE values may be
combined across Work Centers, Parts, etc.
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Chapter 3: Navigating OEE Management

Getting Help

Throughout OEE Management, help is available by clicking the help button &¥ that is
included on most windows. Other ways to access help are: hitting F10; or by selecting
‘Help” > ‘OEE Help’ on the menu bar at top of window. The Help for OEE window will

appear.

=] Help for OEE

Table of Contents

« What is OEE?
+ OEE Owerview
+ Availability
+ Performance
+ Quality
+ What is TEEP?
+ OEE Calculation Methods
« Main OEE Window
+ General
+ User Logon
+ View Audit Report

+ QuickTrend Window
+ Andon View Window
+ Create OEE Data Forms
+ Copy OEE Data to Excel Worksheet
+ Exit OEE
= Filter { Report Menu
+ General
+ Filter Set Up Page
+ Multiple Selection
+ Report Menu Page
+ Paynter Charts
+ Send To Microsoft@ Excel
+ Convert to Microsoft® Word
+ Multiple Reports
+ Analysis Page
= Window Samples

<< Hide Table of Contents

j Print this Subject @ Print Help Guide

Main QEE Window - Fiscal Year Trend Window
[The Fiscal Year Trend window provides a trended view of weekly data which covers a full
Fiscal Year. This feature allows for quick review of success trends which are keyed to the
Fiscal Year.

A
i H E Yisit Capstone

PEE’L Get pdf Help Guide

The Fiscal Year Trend displays trend charts for each of the four OEE metrics: QEE; Availability;
Performance; and Quality. The window also displays two trended Pareto charts, one for
Downtime Losses and a second for Defect Lossas.

Chart Timing Cptions:

» IUsing the 'Trend Period’ drop-down box, the Weekly Trend Charts may be set to cover any
pre-defined Fiscal Year, or a 52 Week Calendar Year.

» The 'Loss Timing' drop-down box allows selection of the time range for the Trended Loss
Pareto. Availzble options are: 4 Weeks; 4 Months (default); or 4 Quarters.

Trend Chart Features:

In addition to display of the desired QOEE Metric, the Trend Chart also includes:

» A Bar which shows prior year perforrmance for the metric.

» A Bar which shows current year-to-date performance for the metric.

» A Line and Bar which show the goal for the metric.

» Color coded Weekly bars based on goal attainment: green bars met the goal, red bars
missed the goal.

Other Features:

» Any Trend or Pareto Chart Itemn may be double clicked to produce 3 large printable chart.
» The 'Loss Scale' drop-down box, allows the scaling of the Trended Pareto Charts to be
based on either Units or Percent.

» Data from the current Trend view may be exported to a Microsoft® Excel Worksheet at
any time by pressing the Bxcel button.

Printing of FY Trend Charts:

3

Upon opening, the Help window will display the topic that is most relevant to the OEE
Management window which is currently being used. The user may browse to other
topics using the ‘Choose Help Topic’ list.

Help for OEE is sensitive to the current user logon. For example, administration topics
are available only if the user has logged on as an administrator.

Help Topics or the entire Help Guide may be printed by pressing one of the Print buttons
at the top of the ‘Help for OEE" window.
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Using the Toolbar Menus

The toolbar generally gives the most convenient access to OEE Tables and
Administrative Menus.

OEE Management

Filz Tables (L3) Admin | o&w

E Tableg\g ___(___J_i%@.\ 7 &
Edit Downtime Codes Edit Monthly Goals Application Setup

Edit Scrap Codes Edit Part Master i User Identities

View DB Locking File
Edit Shifts Edit Departments i £

£f Compact OEE.mdb

‘L Compact OEEData.mdb
3% Repair Database

@ Mass Record Delete

View Table Contents Report Edit Work Centers
View Work Center Report Edit Work Ctr Activities
Edit Equipment
Edit Tooling

=5 Update Links

Edit Downtime Types

User Def, Wrk Ctr Field 1
User Def. Wrk Ctr Field 2
User Def. Part No. Field
User Def. Scrap Field

View Table Contents Report
View Work Center Report

The Tables (L2), Tables (L3) and Admin toolbar features become visible for Logons at
Level2, Level 3 and Administrator, respectively.

Note that the Admin Toolbar Menu is slightly different for the SQL Server version...
Application Setup

i User Identities
§ View DB Locking File

IHI Compact OEE.mdb
2% Repair Database
@ Mass Record Delete

=5 SOL Setup
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Using the Main Window

The Main window is used to find and view OEE data for any selected Production Activity.
The range of activities which are visible on this view are set by selecting the View Data
Range at the top of the window.

o ™y

OEE Management (Administrator Logged On - Level 3)

+ CAPSTONE | [*®tVi®W: [CToday [ Yesterday o Logon [F1] | W [ Import | g
"
AT i” FETRICS| Range 01May-13 [ 01-May-13 [E|| B new Activity [F2] P Bukunits |
J Day Shift Prod | Part Mumber Wark Center Department |
T 01-May-13 3 10:03 PM | 11:28 PM 30 008235 Press 1 Molding
o 1-May-13 3 10:03 PM | 11:28 PM 30 934234 Press & Molding
O 01-May-13 3 12:43 AM | 1:51 AM 120 |859132 Press 7 Molding
o 1-May-13 3 12:43 AM | 1:51 AM 120 |445129 Press & Molding
o 1-May-13 3 2154 AM | 4131 AM U] 132859 Line E Painting
o 1-May-13 3 2154 AM | 4131 AM 130 |291621 Press 3 Molding
o 1-May-13 1 0:08 AM | 8:26 AM 130 291641 Press 9 Molding
O 01-May-13 1 3120 AM | 9:260 AM 34 283141 Line C Painting
o 1-May-13 1 3120 AM | 9:25 AM 34 162129 Line D Painting
o 1-May-13 1 10:25AM  12:17PM | 140 (164129 Line C Painting

Filter Criteria: (Prod Date 01-May-13 - 01-May-13)

F¥ Trends | QuickTrends | = andon Wiew | [M]5equenceOps | 2 Downkirme | f2) Deferts | " Filter [Reports |
7 | ﬁ g audit | 42 Farm | HéExceI| I My .ﬁ.lerts| Excit
Main OEE Window
Ways to select the View Date Range:

» The date range for viewing may be quickly set to Today's or Yesterday's date (or both)
by checking the appropriate box.

» The 'Calendar' button may be pushed, which pops up a calendar for selecting a range.
Once visible, the calendar dates are chosen by clicking on any two dates. Upon pressing
the Calendar's 'Done' button, the selected dates become the view range.

» Dates may be manually entered into the first and last date boxes.

To View or Edit OEE Data for a Production Activity:

Double-Clicking on any Production Activity will open the Activity Entry window for that
activity. (Note that no changes may be made to the Production Activity unless the User
is Logged On and has Edit rights as set by the Administrator.)
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User Logon

In order to enter or edit any data in the OEE Application a User must be Logged On and
that user must have Enter/Edit Rights. (Which are set by the Administrator)

Reports and data may be viewed by any user without requiring a Log On.

I's N

Log On Window

Name | Jane Doe |

Password ]

Logon I LogOff I

Cancel l

Press for
Administrator Log On ~—1 Change Password |

R

Log On Window
To Logon:

» Press the 'Logon' button on the Main window. (Or the ®T icon on the toolbar)

» Select User Name from the 'Name' dropdown box. (A name may also be selected by
beginning to type the name into the Name box)

» Type User's Password into the 'Password' box.
» Press the 'Logon' button.

Now the Main window will return with the User's Name and User Access Level appearing
at the top of the window.

To Change a User Password:

» Select 'User Name' from the 'Name' dropdown box. (A name may also be selected by
beginning to type the name into the Name box)

» Type User's Password into the 'Password' box.
» Press the 'Change Password' button.

» On the Change Password window, enter the new password into each of the two
boxes. The password must have at least 4 characters, alpha or numeric. The password
is not case sensitive, i.e.: Dog is the same as dog.

» Press the 'Change Password' button to accept the new password. This password is
immediately in effect.

The Current User may Log Off by returning to the 'Logon' window and pressing the
Logoff button.

View Audit Report
Audit Report:
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The Audit Report is designed to give a one page view of what Production Activities have
been entered for the selected date. This report is used to quickly determine if all data
has been entered for that day.

The Date for the Audit Report is changed by pressing the 'Calendar' button, which will
pop up a calendar. Click on the desired day, then press 'Done' to return.

Now, pressing the 'Audit Reports' button will open the report. The report may be viewed
on screen, or printed by pressing the 'Print' button.
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Fiscal Year Trend Window

The Fiscal Year Trend window provides a trended view of weekly data which covers a
full Fiscal Year. This feature allows for quick review of success trends which are keyed to

the Fiscal Year.

The Fiscal Year Trend displays trend charts for each of the four OEE metrics: OEE;
Availability; Performance; and Quality. The window also displays two trended Pareto
charts, one for Downtime Losses and a second for Defect Losses.

F¥ Trends
40
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T ANMHM e A-nNAd 10
T g ; , , ] T
_ o L W
gz 5 §  Ef £
2 ] i
(W 2= & i @
i TH AL H ] ] NAA‘ ____"“l_&ll\-_ﬁ_——
_ s = IIF— i H
J &
_ _ _ _ 250
~ T HHH B i e TR R 200
120
100
S0
0 , , , T
T o = 3 5
5 = = C =
m o X 5 ) u"'-_"
5 L i £
1] ] =]
Period © CY & Fv [ Select Reporting Level Trend Ehartkliegga Farsto Elhart LEQE:':'
. . Wee Jul-2010
Tiend Perind| Y2010 =) 4 € Plantwide o Aug2010 O]
Loss Timingl 4 Months *I 5 " Department I [~ Last\éearl _.. SOEI?‘_-%iS E
. oa ct-
Loss Scalel Uriits o & work Center| Line 1 1| volume (Cases) |

CEE Trends -

2

Line 1

¥ 2010 (04-Jan-10 - 02-Jan-11) for Work Center:

single Print || Batch Print |

&' Combo Chart
" E Chartz

Done |

Fiscal Year Trending Window

Chart Timing Options:

» Using the "Trend Period' drop-down box, the Weekly Trend Charts may be set to cover
any pre-defined Fiscal Year, or a 52 Week Calendar Year.
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» The 'Loss Timing' drop-down box allows selection of the time range for the Trended
Loss Pareto. Available options are: 4 Weeks; 4 Months (default); or 4 Quarters.

Trend Chart Features:

In addition to display of the desired OEE Metric, the Trend Chart also includes:
» A Bar which shows prior year performance for the metric.

» A Bar which shows current year-to-date performance for the metric.

» A Line and Bar which show the goal for the metric.

» Color coded Weekly bars based on goal attainment: green bars met the goal, red bars
missed the goal.

Other Features:

» Any Trend or Pareto Chart Item may be double clicked to produce a large printable
chart.

» The 'Loss Scale' drop-down box, allows the scaling of the Trended Pareto Charts to be
based on either Units or Percent.

» Data from the current Trend view may be exported to a Microsoft® Excel Worksheet
at any time by pressing the Excel button.

Printing of FY Trend Charts:

» The current view may be previewed or printed in the Combo Chart format (combining
6 charts) by pressing the 'Single Print' button.

» Individual Charts may be selected for previewing or printing by double-clicking on the
desired chart.

» Batch Printing of charts may be performed by selecting the 'Reporting Level'
(Department or Work Center), then selecting the Report Type (Combo Chart or 6
individual Charts), then pressing the Batch Print button. The reports will be sent directly
to the default printer.
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QuickTrend Window

The QuickTrend window is intended to provide an overview of results for the selected
items. This feature allows for fast analysis of trends that might otherwise not be
apparent. If a particular trend is of interest, use the Filter Report Menu to investigate
further.

Eight thumbnail graphs show trended values for:
% OEE (and Goal)
% Availability (and Goal)
% Performance (and Goal)
% Quality (and Goal)
Total Good Units Produced
Total Downtime (Unscheduled)
Total Scheduled Time
Total Defect Units

QuickTrends (=@ [ 2 |
Actual M Time Perod | 8'weeks -
Trend . e N [
e Range [04/12/09 thru [06/06/09 g|
Chart Type Reliraw - Al | FeDraw - Filker I
Line I Column
|
) Filter Criteria: Show All Records - 8 Week Trend (4/12/09 - 6/6/09)
.! Done I
QuickTrends Window
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The Trend Charts include three lines:
» The blue line (or bar) indicates the Actual metric value for each week in the range.

» The purple line is a Trend Line which is calculated from a linear regression of the
Actual data. This line allows the trend direction to be seen at a glance.

» The red line shows the Goal for the particular metric that was selected.

The 'Time Period' for the graphs is selectable for 4, 8, or 12 Weeks; 7, 30, or 90 Days;
or a Custom period. (Default is 8 Weeks)

The Graphs may be drawn based on one of two options:
» 'Redraw-All'; includes all activity which occurred during the Time Period.

» 'Redraw-Filter'; includes activities which are based on the current Filter Setup and
which occurred during the Time Period. i.e.: If Dept A is selected on the Filter Setup
Page, only those activities will be included in Filtered QuickTrend Graphs. (Note that
graphs ignore any timing which is selected on the Filter Setup Page)

Any Graph may be double clicked to produce a printable Full-Size version.

» Data from the current Trend view may be exported to Microsoft® Excel Worksheet at
any time by pressing the Excel button.
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Andon View Window

The Andon View window is intended to provide a visual scan of OEE results based on
Work Center, Production Activity, and Date. This feature allows for quick detection of
trouble spots which might otherwise not show up.

Two views are available: Andon Lights or Bar Charts...

Andon View = = | 22
v Dept Detail

[+ ‘work Center Detail .

™ Shift Detai Sunday b onday Tuezday |[‘Wednesday | Thursday Friday Saturday

02/03/08 | 02/04/08 [ 02/05/08 | 02/06/08 | 02/07/03 | 02/08/08 | 02/03/08

Dept=told
Wl=Pressz 1
Shift=ALL

Dept=tdald
WiC=Presz 2 -
Mo Activity
Shift=tLL |

Dept=told
WWl=Presz 3

] Mo Activity
Shift=ALL

5:4]

Dept=tdald
WiC=Presz 5

] Mo Activity
Shift=ALL

= Time Period| Last 7D -
Chart Type Hi| Target Goal|| Avg.  Set Color Ranges e E”i:l L ._as ay? —
Andon  Bar OEE 79.9 |656.6 | | -5 |"':"1.-"-"-" 065/06/03 J

B0 e
Ay ailabilit 85.0 7.9 -BOX
Calar Change perf,:,rmar'l-r:ce o5.0 | 845 | A0 Relraw - All | HeDraw-FiIterl
0.5%

Snapl Soft Clualiby 93.0  958.6

Filter Criteria: Show All Records - 7 Day Period (2/3/08 - 2/3/08)

Lj Done |

Andon View Window - Andon Type
In the Andon View (default), the Andon Lights display the four OEE metrics:
» Red: % OEE
» Blue: % Availability
» White: % Performance
» Purple: % Quality

The light will illuminate when a particular metric is below its target value.

Two modes of Andon brilliance change are available:
» Snap: Light brilliance changes instantaneously as the metric value crosses the target
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value.

» Soft: Light brilliance gradually increases as metric value moves below target value.

Each Andon Light, when less than it's Target Value will display the shortfall numerically.
i.e.: For a target of 70.0% and an actual metric value of 65.6% the value in the Andon
light will be 4.4 (70.0% - 65.6%)

Andon Yiew

W Dept Detail
W work Center Detail

(== | £

[T Shift Detail

Sunday
02/03/08

kaonday
02/04/08

Tuesday
0z/05/08

Wednesday
02/06/08

Thurzday
02/07/08

Friday
02/08/08

Saturday
02/09/03

Dept=tdald
WiC=Presz 1
Shift=ALL

Dept=kdald
WiC=Presz 2
Shift=ALL

Dept=tdald
WiC=Presz 3
Shift=ALL

Mo Activity

Ml
ill

Mo Activity

B

Dept=told
Wil=Presz B
Shift=ALL

il
il
1l
i

Chart Type

Colar Change

snap I Soft

Target G ||F_'1

oal
0EE 79.9 | 866.5
Ay ailability 85.0  72.9
Perfarmance 95.0 | 84.5
Cluality 99.0 936

Set Color B anges

-5.0
-5.0
5.0
0.5

PR
Jolele e
[ R o o e |
Jolelee

L
aill
i

Mo Activity

=~

=EEE

Time F'eriu:u:ll Last ¥ Days 'I

nge | 05/31/09 thru | 06/06/09 E|
FRelraw - all | Reliraw - Filker I

o

a

Filter Criteria: Show All Records - 7 Day Period (2/3/08 - 2/9/08)

Done |

» Bar 1:
» Bar 2:
» Bar 3:
» Bar 4:

Andon View Window - Bar Chart Type
In Bar Chart View, Bar Charts display the four OEE metrics:

% OEE

% Availability
% Performance
% Quality

The bar color changes from blue to red when the particular metric is below its target

value.
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The Target Values which are used for determining of the brilliance of Andon Lights, or
the colors Bar Chart, may be selected from:

» Goals (Only available when Goals feature is used)
» Average (Average of all selected data for each OEE element)
The Target source may be selected by using the 'Goal' or 'Avg.' buttons

Two modes of color change are available:
» Snap: Bar color changes instantaneously as the metric value crosses the target value.
» Soft: Bar color gradually changes as metric value crosses near the target value.

The range of values which are covered by the Color Change feature are controlled by
adjusting the 'Set Color Ranges' drop-down boxes.

Date ranges for the Andon Light or Bar Chart Views may be selected from the 'Time
Period' drop-down Box:

» Last 7 Days

» Last 8 Weeks

» Last 6 Months

» Custom Days (User prompted to select a day within the desired week)

» Custom Weeks (User prompted to select a day in the last week of the desired 8 week
period)

The Andon Light or Bar Chart Views may be displayed based on one of two options:
» 'Redraw-All'; includes all activity which occurred during the selected Time Period.

» 'Redraw-Filter'; includes activities which are based on the current Filter Setup and
which occurred during the selected Time Period. i.e.: If Dept A is selected on the Filter
Setup Page, only those activities will be included in Filtered Andon Lights and Bar
Charts. (Note that Andon and Bar Charts ignore any timing that is selected on the Filter
Setup Page)

Any Andon Light or Bar Chart Item may be double clicked to produce a Snapshot Report
for that item.

Data from the current Andon view may be exported to Microsoft® Excel Worksheet at
any time by pressing the Excel button.
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Sequenced Operations Window

In many manufacturing facilities the process required to produce a finished product may
include several operations performed in a sequential or step-by-step manner. With this
in mind, the user may be interested in seeing this sequential manufacturing process
presented in a way that mimics the actual process flow.

The Sequenced Operations Window allows for defining sequential processes that include
each of the required work centers. Once defined, these sequential processes or
Sequential Ops may be reported against.

s o)

Sequenced Operations

Select Sequence:
Process 1 Step1: | work Center Act Parts
Process & Press 2 3 1157
Process 3
Process 4
Select a Sequenice S f’:'rk tr"::lantzer ;":t 'jg:‘g
far viewing sEmpy
Details of the Selected Sequence
Step 3 |work Center Act Parts
Finishing 2 3 1100
Step 4:
Add/Edit Sequences —— Add/Edit Opz |

Press ko Add ar —
Edit Sequences and
their Operations

Timne Period| “Yesterday / Weekend [+
Range[ 01May-13 -] 01May-13 @
Sequenced Ops Report |

FilterCriteria: (Prod Date 01-May-13 - 01-May-13)

d Done |

Sequenced Operations Window

The report will present each Sequence as a list of Steps, with a Summary Line below the
Steps.

To view or print the Sequenced Operations report:
» Select the Sequence Ops button from the Main window.
» Select the Date Range for which the report is desired.

» Press the Sequence Ops Report button to preview the report. Note that the button will
only be enabled if data exists within the Date Range which was selected.
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To define Sequenced Operations:
» Select the Sequence Ops button from the Main window.

» If the User is logged on as Administrator, the Add/Edit Sequences and the Add/Edit
Ops buttons will be visible.

» Each Sequence is initially defined by pressing the Add/Edit Sequences Pushbutton
then entering a Name into the next available box on the list. There is no limitation on
the amount of Sequences that may be defined.

» Once a Sequence is defined, the Add/Edit Ops button is pressed to add Ops (or Work
Centers) to the Sequence. Each sequence may include up to four Steps. Each Step may
include Multiple Work Centers.
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Managing OEE Alert Notifications

OEE Management Software will send email Alert Notifications to Users when
predetermined Alert Rules are triggered. Users may view or build their Alert Rules by
hitting the ‘My Alerts’ button on the Main window.

After a User logs on to OEE Software, the ‘My Alerts’ button will become visible. Pressing
the ‘My Alerts’ button will open the My Alerts list which displays all of the Alert Rules
which are currently set up for that User.

(Note that an Admin Logon will allow viewing and management of all User Alert Rules as
well as access to the Email Setup window.)

-

My Alerts - Motification Rules

Recipient Alert Conditions
[ 2 John User » [Quality %% < 93,5, Plantwide
John User w |Defects, All Events, in Malding Dept
John User w |Downkime Min, =15, for DT Type: Equipment, in Assembly Department

Email Setup Add Rule | Done |

Rules may be built, or defined using the ‘Rule Builder’” window. To open the ‘Rule
Builder’ window, double click an existing rule, or press the ‘Add Rule’ button.

-

Event Alert - Rule Builder

Build Event Alert Rule

Redpient: John User

Class... Type... SCOpE... Select Department. .. Select Downtime Type. ..

g Muolding All Types

Top Level Defects Flantwide ¢ e Materials
Loss Item fs Downtime & Department Equipment
Waork Center ¢~ Cperations

Quality
Base...
All Events ¢~
Minutes ¢  Exceeding | 15

Rule Desc: |D|:nwnl:ime Min, =15, For DT Type: Equipment, in Assembly Deparkment |

Cancel |
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Rules are structured as described below:
» Class: Sets the rule for response to one of the following...
Top Level OEE Metric (OEE, Availability, Performance, Quality)
Or
Loss Item (Downtime or Defects)
» Type: Sets the rule a specific parameter...
OEE; Availability; Performance; or Quality (For Top Level Class)
Or
Downtime or Defects (For Loss Item Class)
» Base: Sets the triggering rule for the Type...
All Events (For a Loss Item)
Or
Specific Trigger Value for a Loss Item or Top Level Item
» Scope: Sets the areas where the rule will apply...
Plantwide; Limited to a Department; or Limited to a Work Center.
(When Department or Work Center option is selected, a selection list will appear)

» Downtime Type: Limits the Rule to a selected Downtime Type (Only applies to
Downtime Loss Rules)

After Rules have been built and the Email Setup has been completed, OEE Software will
send Email messages to Users when a Rule condition is detected.

Once a condition has been alerted it will not be alerted again. For example: If a
particular Downtime Loss is alerted for a particular Activity, it will only be alerted at the
first Rule violation and will not be alerted again if the downtime event is edited.

To conserve on email traffic, multiple alerts for a single activity will be combined into
one email message and that message will be directed to all applicable Users.
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Create OEE Data Forms

Data for OEE Management may be collected in two ways:
» Collect data as it happens by having PC's located in the Work Center areas.

» Data may be collected on preprinted forms, then entered into OEE Management by
another person.

For the second option, there is a built in data collection form which may be printed and
used for this purpose. The form will include all active Downtime and Defect Codes to
insure that the form data is consistent.

If the User has rights that allow, the 'Create Form' button is visible at the bottom of the
'Main' window. Press button to preview, then print, the blank data form.

Copy OEE Data to Excel Worksheet
OEE Management is designed to directly transfer OEE Data to existing Microsoft Excel
Worksheets as follows:

» The target Worksheets must be set up with rows containing days of month and
columns containing various OEE data fields .

» Data is grouped by day of month, where user selects desired month.

» Up to 5 target Worksheets may be assigned. Each Worksheet must be defined with a
profile. Profiles are set up by a user with admin rights, see Application Setup section

» OEE data may be copied to as many as 10 Excel columns, with the available OEE
metrics listed below...

Scheduled Hours Downtime Hours
Available Hours Gross Units

Good Units Defect Units

Scheduled Std Units Available Std Units

% Availability % Performance

% Quality % OEE

Bulk Scheduled Hrs Actual Bulk Units
Scheduled Std Bulk Units Available Std Bulk Units

Copy Data to Excel Spreadshest

1) select Saved Profile
| Extruder Production _~ | Wiew Profile |

2) select Month
| Maros -]

| Report Filter: (Date Range: Mar 0&) |
| 1 Days Found: 3/7/2006 through 3/7/2008 |

3] Copy Data
LJ Done

Copy Data to Excel Spreadsheet Window
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To perform a copy using a saved profile:

» If the User has rights that allow, the 'Copy to Excel' button is visible at the bottom of
the 'Main' window. Press button to open the ‘Copy Data to Excel Worksheet’ window.

» Step 1 — Select the desired ‘Saved Profile’.
» Step 2 — Select the desired ‘Month’.
» Step 3 — Press the ‘Copy Data’ button.

Now OEE Management will open the target Worksheet and copy the selected data. After
completion, the user must save and close the Worksheet.

Exit OEE

Pressing the Exit button will close the OEE Application. (Or press the :'% icon on the
toolbar)

Additionally, OEE Management will automatically close when it has detected four hours
of inactivity.
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Chapter 4: Filter / Report Menu

General

The 'Filter / Report Menu' window provides access to the tools used for finding and
reporting on OEE Data. It is arranged in three pages:

» 'Filter Setup' Page - Allows for filtering data to find desired information. (Also sets up
filtering for the 'Main' window)

» 'Report Menu' Page - Provides collection of Reports and Charts.

» 'Analysis' Page — Performs analysis which identifies best and worst performers by
Work Center and Part Number.

Filter Set Up Page

The Filter is used to narrow a large amount of records down to a smaller group that the
user wants to focus on.

OEE Filter / Reports
Filter Setup %

Report Menu | Analyziz ,O | Shideshow | Iel

Select Activities:
Dept| [<] ProdDate[ 07-5ep-13 -[ 07-5ep-13 [
—lE :_EI PC1Mame * =] Set F‘.ange| Yesterday [ Weekend |«
notin use | PC2Marmne * L] shift | 2
Work Ctr | = notin use| Pllsarl *
not in use | PMiMame * =]
notin use Toor 1=
Part Nu| [
Filter Criteria: (Prod Date 07-5ep-13 - 07-5ep-13)
Select Downtime Events: Select Defect Events:
OT Type| all [ notin use|
Sched. | Unscheduled [ Rework| Scrap Only =
otinuse E SCAttrib *
CT Cudel [ Def., Codel =
Un5cheduled OT Scrap Only
0 Downtime Events Found 0 Defect Events Found

* Llzer Assignable Fields

;j 0 Activities Found Scriptl% | D’l F‘.esetFilterl Done | Apply I

Production Activities are filtered using any of several criteria in the 'Select Activities'
box...
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The 'Select Activities' box contains several Selection Boxes that allow the user to narrow
the search. i.e.: The user may select a particular department from the appropriate
'Department' box, say 'Department A'. Now the amount of Selected Records is reduced
to only those that are related to Department A.

A Date Range may be set for record selection. Methods to select the View Date Range:

» The 'Set Range' selection box may be used to select any of several preset ranges, i.e.:
Prior Week , Current Month, etc..

» The 'Calendar' button may be pushed, which pops up a calendar for selecting a range.
Once visible, the calendar dates are chosen by clicking on any two dates. Upon pressing
the Calendar's 'Done' button, the selected dates become the Date Range.

» Dates may be manually entered into the first and last date boxes.

Once the Filter Selections are made, the criteria that resulted are shown in the Filter
Criteria box. Also, at the bottom of the Filter window, the amount of the Production
Activities that meet the Filter Criteria is displayed.

Additional Filtering may be made for Downtime or Defect Events. The term - Event -
refers to any specific event of Downtime or Defect.

Downtime and Defect filtering has no effect on which Production Activities are selected.
Downtime and Defect Filtering only affects the Events which are included within the
selected Production Activities.

Filtering for Downtime or Defect Events is performed by selecting Filter Criteria in either
the 'Select Downtime Events' or the 'Select Defect Events' boxes. As is the case with
Production Activity Filters, the Event Filters also display the current Filter Criteria as well
as the amount of Event Records that result from the current filtering.

Once the Filter is set to meet the User's needs, the following options are available:

» The 'Apply' button will minimize the 'Filter / Reports' window and apply the filter
settings to the 'Main' window. The settings will be available for use the next time that
the 'Filter / Reports' window is opened.

» The 'Done' button will minimize the 'Filter / Reports' window but will not apply the new
filter settings to the 'Main' window. The settings, however, will be available for use the
next time that the 'Filter / Reports' window is opened.

» Selecting the 'Reports Menu' tab at the top of the 'Filter / Reports' window will switch
to the Reports Menu page.

» Selecting the 'Analysis' tab at the top of the 'Filter / Reports' window will switch to the
'Analysis' page.

Multiple Selection
Many of the pull-down boxes used for selecting filter setup parameters include a
‘Multiple Selection' option as the second item on the list.

To Use Multiple Selection:

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 30



» Click the 'Multiple Selection' item on the pull-down list. This will open the 'Select
Multiple Items' window. The window shows available items in the left list and selected
items in the right list.

» Items may be moved from one list to the other by double-clicking them or by using
any of the arrow buttons.

» When selection is complete, press the Done button. The Filter is now set up with these
selections.

Report Menu Page

The 'Reports Menu' page contains various reports that may be generated based on the
Filter Setup which has been established.

s ™

(OEE Filter / Reports
Filter Setup %

Report Menu | Analysis p| Slideshow | g

Reports: DT by 'WC Crosstab Hﬂl Paynter Charts:

QEE Snapszhot EE%g DT by PM Crogstab OEE: Oweral

DT Paret
EiL B iC= i DT Tood OEE. Avaiabilty |
Eff. by PM1MamMe U= by Week Tot 0T Min
EF. by Tool OT TEWK Study TatDT %
EF. by \wC - Shift DT Detai
Eff. Summany by Shift DT Opportunity by DT Min. |DEE3 Performance |
0. E. E. Summ by WwC DT Duration by Wesk
DL Sumr.n el Defects by 'wWC Crozstab . -
0.E.E. Detai Defects by PN Crosstab |DEE' Huaity |
0.E. E. by PN1Mame Defect Parsto Defect Urits

4

0.E.E. by Tool Defect Trends by Weask Delize!

Defect 12wk Stud RiEEE
0.E. E. 12wk Trend e Lo i e

Defect Detail
E quiprnent Litilizatian
Itilization Cazcade W Opporturity oy OEE

PH Opportunity ¥

Multiple Beparts FPaynter Tire Hange| 4'ieek Penod |-
| Single Report | +] EndDate[ 0B/02713 | [E
Send Ta: | @] Report Excel Grouping for OEE | Grouped by Dept El
134 Activities found S .
i at 41 Work Centers script B | =g | Done | . Apply |

Filter / Report Menu — Report Menu Tab

The left column contains Reports, while the right column contains Paynter Charts.
Clicking on the desired report or chart will open that item in preview mode, showing the
report on screen. From the preview screen, pressing the 'Print' icon on the menu bar will
send the report or chart to the default printer.
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OEE Snapshot Reports

The OEE Snapshot report provides an overall view of OEE performance for the given
filter setting. It may be produced in Landscape or Portrait format as selected from the
Filter Report Menu.

Overall Equipment Effectiveness - Snapshot
Fiter Criteria: (Prod Date 08-Jun-11 - 08-Jun-11) Scrap Only

2 100
.~ OEE 66.3%
V DT e——t - o o —
75 81.5%
Overall, this process ran at 66.3% of o,
its Designed Equipment Capacity. e | |e83%
50_.
During this period of 307 Hours Total
Time, 6Hr:45Min was Scheduled 25+
Downnme and in the remairing 300
Hofus of Planned Production T ime; o
B o e OEE  Avail.  Perf. Quality
%) X X
Goal8® GoalB2 Gola8s Gold@@
Availability Pareto Chart of Top 5 Availability Downtime Causes
o Cause 0 Mires 2000 %6
82.6% MP-Tooling Change 1325 7.3
3145 minutes were lost to Availability PR-Sensor Fail 739 41
Deownnime, Availabiliny was 8§2.6%. MC-Setup 665 37
TE-Motor Fail 165 ce
TL-Tester Fail a1 0.5
Performance Pareto Chart of 3 Performance Downtime Causes
: - o Cause 0 Mimses 2000 %
v 81.5% MA-No Schadule 300 1.7
597 minutes were lost to Performance MP-Late Delivery 245 14
Downtime and Speed was 84.9% of MH-incident 52 0.3
Standard.
Std: 91.8/Hr Act: 78.0/Hr
’ Quality There was No Quality Downtime
98.50%
Therve was No Quality Downame and
98.50% of the product started was
finished as Good Production.
Pareto Chart of Top 5 Defect Causes
Cayse 0 Units 50 3%
| Quality PPM 15.011 | SC-Start-Up Scrap 48 0.28
SU-Off Color 46 1| 025
BS-Paint Run 43 T Jd 0.23
55-Short Shet 37 : 0.20
SP-Process Scrap 20 &5 | 0.11
A
FEN
PATBY Page 1 of 1

OEE Snapshot Report
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There are three formats available for the OEE Graphic on the OEE Snapshot Report...

0 g26% 100;

Availability
0 81.5% 100,
Performance
Speedometer Format
100
75 81.5%
% 66.3%
S0
25-1
0

OEE Avail. Perf.

X | X
Goalgg Geal 82 Goal 85 Goal ¢

Bar Chart Format

Pie Chart Format

The desired format may be selected from The Filter Reports Menu. A default format may
be selected from the Setup Window.
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Paynter Charts

The Paynter Charts provide the foundation by which OEE Data is used to drive
improvement to manufacturing processes. It provides a very comprehensive view of
complex data and allows quick identification of the causes of lost performance. The data
is readable at a glance but also provides the underlying details.

The Paynter Chart format has three key sections:

» In the upper left corner a trend chart shows how the metric has performed during the
selected Chart Timing.

» In the upper right corner a Trended Pareto Chart indicates the top losses for the
selected metric, and ranks them from most significant to least significant. Also, each
Pareto bar contains a trend feature that displays how that particular cause is performing
over time.

» The bottom half of the report lists the detail that make up the Trend and Pareto
Charts. This numerical data is important for putting the charts in a realistic context.

PERCENT DEFECTIVE - 4 Week Analysis gocbeoa cuiayieinsaiiboliot baoeits:
tkfotter FWorsel  Trend Chan Parets Chart
25% 0.8% » A
2.7% B
20% 0.6% =
/\ 05% 2
15% | N ’” 0.4% g
" . =
-— / 0.3% A — Z
1.0% - - 0.2% 4 F =
v |
it [ 7= ] Al
05% 0.0% + - — — L
g 5 s . - »
00% £€ 5 % 5§ ; § X ’I’
S o - - § z o P 2 2 b a® ¢ ®
2 pS TS 58 3 % w oy w4 9§
= 0= ¢S 9= < - o % - ul <&
= = = - WS 100 WE 17-2n WIE 2430 WiE 3t Quanud, %%
e
Cﬂl@gow ViB 10-Jan WiB 17-Jan W8 24-Jan ViE 31-Jan J-Jan 1-Feb 2¥eb 1¥eb L¥eb 5-Feb G-Fed
FamRys 038 T 0 32 < 3t a2
o4To & 22t o8 02¢ a2 4 2 2 2 2
Sunlp S 813 SRH] 318 93 8.3 oz 23 2
Frcess S oh iz a2 014
=3 Coem 214 214 9.43 s
Shen Cye < 02
ST 2 B H
FantDamazes 8 w 0
ronSns K o 2 2
Cezppes Pant = bl 0z 3
Bsordurace 03 s
Sanzefee 2 03
Vet See s 1
AITren 2 4
-y 23 [ 4 4 2 £ Fl
291 Geala W
/A
LI\ Mondey, Januery 31, 2002 Pegelof 1

Paynter Chart
Paynter Charts are provided for the following datasets:
» The key OEE metrics
a) OEE

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 34



b) Availability
c) Rate
d) Quality
» The underlying Availability metrics
a) Downtime Minutes
b) Downtime Percent
» The underlying Quality metrics
a) Defect Units
b) Defect Percent

The Charts may be customized using the controls below the Chart List:

» 'Chart Timing' - User may select '4 Week Analysis'; '4 Month Analysis'; 'Current Year
By Month'; or 'Prior Year By Month'.

» 'Ending Period' - User may select 'Current Period' or 'Last Full Period'. Current Period
will display the current partial period (week or month) as the last period for the Chart.
Last Full Period will set the last period of the Chart to the prior week or month.

» 'Grouping for OEE' - For the four OEE Metric Charts (OEE, Availability, Rate, Quality)
the data may be grouped by 'Department’ or by ‘Shift’. For the Non-OEE Metric Charts
(Downtime and Defect), this control is ignored, since the data will be grouped and
ranked by the cause (Downtime Cause for Downtime Charts and Defect Cause for Defect
Charts)

Send To Microsoft® Excel

Many of the OEE Reports may be exported to a Microsoft® Excel Worksheet rather than
being printed.

The items which are NOT exportable to Excel are:
» OEE Paynter Chart collection
(These items are largely graphic-based and do not contain the required underlying data)

To export a Report's data to Excel:

» Setup the Filter to obtain the desired information.
» On the Reports Menu Page, press the 'Send To:' button to the ‘Excel' option.
» Click on the desired Report.

» Browse to the folder where the new Excel Worksheet is to be saved. A default file
name is assigned to the new Worksheet - this filename may be changed by the user at
this point.
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Convert to Microsoft® Word
Many of the OEE Reports may be exported to a Microsoft® Word document.

To export a report to a Word document in Rich Text (.rtf) format...

» While viewing a report, select the Word 'W' button on the toolbar.

» Now Microsoft® Word will open and display the Rich Text version of the report.
» The Word document may now be saved and closed.

» Note that reports that do not readily export to Microsoft® Word will not contain the
'W' on the toolbar.

Multiple Reports

Generally, selecting a report from the Report Menu will generate that report for viewing.
The 'Multiple Reports' pull down menu on the 'Reports Menu Page' allows for reports or
charts to be printed in groups.

There are four options on the 'Multiple Reports' pull down menu...
» 'Single Report' - This is the default setting which produces only one report.

» 'Report for each Department' - This setting will produce one Report for each active
Department.

» 'Report for each User Defined Grouping (PC1)' - This setting will produce one Report
for each active item in the User Defined Group. (This option is subject to the current
Filter Set Up which may be used to limit the multiple reports to a certain Department or
group of Departments)

» 'Report for each Work Center' - This setting will produce one Report for each active
Work Center. (This option is subject to the current Filter Set Up which may be used to
limit the multiple reports to a certain Department or group of Departments)

»» Example of use for the 'Multiple Reports' option...

A User wants to produce a set of 'OEE Snapshot' reports for posting at each Work
Center within 'Department A'.

The procedure is...

» Go to 'Filter Set Up' page

» Set the 'Dept' pull down menu to 'Department A’

» Set the 'Prod Date' range to reflect the desired time period

» Go to 'Reports Menu' page

» Set the 'Multiple Reports' pull down menu to 'Report for each Work Center'
» Click on the 'OEE Snapshot' item on the report menu.

Now a group of reports will be sent to the User's default printer.

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 36



Report Scripts

The Report Scripts Feature provides a method to create and save a group of reports that
may be printed routinely. When a particular report is saved to the script, it will include
any selected filtering (i.e.: Work Centers, Shifts, etc.). The saved report does not
contain any date range information. Saved reports will be printed based on the ‘Prod
Date’ range that is selected on the ‘Filter Setup’ tab at the time that the script is printed
or previewed.

-~ -

OEE Filter / Reports
Filter Setup %

Report Menu | Analyzis }D | Shdeshow | Iel

Select Activities:
Dept| [<] ProdDate[ 07-5ep-15 -| 07-5ep-13 |
i s PCiMame * [=] Set Range' Yesterday [ Weekend [«
notin use PC2Name * =l shift] L]
Work Ctr| [ notin use| Pllsgr] *
notin use | PH1Name * [l
notin use Too* 1=
Part No| =
Filter Criteria: (Prod Date 07-5ep-13 - 07-5ep-13)
Select Downtime Events: Select Defect Events:
DT Type| all [ notin use|
Sched. | Unscheduled =] Rework| Serap Only =]
notin use [@E SCAttrib *
CT Cude' [ Def. CDdEI [
UnScheduled OT Scrap Only
0 Downtime Events Found 0 Defect Events Found

* ser Assignable Fields

0 Activities Found Script &, | ResetFilter | Done | Apply |
| I[} &+ Print F'review| Show:| &+ All I'v1ir'|e| Indude v
1 S——
QEE &napshot Incude All Record

0. E/E. by Mald Includ
Pareto Incude Al Records
12 Wk Study Indude Al'gecords

RERECIE

EURTIE S|

v T T %

Save last repork Preview selecked  Fun Scripked Sek Mode for running
wigwed bo scripk Report Reports Scripted Reports
» Running a Report Script...

Any User may run a saved Report Script by selecting the desired Prod Date range on the
‘Filter Setup’ tab, opening the ‘Script Window’, then pressing the Run Script button. The
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default mode for running scripts is ‘Print” which will send the scripted reports to the
default printer. If the ‘Preview’ mode is selected, the reports will be displayed one by
one for review. If certain scripted reports are to be skipped, remove the check from the
‘Include’ box.

» Saving a Report to the Script...

Open the ‘Script’ window by pressing the ‘Script’ button. Now set up the desired report
by selecting the desired filtering then displaying the report. If the report, as displayed, is
acceptable it may now be saved to the script by closing it then pressing the ‘Save’
Button on the ‘Script’ window. The new report will now be included on the Scripted
Reports list.

Reports may be saved to the script by Users with a Level 3 or Admin logon.

» Managing the Report Script...

Open the ‘Reports Script Manager’ window by pressing the ‘Manage Script’ button on the
'Script” window.

From the ‘Script Manager’ window, saved reports may be placed in the desired print
order, or may be removed from the script.

The ‘Reports Script Manager’ window is only available to Users with a Level 3 or Admin
logon.

Reports Script Manager

Re-Order or Remove Reports...

Mo | Report Filtering

2 0. E. E. by kold Include All Records
3 DT Pareta Include All Recaords
4 DT 12 Wk Study Include All Records

L& | &

Remove Report Done
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Analysis Page

The Analysis Page provides the ability to quickly identify problem areas based on their

relative performance or the trending of their results.

(OEE Filter / Reports

Filter Setup % Report Menu | Analysiz

1) Select Conditions for Analysis

B | sideshow ||C]

Best vl QEE vI Dverall vII:u_I,I Work Center - | for | 8'weeks vI

OEE ['w/ork Center | Uritz -
a4k VC Ad 7425

Tk WC C1 1698

TBx WC AG i B
B WC B2 B21

TR W () -
TAES 1A A4 T A
% 0OEE % Lovailability % Performance Z Quality
100 e
Ll == Ee =
ED)
L]
Actual Trend Goa Send to Filter OEE Snapshot
7313 Activities found at 42 Wark oo
7 Centers Script | &[> | Done | : Apply :

First Conditions are selected for the analysis:
» Select Best or Worst Units.

» Select the Metric to focus on (OEE; Availability; Performance; or Quality).
» Select whether to rank by Overall Performance of the metric, or by the Trending of the

metric.

» Identify whether to focus by Work Center or by Part Number.

» Select the Analysis Range (4, 8, or 12 weeks).

Once Conditions are selected, the 'Refresh Display' button will update the analysis.

A list of items will appear which reflect the results of the conditions. The name of the
item is displayed, as well as the metric that was selected above.

For the currently selected list item, the four Metric Charts will show each the key OEE
Metrics (OEE - Availability - Performance - Quality) in a trend chart. The arrow keys or

mouse now may be used to scan through the items.
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The Trend Charts include three lines:
» The blue line indicated the Actual metric value for each week in the range.

» The purple line is a Trend Line which is calculated from a linear regression of the
Actual data. This line allows the trend direction to be seen at a glance.

» The red line shows the Goal for the particular metric that was selected.

To provide further analysis for a particular item (Work Center or Part Number):
» Option 1:

After selecting a Work Center or Part Number from the list, press the 'OEE Snhapshot'
button to open the snapshot report. This report provides a quick analysis of the item
with Pareto charts for the Downtime and Defect events.

Option 2:

» Press the 'Send to Filter' button which will focus the report filter on the selected
opportunity.

» Go to the 'Reports' page (Click 'Reports Menu' tab).

» Run Reports or Charts, as desired to identify the underlying cause(s) of the particular
performance or trend.

At any time, the Condition selections may be changed and Display Refreshed to perform
another analysis.
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Slide Show Feature

A feature for Viewing and Creating Slide Show Presentations is available in OEE
Management Software. This feature may be of value in various locations of the factory
where current results may be displayed on a continuous basis.

Viewing a Slide Show:

If your Administrator has enabled this feature, and a Slide Show Script has already been
created, then the Slide Show may be started at any time by pressing the ‘Slide Show

Start’ button at the bottom of the ‘Filter/Reports” Window.

The Slide Show will begin sequentially displaying the scripted reports in a full screen
view. Each slide will be displayed for the slide duration time (10, 20, or 30 seconds) as
set up by the Administrator.

m- The Slide Show Control Window will be visible at the left edge of the

- screen and may be used to Pause/Resume or to Stop the Slide Show.
The window also indicates the Slide Show status as well as the current
slide number.

The Slide Show will check for presence of any new production data after each cycle of
the Slide Show Script. If new data is entered into the system during a slide show cycle,
the following cycle of the script will reflect the most current data.

Creating a Slide Show:

A Slide Show Script may be created and edited by Users who are granted rights by the
Administrator.

» Open the ‘Filter/Reports’ Window
» Go to ‘Slide Show' page (Click ‘Slide Show' tab).
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e Talanm

Filter Setup % | Report Menu |

Slide Show Script

Analysis p | Slideshow

Mo | SlideTywpe
OEE "W Scan
OEE Snapsghot
Defect Pareto
OEE Snapshot
OEE Snapshot
Defect Pareto
DT FPareto
DT Pareta

Period

Current Week
Curment Week,
Curment Week,
Current ‘week,
Current Week
Curment Week,
Current kanth
Current ‘Week,

Drept
Malding

Molding

Azzembly

o0 =] O CEss L o —

Malding

| |
Create Slide

Chart Type |

CEE Snapshot

L]
L]
Insert MNew Slide Before Slide: 1 | : |

Select Slide Parameters

Set Range| Current Day

User Fld PC1 | WC Shift

By B 2

Press & +

Dept| All

User Fid pCi| Al
Work Ctr Al
Shift] Al

Cancel | Save Slide |

0 Activities Found

a

saipt® | FD |

A Slide Show Script is made up of one or more individual slides which will display
sequentially until the Slide Show is stopped. The process for creating a Slide Show is to
create new slides — then press the Start button.

To Create a New Slide:

» Select a Chart Type from the pull down box

» Select the Time Range (typically Current Day; Current Week; or Current Month)

» Select location where the new slide should be inserted

» If desired, select a Department, User Field PC1, or Work Center for the Slide

» If desired, select a Shift for the Slide
» Press the ‘Save Slide’ button

To change the Viewing order for your Slide Show:

» Use the Up — Down buttons to the right of the Slide Show Script to change position of

slides within the Slide Show.

Slides may be edited or deleted by selecting a slide on the Slide Show Script, then

pressing the appropriate button.
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Chapter 5: Enter or Edit Production Activity Data

Enter a New Production Activity - Step 1

The 'Production Activity Data Entry' window is used to enter information from a
Production Activity. The following procedure is used to enter Production Activity data.

Activity Entry (Step 1)

# | Enter Basic Activity Data:
) Date
Department (Optional) 19-Dec-13
| ﬁsiegqbt"" = Shit ~ StartTime EndTime Minutes
ork Center
| 1ST |]/10:50 AM | 2:30 PM | 220
| Assembly 2 =]
Sequentim WGC Cnly vizible when
Select Tooling Option is
Level ——enahled [ ]
' Shift Start Duration 430 Min. Shift End
| Reset 6:30 AM Shift Timeline 2:30 PM
Activity g Parts of this Shift have already
b d.
83451C Widget Asm -] s e
Comments
Std Rate: 163.6 ‘
(% | Cancel ‘ Go To Step 2

Activity Entry Window (Step 1)

» Press the 'New Activity' button on the 'Main' window or press F2 (If the user is not
currently logged on, the 'Logon' window will appear)

Now the ‘Activity Entry' window will appear.

» (Optional) Make a selection from the ‘Department’ box. If this box is left blank, it will
be automatically filled after the Work Center is selected.

» Make a selection from the 'Work Center' box.

Following the Work Center selection, the next step will depend on whether or not the
Tooling Option is in use.

If Tooling Option is notin use:
» Make a selection from the 'Activity' box.

The 'Activity' box will include all Part Numbers that are currently associated with
the selected Work Center. If the desired Part Number is not available in the
'Activity' box there are two options....

A) Look for Part Number Department-wide:
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Check the 'All' check box next to the 'Activity' box. Now the 'Activity' list will
include all Part Numbers which are associated with any Work Center in the
Department. Now the Part Number may be selected and data entry can proceed.
Note that the selected Part Number will still NOT be associated with the selected
Work Center.

B) Associate desired Part Number to the selected Work Center:

Type the Part Number into the 'Activity' box, then hit enter. The 'Add Part to
Work Center' window will appear. A list of Part Numbers will be included which
match what was typed in. Click on one or more of the Part Numbers which are to
be associated with the selected Work Center. Now press the 'Add Selected Parts'
button. Now the Part Number(s) are associated to the Work Center.

Note: If the Part Number does not currently exist in the Part Master table,
neither of the following options will succeed. In this case, the new Part Number
must be added to the Part Master table before entry of this Production Activity
can continue.

If Tooling Option is in use:

» Make a selection from the "Tool' box or the ‘Activity’ box. (the Tool box will only
be visible when the Tooling Option is enabled)

The "Tool' box will include all Tools that are currently associated with the selected
Work Center. If the Tool is found in list, select it and proceed to the Date box.

If the Tool is not found in the list then type part or all of the Tool Name into the
"Tool ' box, then hit enter. The 'Add Tool to Work Center' window will appear. A
list of Tools will be included which match the information which was typed in.
Click on one or more of the Tools which are to be associated with the selected
Work Center. Now press the 'Add Selected Tools' button. Now the Tool(s) are
associated to the Work Center.

Once a Tool is selected, the ‘Activity’ box will be disabled. The parts which
associate with the selected tool will be included automatically once the Step 2
(Tool Level) window appears.

» Alternate Method: If the Activity Part Number information is selected first, then
the ‘Tool” box list will be adjusted to include only those tools which are associated
with the selected part. Now the Tool may be selected from the shorter list.

The result is that the entry may be made by selecting Part or Tool, whichever is
most convenient. At this point, if the part or tool selection needs to be changed,
the 'Reset’ button may be used to reopen the Tool & Activity boxes for a different
selection.

» Use of Tool Level Data Entry: After the Tool or Part selection is made, the
mode should be returned to the Tool Level by pressing the button to the left of
the Tool Select box. Whenever possible, it is always desirable to enter data at the
Tool Level rather than the Part Level. Using the Tool Level is more time efficient
and also ensures that each tool cavity is properly accounted for.
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Depending on the configuration made by the Administrator, it may be a
requirement that all production which has an associated tool is entered at the
Tool Level. i.e.: In this case, Part Level data entry is not allowed. If the
Administrator configuration does allow Part Level entries for tooled parts, then
the window will flag in red when Part Level entry is selected for a tooled part.

Following selection of Part or Tool...

» If necessary, enter the production date in the 'Date' box.

» Select the Production Activity worked from the 'Production Activity' box list.

» Setting of Activity Start and Stop Times:

OEE Software will attempt to assist in setting times as shown below...

If no other activities have been entered for the selected Work Center, Date and Shift:

The Standard Shift Times, for the selected Shift, will be used to automatically fill
the 'Start Time', 'End Time' and 'Minutes' boxes.

If other Activities are found for the selected Work Center, Date and Shift:

OEE Software will guess what the next activity times should be, based on the
time block(s) which have already been assigned to other activities.

At this point, if the automatic selection is not desired, the User is free to directly enter
Activity Start and Stop Times, or Minutes. The 'Minutes' box will update automatically as
start or end times are changed.

Once the Start and Stop Time selections are made, a visual timeline for the selected
Work Center, Date and Shift will be displayed. The timeline which indicates: Activities
which have already been assigned (Red); open time (Green); and the current selected
Start and Stop Times (Blue).

Format for Shift Time Entries:

When entering Shift start or end times, the format for data entry is dependent on how
your administrator has set up the application...

» For 12 Hour AM-PM Option...

6:25 AM is entered as 625a

10:07 PM is entered as 1007p

3 or 4 digits are required, followed by an 'a' or 'p'.
» For 24 Hour Option...

6:25 or 6:25 AM, is entered as 625

22:07 or 10:07 PM, is entered as 2207

3 or 4 digits are required.

The initial entry of Production Activity Data is now complete....
» Press the ‘Go to Step 2’ button or hit F5
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Enter a New Production Activity - Step 2 (Part Level)

The 'Activity Entry Step 2' window is used to enter remaining information from a
Production Activity at the Part Level. The following procedure is used to enter Production
Activity data.

" Activity Entry (Step 2)
d Assembly 2 7| |83451C Widget Asm (56.3/Hr) -] c|show Ar
Sequential WC Std Units/Hr - 56.3
Good Units 60
Date Shift Start Time End Time Minutes

| 01-May-13 | 1 ix/| 220 PM | 3:30PM | 70

| Enter Downtime Events [F3]: Show All ™ Min Start End Comments
» 402 Change Over E 5 | 2220PM | 2:25 PM

|| | 24-032- Final Tester [=]| 24-032-06 - Sensor [~]

#* |L| 0

| | Mo Parent Equipment Selected [=| Na Child Equipment Selected (=]

Enquipment Fields appear anly when
Enquipment Hierarchy Feature is
Enabled by Administratar

| Enter Defect Events [F4]: Show All ™ Units Rework Comments
b 24 - Scratched =l 2

#] ~l 0 ®

Comments Sched Min 70
DT Min 5
AvailMin 65 => shift [F6] | >> WC [F7] |

a Remove Std Events | s EE Snapshat | Done [F5]

Activity Entry Window - Step 2 (Part Level)
Continue from Step 1 as follows:

» Enter the amount of good production into the 'Good Units' box. This box will calculate
sums and differences.

»» Example: An activity includes two lots of production with quantities of 320 and 150.
The entry into 'Good Units' should be '320+150'. This entry will automatically change to
'470'.
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Enter Downtime events as follows:
» Enter Downtime Events area by clicking into it or by hitting F3.
» Select Downtime Reason from first box.

» Enter 'Start', 'End', and 'Min' boxes. Only two of these three boxes needs to be filled -
the third will fill automatically. i.e.: if 'Start' and 'Min' are entered, 'End' will be
calculated.

Format for Downtime Time Entries:

When entering downtime start or end times, the format for data entry is dependent on
how your administrator has set up the application...

» For 12 Hour AM-PM Time Format Option...

6:25 AM, entered as 625

12:07 PM, entered as 1207

3 or 4 digits are required.

AM or PM will be automatically filled based on the Shift that is selected.
» For 24 Hour Time Format Option...

6:25 or 6:25 AM, is entered as 625

22:07 or 10:07 PM, is entered as 2207

3 or 4 digits are required.

If the Equipment Hierarchy Feature is enabled, then fields will also be present for entry
of the equipment which encountered the issue. The equipment may be selected from
the drop-down box at two levels — Parent and Child.

» Repeat process for each Downtime event.

Note: If the Administrator has enabled the Standard DT Events feature, the Standard
Events will appear when the Activity Entry (Step 2) window opens. Note that if the
activity Start Time or End Time is adjusted, Standard Events will be added or removed
accordingly.

Enter Defect events as follows:

» Enter Defect Events area by clicking into it or by hitting F4.
» Select Defect Reason from first box.

» Enter quantity defective in the 'Units' box.

» If defective pieces were reworked into good product, place a check in the 'Rework’
check box.

» Repeat Process for each Defect event.

Note on Reworked Material: Any defect entries which are checked as Rework will be
treated as good product for OEE calculations and reporting. The Rework data is available
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for review in many of the Defect based reports. To view Rework data, make the
appropriate setting in the Select Defect Events section of the Filter Report Menu.

Entry of Production Activity data is now complete....

There are three options available at this point:

There are three options available at this point:

1)Exit Activity Entry by pressing the 'Done' button or by hitting F5.
Or, for Users with Levels set by the Administrator...

2)Enter another Activity for same Shift and same Work Center by pressing the '>> Shift'
button or by hitting F6.

3) Enter another Activity for Work Center by pressing the '>> WC' button or by hitting
F7.
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Enter a New Production Activity - Step 2 (Tool Level)

The 'Activity Entry Step 2' window is used to enter remaining information from a
Production Activity at the Tool Level. The following procedure is used to enter
Production Activity data.

Activity Entry - Tool Level (Step 2)

Shift Date Sched Min 480
| Press1 || 1 [z]| 13-Oct-13 DT Min 132
Sid Rate 352 Avail Min 348
[F2] Start Time EndTime  Min Block  Good Defect Gross
ﬁ testmold 19:00 AM | 5:00 PM [ 480 | 1193 | 7 | 1200
*|| PNOD12345 - Sample Part 345 120 (1|1 0 0 0
PN0012346 - Sample Part 346 120 0|1 | 400 0 400
PN0012347 - Sample Part 347 120 o[1 | EBH | 7 | 400
PN0012348 - Sample Part 348 120 lol1 | 400 0 400
Edit Tool DT [F3] |
_Dl:uwntime Cause Min Comments
| » |15 - Start Up 4
| *| 0
| Enter Defect Events [F4]:  Show All T~ Units Rework Comments
' » 11 - Flash =] 7 | T
¥ x] 0 | ®
Cﬂmment5|
>> Shift [F6] | >> WC [F7]
i Remove Std Events | [lax CEE Sniapshat: | Done [F5]

Continue from Step 1 as follows:

» Enter the amount of good production for each of the Tool’s Part Numbers into the
'Good Units' boxes. These boxes will calculate sums and differences.

»» Example: An activity includes two lots of production with quantities of 320 and 150.
The entry into 'Good Units' should be '320+150'. This entry will automatically change to
'470".

For convenience in entering multi-cavity tools the Defective Parts and Gross Parts are
displayed next to the Good Parts. This allows a quick visual verification that production
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from the various cavities is balanced.
» Cavity Blocking Feature

If Cavity Blocking has been enabled by the Administrator then one or more tool cavities
may be blocked at this point. This option allows one or more cavities to be ‘blocked’ or
‘shut off’ for a multi-cavity tool activity. This condition might be due to rebalancing of
inventories or a tooling issue.

To block one cavity for the selected part, put a value of 1 into the ‘Block’ box. (Note that
in a case where two cavities are producing the same part number, then the option
would be to enter 1 or 2, depending on how many of these 2 cavities are blocked.) Once
a number has been entered into the 'Block’ box, The 'Blocking” window will open. The
‘Blocked Minutes’ value will default to the Tool Runtime (ie: it is assumed that the cavity
is blocked for the entire run of the tool). At this point, if desired, a value may be entered
which is less than the default value.

Cavity Blocking

Blocking for Part: PNOD12345 - Sample Part 345
Adjust Blocking Selections below, then press Done to continue

Actual  Allocated

Cavity Count Mold Minutes 480
1 Available Part Minutes 120
1 Blocked Blocked Minutes| 120 120

Done

Blocking a cavity will have the following effect...

A Part Level Downtime Event will be automatically generated for the part number
associated with the blocked cavity. The downtime duration will be an allocation of the
Blocked Minutes based on the total cavities blocked vs. the total cavities available in the
tool. For example, if 1 of 4 cavities is fully blocked and the mold is scheduled for 480
minutes, then the blocked cavity will be charged with 120 minutes of downtime (or ¥4 of
the tools total time).

» Enter Tool Level Downtime events as follows:

Note that when entering Downtime Data at Tool Level, the downtime entered is what
occurred at the Tool Level.

i.e.: If 10 minutes were lost, that loss will automatically be split up and distributed to
each of the parts being produced. This could lead to: 3 minutes; 3 minutes; 2 minutes;
and 2 minutes, respectively, for a four cavity tool. The distributed losses are transferred
as whole numbers, which may sometimes cause a 1 minute unbalance between the
parts.

» Open the Downtime Events area by pressing the ‘Edit Tool DT’ button or by hitting F3.
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» Select Downtime Reason from first box.

» Enter 'Start’, 'End’, and 'Min' boxes. Only two of these three boxes needs to be filled -
the third will fill automatically. i.e.: if 'Start' and 'Min' are entered, 'End' will be
calculated.

Format for Downtime Time Entries:

When entering downtime start or end times, the format for data entry is dependent on
how your administrator has set up the application...

» For 12 Hour AM-PM Time Format Option...

6:25 AM, entered as 625

12:07 PM, entered as 1207

3 or 4 digits are required.

AM or PM will be automatically filled based on the Shift that is selected.
» For 24 Hour Time Format Option...

6:25 or 6:25 AM, is entered as 625

22:07 or 10:07 PM, is entered as 2207

3 or 4 digits are required.

If the Equipment Hierarchy Feature is enabled, then fields will also be present for entry
of the equipment which encountered the issue. The equipment may be selected from
the drop-down box at two levels — Parent and Child.

» Repeat process for each Downtime event.

» Now press the ‘Downtime Entry Complete’ button. This will distribute the Tool Level
Downtime to each of the tool’s parts, then return the downtime view to the Part Level.

Note: If the Administrator has enabled the Standard DT Events feature, the Standard
Events will appear when the Activity Entry (Step 2) window opens. Note that if the
activity Start Time or End Time is adjusted, Standard Events will be added or removed
accordingly.

Enter Defect events as follows:

When entering activity data at the Tool Level, defect data is required to be entered for
each part individually — at Part Level. This requirement is due to the fact that the
individual parts will nearly never experience the same defect rates.

» Select the part for which the defect data is to be entered.

» Enter Defect Events area by clicking into it or by hitting F4.

» Select Defect Reason from first box.

» Enter quantity defective in the 'Units' box.

» If defective pieces were reworked into good product, place a check in the 'Rework’
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check box.
» Repeat Process for each Defect event.

Note on Reworked Material: Any defect entries which are checked as Rework will be
treated as good product for OEE calculations and reporting. The Rework data is available
for review in many of the Defect based reports. To view Rework data, make the
appropriate setting in the Select Defect Events section of the Filter Report Menu.

Entry of Production Activity data is now complete....

There are three options available at this point:

1)Exit Activity Entry by pressing the 'Done' button or by hitting F5.
Or, for Users with Levels set by the Administrator...

2)Enter another Activity for same Shift and same Work Center by pressing the '>> Shift'
button or by hitting F6.

3) Enter another Activity for Work Center by pressing the '>> WC' button or by hitting
F7.

Using the Activity OEE Display

When Production Activity is being entered, an ‘Activity OEE’ window will be displayed to
the left of the Step 2 Production Activity window. This ‘Activity OEE’ window will display
the current OEE, Availability, Performance, and Quality metrics based on the data which
is being input. This display is useful for quickly assessing the overall validity of the data.

=a] Activity OFE =2
100 =
99.8 %
90.9 %

75— - -
% 63.5 %

50 - |
25— - -

0
OEE Avail. Perf. Quality

b B b1 B

Goal 81 Goal 83.2 Goal%3.3 Goal99.1

Since the Performance Metric is calculated based on all of the data, it can act as an
indicator of a data error. If the display calculates a Performance result which exceeds
100%, generally a result of a Downtime or Scheduled time error, the bar will be colored
yellow and will provide a warning to check input data.

Edit or Delete a Production Activity

A Production Activity may be edited or deleted at any time after initial entry. The same
User Rights are required to Edit a Production Activity as are required for initial Entry of
the Production Activity. Deletions may only be made by a Level 3 User.
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Opening a Production Activity for Editing...

» From the 'Main OEE Management' window, locate the Production Activity which is to
be edited by selecting the desired date range then finding the particular record.

» Double-click the record to open the Production Activity for editing.

» Any Production Activity data may now be edited (as long as the User has the required
User Rights).

» Any Downtime or Defect entries may be deleted by selecting the desired entry then
hitting the 'Delete’ icon ¥, on the top toolbar.

» The entire Production Activity may be deleted by selecting one of the fields at the top
of the Activity Entry window then hitting the 'Delete' icon ¥ on the top toolbar.

Any Deletion will prompt the user for confirmation before performing the deletion. Use
caution, deleted records are not recoverable. (The OEE Administrator determines the
minimum User Level which is allowed to make deletions —i.e.: User Level 1, 2, or 3)

» Exit 'Activity Entry' window by pressing the 'Done' button or by hitting F5.

Note that any User may open a Production Activity as described above, editing,
however, is only allowed with the required User Rights.

Once a Production Activity is edited, any reports or charts that are viewed will reflect the
revised data.
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Part Number Associations

OEE Management organizes all entities into a hierarchical structure. The Hierarchy is
shown below:

Level 1 - Department

Level 2 - User Defined 'PC1' (Optional)

Level 3 - Work Center

Level 4 - Part Number

Levels 1, 2, and 3 are linked together in such a way that Work Center A may belong to
one Department and one Department Only.

Level 4 is Linked to Level 3 in a more flexible way, however. Each Part Number may be
associated with a) No Work Centers, b) One Work Center, or ¢) Many Work Centers.
This flexible grouping exists primarily for the following reason:

» Each Part Number contains its own standard 'Rate' (and 'Labor’, if enabled). It may be
necessary, however, that the same part number may have two different standards when
it is run on two different Work Centers. For this reason, a given part number may be
individually associated to several Work Centers - each association may have specific
standards applied.

»» Example: Part Number 123456 has a standard rate of 30 Parts/Hr.
On Work Center A, PN 123456 runs at 30 Parts/Hr.

PN 123456 has an alternate route through Work Center B, a slower machine. On Work
Center B, PN 123456 can only run at 24 Parts/Hr. For this situation, The same part
number can be set up differently for each association.

Importing OEE Data

OEE Data may be imported (or read) from an external source. If the administrator has
enabled this feature, the 'Import' button will be visible on the Main OEE window for
Level 3 Users.

Before Importing OEE data, data file(s) must be available for import. See your
administrator for information on how this should be done.
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Import Data

Import Files Found...

CEEPOGO7Y. cav Prod File Refresh List |

QEESOR077.cav Scrap File
OEEDOGDFF.cav Downtime File

Import Progress... Mo Files Found

Import Results...
File Type  Files Records Imported  Skipped

Production 1] 0 0

Scrap 1] 0 0

Downtime 1] 0 0
2

Import File Location: C:\OEE\ImpartTables',

Import File Structure: Text (csv) File with Header Row

Import Producton Activity

To Import OEE Data...
» Press the 'Import' button on the Main OEE window.

» The 'Import Data' window will appear showing any files that are available for Import.

» Press the 'Import Files' button.

» OEE will read the files, reporting its progress in the information box.

To Correct Errors...

» If any errors are detected, the 'Errors Found...' window will appear.

» Double-click a record to open the 'Activity Entry' window for that activity.

» Make the needed correction then press 'Done'.
» Repeat the above steps until the error list is empty.

Enter and Report Bulk Units

OEE Management Software calculates OEE on the basis of single units produced. The
reasoning for this method is that it inherently provides all the detail needed to analyze
the information that makes up the top level Quality metric. It is understood that some
users may desire to track production in bulk quantities in addition to discrete or
individual units. Examples of bulk units might include ‘Pallets’, ‘Racks’, ‘Cartons’, etc.

To accomplish this, OEE Management includes a feature that allows entry, and reporting
of Bulk Units. Bulk Units are collected at a Work Center level and are defined by Date

and Shift.
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Bulk Units Entry
p | Enter Bulk Units Data:

Work Center Optional; Leave blank if shift data| gy per Hr:
| | j available from production entries,
Clear Manual Shift Times | ]
Date Shift Start Time End Time Minutes Bulk Units
| 031806 | R | | 0 | 0
J Cancel | Done |

Bulk Units Entry Window

To Enter Bulk Units...

» Press the 'Bulk Units' button on the Main OEE window. (The button will only be visible
if the administrator has enabled this feature)

The *Bulk Units Tracking” window will appear.

» Press the 'New Bulk Units' button on the ‘Bulk Units Tracking” window. (The button will
only be enabled if the user is logged on and has data entry rights)

Now the 'Bulk Units Entry' window will appear.

» Make a selection from the 'Work Center' pulldown box. (The Work Center list will only
include those that have been enabled by the administrator)

» If necessary, enter the production date in the 'Date' box. (This box will contain today's
date or the last date used)

» Select the Shift worked from the ‘Shift’ box list.
» Enter the actual Bulk Units produced in the ‘Bulk Units’ box.

NOTE: There are fields available for entering Shift times (‘Start Time’; ‘End Time’ and
‘Minutes’). These fields are generally left blank. OEE Management will find shift time
date by searching for normal production activities that match the Work Center - Date -
Production Activity combination. The shift duration that was found will be shown.

» Press ‘Done’ to complete the entry and close the 'Bulk Units Entry' window.

Deleting a Bulk Units Entry...

» From the 'Bulk Units Tracking’ window, locate the Bulk Units Entry that is to be
deleted by selecting the desired date range then finding the particular record.

» Double-click the record to open the Bulk Units Entry.

» Delete the Bulk Units Entry by pressing the 'Delete' icon ¥ on the top toolbar. View
will now return to the ‘Bulk Units Tracking’ window.

Note that any User may open a Bulk Units Entry as described above, deleting, however,
is only allowed with the required Level 3 User Rights.

To Report Bulk Units...
» Press the 'Bulk Units' button on the Main OEE window. (The button will only be visible

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 56



if the administrator has enabled this feature)
The 'Bulk Units Tracking” window will appear.

» Press the 'New Bulk Units' button on the 'Bulk Units Tracking” window. (The button will
only be enabled if the user is logged on and has data entry rights)

Now the 'Bulk Units Entry' window will appear.

» In the ‘Report Filter’ area, select desired Date Range, Department, Work Center and
Shift.

» Press ‘Bulk Units Report’ button to view or print report.
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Chapter Al: Administration Overview

General

OEE Management is configurable to match nearly any type of manufacturing operation.
The 'Administration’ features contain the tools needed to perform this configuration as
well as those for the ongoing administration of this application.

Administration tools are available only through the Administrator Logon. Administration
Logon is performed as follows:

» Press the 'Logon' button on the 'Main' window. (Or the Key symbol on the toolbar)
» Press the Toolbox button on the 'Logon' window.

» Type the administration password into the 'Admin Password' box.

» Press the 'Logon' button.

Setting OEE Goals

Many of the OEE charts and reports have the ability to display results relative to
established goals. These goals are set up using the 'Edit Monthly Goals' window.

Goal Management Features:

» Goals are entered for each of the OEE Metrics; the final OEE Goal is then automatically
calculated.

» Goals are handled by month and year, allowing them to change over time.

» Goals may be established at Plantwide, Department, or Work Center Levels, or any
combination of levels. For purposes of reporting, the lowest level goal which applies will
be used.
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Edit Maonthly Goals

Enter or Edit Goals: Select Level
e Tl e
2 ¢ Department | =1 lowest level goal which
applies will be uzed.
3 work Center I Line 1 =]
Goals for Work Center: Line 1
100% q
a0% ——
a0%
T0% —
B0% ——
S0% 4
40% T T T T T T T T T T T "
Jan Fehk Mar Ay ey Jun Jul Aug Sep Ot Moy Dec

Availability 70.0% | 70.0% | 71.0% | 71.0% | 73.0% | 73.0% | 73.0% | 73.0% | 73.0% | 75.0% | 75.0% | 75.0%
Performance 90.0% | 90.0%  92.0% 92.0% p2.0% 92.0% 92.0% 92.0% 92.0% 92.0%  94.0% 94.0%

Quality 95.0% | 96.0% | 95.0% | 96.0% | 96.0% | 98.0% | 98.0% | 98.0% | 93.0% | 99.0% | 99.0% | 99.0%
OEE 60.5% | 60.5% | 62.7% | 62.7% [ 64.5% | 65.8% | ©5.8% | 65.8% | ©5.8% | 08.3% | 69.83% | 69.8%

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Moy Dec
Copy May Goals == |

sJ Done
Erter OEE Goals

To Enter OEE Goals:

» Select the 'Tables (L3)' option on the toolbar. (Note that this option is only visible for a
Level 3 User)

» Select the 'Edit Monthly Goals' option to open the 'Edit Monthly Goals' window.
» Select the Year and Level for the goals to be entered.

» Enter the Availability, Performance, and Quality Goals for the desired Month. After
entering these values, the OEE Goal will be calculated and displayed.

» The 'Copy Goals' button may be used at any time to copy goals from the selected
month to each of the following months of the selected year.

» To enter additional goals, select a new Year or Level and repeat the above process.
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Work Centers — Options for Configuration

S it ],:> @ = @ = @

Part Flow over Time

The first, and most common arrangement is that the Work Center may process several
different part numbers, but that they must be run one at a time, i.e.: Sequentially. This
is the standard arrangement and allows for traditional OEE calculation.

-
Mixed Flow
Work Center

@

. J Part Flow over Time

The Mixed Flow Work Center option is for a Work Center to process different part
numbers - at the same time, i.e.: Mixed. This mode requires special steps to determine
the share of the total Production Activity time which is allocated to each of the part
numbers which were run through the Work Center.

The determination of how to classify Work Centers is made by the User Administrator
via the 'Edit Work Centers' window. The default setting is 'Sequential'. 'Mixed' may be
selected by checking the 'Mixed' checkbox.

OEE Handling of Mixed Flow Work Centers:

The difficulty in calculating OEE for a Mixed Flow Work Center is that the 'Scheduled
Time' for each of the part numbers run does generally not exist. OEE will allocate
scheduled time for each part number run on a Mixed Flow Work Center as described
below:
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1) Determine Earned Hours for each part number which ran (Earned Hours = Gross
Units Produced / Standard Pieces per Hour)

2) Calculate Avail Min (Avail Min = Total Production Activity Minutes - Downtime
Minutes)

3) Distribute available minutes to each part number as follows:
» PN Allocated Min = (PN Earned Hours / Total Earned Hours) x Avail Min
» Sum of PN Allocated Min will equal Total Avail Min

» All Available Production Activity time has now been allocated to each of the individual
parts, based on their respective standards

4) Downtime events are handled as follows:
» Add downtime events to any one of the PN entries for the subject Production Activity

» For that particular PN entry, the PN allocated min will be increased by the total
amount of downtime minutes charged

» Note that the 'Standard Downtime Events', 'Auto Speed Loss', and 'Auto Unidentified
Time' features will not generate automatic downtime entries for Work Centers that are
set up as Mixed Flow.

' -

Parallel Flow
Work Center

o @=>@=>0
=)o@ = ®=>®

~>@=->0=>0

PartFlow over Time

Similar Machines comprise Work Center

Parallel Flow Work Center - Some manufacturing operations utilize groups of similar
machines which perform the same work simultaneously. As an example, three drill
presses may be grouped to operate as one work center. In this case, the three drill
presses must be performing the same operation, where their combined output
represents the total output for the Work Center. It is up to the Administrator as to
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whether the three machines are handled as individual Work Centers, or be grouped into
one Work Center. The grouping alternative may be chosen to reduce the amount of
complexity in data collection and entry.

OEE Management supports this Work Center grouping method by allowing Downtime
Events within the Work Center to be factored to represent the affect of a single machine
on the combined Work Center.

Example of Factoring Downtime within a Parallel Path Work Center...

» A Work Center is comprised of three drill presses - A, B, and C. (Three parallel paths)
» One of the drill presses incurs a 60 minute Downtime Event.

» The Factored Downtime for the Work Center is 20 minutes (60 min / 3 paths)

» For Downtime analysis, the full 60 minute Downtime Event is stored as the downtime
data, but for the purpose of OEE and Availability calculations, the Factored Downtime
value is used.

In order to activate this feature:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Options' tab.
» Check or Uncheck the ‘Use Factored Downtime’ checkbox.

» Now use the ‘Edit Work Centers’ table to set the ‘Parallel Paths’ for applicable Work
Centers. (This number represents the amount of machines grouped in the Work Center
and has a default value of 1)

» Now refer to section: Setup for Factored Downtime Events to complete the setup
steps.

» Note that Downtime Factoring will not be performed on Activities that run on defined
Tooling.
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Finally, a Work Center may be set up to use Tooling. OEE Management Software allows
for tooling information to be used to ease data entry and to provide tool focused OEE
and loss reporting. For this application, tooling refers to individual units which are
designed to mount on a machine to produce a particular group of part numbers. The
tooling option is most useful when tools are utilized which produce more than one part
number during a single cycle.

If the tooling produces several of a single part number during each cycle, it may not be
worthwhile to track by tool.
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User Setup
In order to enter or edit data within OEE Management a user must be assigned an
identity and logged on. (Note that generating reports does not require any logon).

Users must be setup in the 'User Identities' table before Logon is possible. (Note that
the Administrator Logon is always available, even if no User Identities are set up.)
Procedure for adding Users:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'User Identities' option. This will open the 'User Identities' window.
» Complete the 'Name' and 'Password' fields. (The 'Title' field is optional)
» Select the 'Access Level' for the User....

0) Read Only access

1) Enter / Edit Activity Data, no Delete rights, no Table Edit rights.

2) Enter / Edit Activity Data, no Delete rights, Edit only 'Level 2' Tables.

3) Enter / Edit Activity Data, Delete rights, Edit 'Level 2' & 'Level 3' Tables, Import
OEE Data.

» Check the 'Active' checkbox (Checked by default for new User entry).

If a user becomes inactive, remove the check from the 'Active' checkbox. (For the
purpose of maintaining historical data, Table information is not deleted)
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Chapter A2: Application Installation (Access Version)

Contents of OEE Management Software System Zip File

Typically, the software is transmitted to clients via a zip (compressed) file attached to an
email. The contents of the zip file are depicted below.

OEE
£ OEE. mde

OEEData
@ AQSetup.mdb
[ OEEData.mdb

TableLoadingTools

B OEETablePartUpdate.ds
& OEEEquiptTables.xls
& OEETahbleSchemexs

Quick Install for OEE Management Software

The following steps will generally get OEE Management Software up and running.
On Network Fileserver...
1. Create a new folder named ‘OEE’ on a fileserver that is accessible to all users.
2. Place ‘OEE.mde’ and the ‘OEEData’ sub-folder in this new folder.
(sub-folder contains OEEData.mdb and AOSetup.mdb)
3. Run ‘OEE.mde’
4. Follow prompts to link to the OEEData.mdb and AOSetup.mdb files
On 1* User PC...
5. Place a COPY of ‘OEE.mde’ from server on the PC Desktop.
6. Run ‘OEE.mde’ from Desktop

At this point, the application should run, however, it is strongly recommended that
the two following sections be reviewed before proceeding further.

Installation of OEE Management Software on Your Network

The OEE Management application is written for Microsoft® Access. In order to
successfully run an Access application in a network environment, there are a few issues
that the administrator needs to be aware of. These issues are listed below.

Where to Place the OEE Files...
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FILESERVER

USER COMPUTER A ]

QEE.mde on Desktop,
Linked to server
data files

QEE

&) (OEEmd)

OEEData
[#] OEEData.mdb
@] AOSetup.mdb

Server copy of OEE.mde is linked
to data files, but is not run from

USER COMPUTER B

OEELocal

1] LocalFile

OEELocal

1] LocalFile

Local File created
automatically

this location, it is used for
distribution to User Desktops

Step 1 — Install Software on Network:
» Select a network drive that is accessible to all intended OEE users.

» Create a folder named 'OEE' near the root of this drive, for fastest operation it's best
not to bury the application several folders deep.

» Create a subfolder to 'OEE' nhamed 'OEEData’.

» Place OEE.mde in the OEE folder then place OEEData.mdb & AOSetup.mdb in the
OEE\OEEData folder.

» Run OEE.mde from the OEE folder by double-clicking it. A prompt will request you to
browse to the network location of the data files. (See page 119 'Update Links to Data
Files'

Now the application is installed and linked on the network. For optimal speed and
reliability, copies of the OEE.mde file should now be distributed to user PC's. Continue
with Step 2, below.

Step 2 — Distribute Copies of OEE.mde to User PC's:

In this step, the network-installed copy of OEE.mde is distributed to the PC Desktops of
the intended users..

» For each user PC - Drag a COPY of the OEE.mde file from the network OEE folder to
the PC Desktop. Now, the user runs OEE by opening the local copy of OEE that is on the
desktop. Note that once the network copy of OEE.mde is  properly linked to
OEEData.mdb & AOSetup.mdb, the linking will be valid from any network PC as long as
that PC can see and has R/W/X rights in the OEE folder and it's OEEData sub-folder. i.e.:
The PC copies of OEE.mde will not need to be relinked.

This 2nd Step of distributing the OEE.mde file to users will improve response time and
reduce network bandwidth usage.
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Chapter A3: Application Installation (SQL Server
Version)

Contents of OEE Management Software System Zip File

Typically, the software is transmitted to clients via a zip (compressed) file attached to an
email. The contents of the zip file are depicted below.

OEE
£ OEE. mde
|| CapstoneOEE.bak

TableLoadingTools
B OEETablePartUpdate.sds

& OEEEquiptTables.xls
& OEETahleSchemexs

Quick Install for OEE Management Software

The following steps will generally get OEE Management Software up and running.
On Network Fileserver...
1. Create a new folder named ‘OEE’ on a fileserver that is accessible to all users.
2. Place ‘OEE.mde’ in this new folder.
3. Restore CapstoneOEE.bak to your SQL Server
4. Run ‘OEE.mde’
5. Follow prompts to link to the CapstoneOEE Database
On 1% User PC...
6. Place a COPY of ‘OEE.mde’ from server on the PC Desktop.
7. Run ‘OEE.mde’ from Desktop

At this point, the application should run, however, it is strongly recommended
that the two following sections be reviewed before proceeding further.

Installation of OEE Management Software on Your Network

The OEE Management application is written for Microsoft® Access along with a
Database which resides in a Microsoft SQL Server environment. In order to successfully
run this application in a network environment, there are a few issues that the
administrator needs to be aware of. These issues are listed below.

Where to Place the OEE Files...
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USER COMPUTER A
USER COMPUTER B

OEE.mde on Desktop,

Linked to server
c:\
OEELocal

data files
() LocalFile )

|
Local File created \L__J—

automatically

Sy
\"K:":‘- Microsort

- SQLServer

(2] LocalFile )

Step 1 — Install Software on Network:
» Select a network drive that is accessible to all intended OEE users.

» Create a folder named 'OEE' near the root of this drive, for fastest operation it's best
not to bury the application several folders deep.

» Place OEE.mde in the OEE folder
» Restore CapstoneOEE.bak to your SQL Server

» Run OEE.mde from the OEE folder by double-clicking it. A prompt will request you to
provide initial information on the SQL Server Database Connection. (See: Manage SQL
Server Connection)

Now the application is installed and linked on the network. For optimal speed and
reliability, copies of the OEE.mde file should now be distributed to user PC's. Continue
with Step 2, below.

Step 2 — Distribute Copies of OEE.mde to User PC's:

In this step, the network-installed copy of OEE.mde is distributed to the PC Desktops of
the intended users..

» For each user PC - Drag a COPY of the OEE.mde file from the network OEE folder to
the PC Desktop. Now, the user runs OEE by opening the local copy of OEE that is on the
desktop. Note that once the network copy of OEE.mde is properly linked to the SQL
Server Database, the linking will be valid from any network PC as long as that PC can
see and has R/W/X rights in the OEE folder. i.e.: The PC copies of OEE.mde  will not
need to be relinked to the SQL Server Database

This 2nd Step of distributing the OEE.mde file to users will improve response time and
reduce network bandwidth usage.
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Chapter A4: Miscellaneous Installation Notes

Most application setup is performed using the ‘Setup Options’ window. To open this

Prepare a User PC for OEE Management Software

There are three considerations that need to be reviewed for any PC that will run the OEE
Management Application.

1) Location for Local Database File:

The OEE Software must create a local database file on the User PC. The local database
file is used for handling data that relates to what the user is doing. A fresh copy of this
file is created each time the user starts OEE Management. This local database file will be
automatically deleted when the user exits OEE. Once created on a PC, this OEELocal
folder will remain.

The default option will place the local folder in the ‘AppData’ folder that is automatically
maintained by Windows. This is the recommended option.

If another location is desired, see the 'Local DB Path' tab of the 'Setup Options' window.
2) Set Microsoft® Access Security or Trusted Locations:

Microsoft® Access 2002 and 2003 versions have features built in which will detect
that certain types of automation are in effect for a given application. This feature may
cause warnings at startup of the OEE Application. The OEE Application does not
threaten your machine in any way; however Access detects automation and warns the
user.

To avoid these warnings:

» Start Microsoft® Access 2002 or 2003 from your 'Start' Menu

» From Access Toolbar, select 'Tools', then 'Macro', then 'Security"'

» Security window will be displayed, select the 'Security Level' tab

» Click the 'Low' option

» Now, close Access, then run OEE

This process needs to be completed for each computer which will run the application.
For more information on Microsoft Access 2002/2003 Security, please visit...
Macro Security Levels in Office 2003

Microsoft® Access 2007 and 2010 versions protect users by encouraging that the
software being run (in this case, OEE Management Software) resides in a “Trusted
Location”. This feature may cause warnings and multiple permissions at startup of the
OEE Application if it is not running in a Trusted Location. The OEE Application does not
threaten your machine in any way; however Access treats any executable software as a
threat and warns the user.

To avoid these warnings:
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» Please refer to Chapter A10: Microsoft® Trusted Locations

This process needs to be completed for each computer which will run the application.
For more information on Microsoft Access 2007/2010 Security, please visit...
Get started with Access 2007 security - Access - Microsoft Office

3) Verify Access to Network Files:

If this PC is intended to run OEE Management with data files located on a network drive
then it should be verified that the PC has access to the ‘OEEData’ folder on the server.
This is generally an issue only if the data files are linked via a mapped drive rather than
the complete path to the folder.

Using Microsoft® Access 2007 — 2010 Runtime Version

Using the Microsoft® Access Runtime Version is an attractive alternative for those who
do not run a fully licensed version of Access. The Runtime offers the same functionality
as the licensed version but is available for free download at microsoft.com.

Note that Access Runtime Version is supported by OEE Management Software 6.0 and
greater.

» For more information on the Microsoft® Access Runtime Version refer to Chapter Al1:
Using the Microsoft® Access Runtime

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 70


http://office.microsoft.com/en-us/access-help/get-started-with-access-2007-security-HA010198047.aspx

User Group Security Setup on Network:

To insure reliable operation of a multi-user Access application, care needs to be taken in
how network security is handled for the application users. As discussed in the 'OEE
Application Files' Help section, Access maintains a database locking file (*.ldb) for each
database file (*.mdb or *.mde) which is opened. Handling of this locking file by Access
is important in order for applications to run properly.

When the first user opens an Access application, a locking file will be automatically
created. Whenever the last user exits the application, the locking file will be
automatically deleted. During the time in between, the locking file tracks who enters and
exits the application as well as a tally of data transactions. In order for the locking file
operation to occur properly, the users must have adequate rights in the directories
where the files reside.

For the above reason, any user who is to use the application would, ideally, have
Read/Write/Delete access in the directories where the application and its data files
reside. For a user without adequate R/W/X rights, the application may not be allowed to
properly handle it's locking file.

A user without write privileges will be unable to create or change the locking file. This
problem with the locking file can cause the application to open in a 'read-only' mode.
Also, this condition may cause an 'Unable to lock file' error and not permit the user to
start the application.

Users with inadequate Delete rights will be lead to failure to delete the locking file on
exit, causing the locking file to persist, even after all users have exited the application.
This condition may make it impossible for file compression, or  other  administrative
functions to be completed, as the presence of the locking file causes Access to assume
that there are still users in the application. The simplest approach is to allow all
application users full rights in the application and data directories. If this option is not
desirable, then it is possible to handle this situation by having someone  with  delete
privileges, enter then exit the application in order to clear the locking file.

“Trusted Locations” on the Network:

Microsoft® Access 2007 and 2010 require that applications (in this case, OEE
Management Software) reside in a “Trusted Location”. This feature may cause warnings
and multiple permissions at startup of the OEE Application if it is not installed in a
Trusted Location. To avoid these warnings please refer to Chapter A10: Microsoft®
Trusted Locations
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Most application setup is performed using the ‘Setup Options’ window. To open this

window:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the

Chapter A5: Application Setup

Administrator Logon is active)

» Select 'Application Setup' option. The 'Setup Options' window will now appear.

Setup for Default Views

e

Setup Options for OEE Management

OEE Management |
OEE Management Setup Features

Auto OT Calc I Case | Bulk Units | Create Forms

Qutput to Excel | Import Path | Local DB Path | Advanced

[ View | Options I Calendar | Tooling Setup | OEE Calc | Lser Fields

Default Date Range for Main Window: [ Today [ Yesterday

Default Chart Type for Andon View Window: E

Default Chart Type for Quick Trends Window: .~ Egég

Default Chart for Snapshot Repart: Eg%g 'f-q:l

Select OEE Report Format:  Standard @ Alternate
Show Guide Arrows on Trend Charts:  WeBetter| '/ Worse| [
Show OEE Display for Activity Entry | Level 3 User E

Set Defaults for Report Filtering:

Sched.| Unscheduled ||

Setup for Trended Pareto Charts:
Indude "All Others' Bar [v

Setup for Crosstab Reports: |50 Highlighting [+  Show Percent [~

OT Units: ™ Hr & Min

Show Cumulative Percentage [v

Setup for Loss Trend Charts: pmaying Average Periods [ 5 Periods -
Type: & Column ] ¢ Line s

Rework| ScapOnly |«

Pareto ChartBars | 5 :

Show Chart Average Line [

Columns: & 10 15

a

Load Part Updates | Done |

The View tab contains several options for customizing the appearance of many of the

windows and reports.

To make changes to the default views:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
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» Select the ‘View' tab.

» The default Date Range may be set for the Main OEE window. This is the default date
filtering which will be applied when a user opens the application.

» The default Chart Type may be set for the Andon View and Quick Trends Windows as
well as the Snapshot Report.

» At the bottom of the window, additional settings are available to change the
appearance of Trend and Pareto Charts.

Setup for Date and Time Formats

» The administrator may select the Time and Date Formatting for various windows and
reports. Specific Formats may be selected; or settings may be selected that correspond
to each computer’'s Windows Regional Options.

Note that the selection of the Time Format will also determine the format used for
entering time data:

» For 12 Hour AM-PM Time Format Option...
6:25 AM, entered as 625
12:07 PM, entered as 1207
3 or 4 digits are required.

» For 24 Hour Time Format Option...
6:25 or 6:25 AM, is entered as 625
22:07 or 10:07 PM, is entered as 2207
3 or 4 digits are required.

» The First Day of Week setting aligns OEE reports and filters to a work week which
begins on the specified day, i.e.: the week may begin on Sunday, Monday, etc. This
feature allows reports to correspond with the client’s specific work week.

Note that upon changing the First Day of Week setting, the administrator will be
prompted to allow OEE Management to change the Start Dates for the Fiscal Calendars,
if any exist.
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Setup for User Defined Fields

Setup Options for OEE Management

OEE Management |

OEE Management Setup Features
Auto DT Calc I Case [ Bulk Units | Create Forms
Qutput to Excel | Import Path | Local DB Path | Advanced
View I Dptions I Calendar | Tooling Setup | OEE Calc | User Fields ]
IUser Field may be set up by giving it a name, any field left blank will not
be used:

Enter Names for User Defined Fields:
_} PCiName  cal Field Description:

PCZMame Field PC1Mame: Provides
| PMiMame Customer another level of dassification
— for Wark Centers (jie: Cell

PUser1 . ) )

— designation, or other rational
|| PUser2 Comments grouping)
|| SC1Mame
|| scatirib
|| S5CUserl Comments
|| SCUser 2
|| DTuserl Comments

DTUser 2

d Load Part Updates | Done |

OEE contains several User-Defined fields:

» [PC1Name] A field that is related to production records which may be used to group
data by product grouping, manufacturing cell grouping, etc.

» [PC2Name] An additional field that is related to production records which may be used
to group data by product grouping, manufacturing cell grouping, etc.

» [PN1Name] A field that is linked to Part Numbers that allows grouping Parts into
rational sets, such as: Customer, Product Line, etc.

» [SC1Name] A field that is related to Defect Events that may be used to group data by
defective category, cost of quality grouping, etc.

» [SCAttrib] Provides an attribute that can be attached to Defect Events. This is a
"True/False' Attribute. (ie: Defect Event Occurred Downstream)

» [PUser1] A small text field that is related to production records which may be used to
group data by lot number, sales order, etc.

» [PUser2] A large text field which may be used in association with each Production
Activity, may be used for comments or other data which might be desired by user.

» [SCUser1] A large field which may be used in association with each defect record, may
be used for comments or other data which might be desired by user.

» [SCUser2] A smaller field (typically about 12 characters) which may be used in
association with each defect record, may be used for data which might be desired by
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user, a Scrap Ticket Number, for example

» [DTUser1] A large field which may be used in association with each downtime record,
may be used for comments or other data which might be desired by user.

» [DTUser2] A smaller field (typically about 12 characters) which may be used in
association with each downtime record, may be used for data which might be desired by
user, a Work Order Number, for example.

To make use of these fields:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'User Fields' tab.

» For the desired User Defined field, enter the name that is to be associated with that
field into the Name box. i.e.: Enter 'Comments' if this is how field 'PUser2' is to be used.

If the Name box is blank for a field on the 'User Field Names' window, that field is
assumed to be not used.
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Selection of Optional Features

Setup Options for OEE Management

OEE Management |
OEE Management Setup Features

Auto DT Calc I Case [ Bulk Units | Create Forms

CQutput to Excel | Import Path | Local DB Path | Advanced

View Options | Calendar | Tooling Setup | OEE Calc | User Fields

Sefup Features: Use Downtime Event Start / Stop Times [~ |
Use Standard Downtime Events [

Lock Rework Status for Rework Events W
Create Automatic DT Event for Rework [ |1
WC Level ¥ DT Code Level W A
Track Costs for Losses:
IUse Sequenced Operations Features [ ;_J
Use Labor Tracking Features [~ |4

Use Downtime Factoring:

Alternate Cyde Time Units | Seconds (Def) E

Data Entry Shortcuts F6-F7 Level | Level 1User [+
Allow Deletion of Activity or Loss | Level 3User [«
Handle Overlapping Activites| — Disallow ||

Slide Shows:

Slide Design Level | Level 3 User

Use Equipment Hierarchy [ ;_j

Downtme W Defect ¥ A

-
Use Event Motification [~ £

Use Slide Show Features [

Slide Time | 10 Sec | :

Load Part Updates | Done |

The Options tab provides customization for Labor Tracking; Downtime Event Time Entry

options; and setup for the Fiscal Year Calendar.

To make changes to these options:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.

» Select the ‘Options’ tab.

Linking Parts and Tools to Work Centers

OEE Software maintains a set of Linkages between Parts and Work Centers. This set of
relationships exists because a certain part may have differing Standard Production Rates
when it is run on different Work Centers.
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The reasoning for this Part — Work Center Linking capability is illustrated by the case
described below:

Each Part has its own Standard Production Rate (and also Standard Labor, if the Labor
Tracking Feature is enabled). It may be the case, however, that the same Part may have
two different standards when it is run on two different Work Centers. For this reason, a
given part number may be individually linked to several Work Centers - each association
may have specific standards applied.

»» Example: Part Number 123456 has a standard rate of 30 Parts/Hr.
On Work Center A, PN 123456 runs at 30 Parts/Hr.

PN 123456 also has an alternate routing through Work Center B, a slower machine. On
Work Center B, PN 123456 can only run at 24 Parts/Hr. For this situation, the same part
number may be set up differently for each linked Work Center.

e

Edit Work Center Activity
1) Select Work 2) Select Parts to Link Select by Tool
Center or Unlink (optional)
Press 1 * || n21R-g50-791 T154 . i“_ke‘:_ -
Press 2 - _ nactive Lin
P e L 155 3) Adjust Conditions for
ress 3 DR A Unfinked Linked Parts (optional)
Press 4 021R-852-711
Press 5 P |PtNo 021R-850-791 [+] Rate &0
Press & Desc EBracket LH - Malded - 588 Cyde &0
Press 7L Default r
Press 7R
Press 11 PtMo 0Z1R-686-445 El Rate a0
Press 12 Desc Bracket RH - Malded - SES Cyde &0
Press 14 Default
Press 20 0Z21R-323-474 T153 r
Prass 21 021R-5965-518 PtMo 021R-464-601 El Rate &0
Fress 27 Desc Bracket LH - Maolded - 1T4 Cyde | &0
Default

222222:3 g' Part Search | X T1i0Z " B
aesombly C . N {1107 PtNo 021R-852-711 [=] Rac*lce &0
Assembly 6L 0Z1R-604-675 Ti09 Desc| Bracket RH - Malded - 174 Cyde | 60
fissembly 201 U21R-531-873 T1l1R Default [~
Assembly 202 0Z21R-395-920 UL
Paint 1 021R-148-477 T113
Paink 2 021R-377-710 T114

021R-366-106 T113A

1560C-723-263 Ti118E

Wark Center Report |

To use the ‘Edit Work Center Activity’ window:

» Select the ‘Edit Work Ctr Activity’ option on the Tables (L3) toolbar. (Note that this
option is only visible with a Level 3 or Admin Logon)

» 1) Select a Work Center. The window will now display the Parts which currently have
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active linkage to the Work Center (Green), Parts have inactive linkage to the Work
Center (Yellow), and Parts which currently have no active linkage to the Work Center
(Red)

» 2) Now select any parts which are desired to be Linked or Unlinked from the selected
Work Center. After selecting the desired parts, press the appropriate arrow key to
change the Linking.

Note on Part Search feature: If it is desired to locate a part in an extensive list, enter
some of the part number into the Part Search box to shorten the part list to those that
match the search criteria.

» 3) Once the desired Parts are Linked, these actively Linked Parts will also be displayed
in the ‘Adjust Conditions’ list. From this list, the Standard Rates may be adjusted to the
desired values for the selected Work Center. Additionally, the Description for this
Linkage may be changed as desired. Initially this Description will default to the Part
Description as found in the Part Table.

Note on Linked Tooling: If the Tooling Feature is active, a similar set of lists will be
visible based on Tools in addition to Parts. In this case, tools may be selected as are
parts, where selection of a Tool will automatically select the Parts which are attached to
the Tool. Also, if a Part is selected which runs in the same Tool as other Parts, then
these additional Parts will also be selected.

Note on Inactive Links: Once a Part has been Linked to a Work Center and Production
has been reported against that Linkage, then that Linkage may not be removed. In this
case, The Linkage is made Inactive rather than being removed. Parts with Inactive Links
may be be made Active again if the need arises.

Setup for Downtime Event Start/Stop Times
When entering information for downtime events, it is optional whether or not the actual
stat and stop times for each event are required.

For the calculation of OEE, only the duration of each downtime event is required. The
administrator, therefore, may decide whether the data entry for downtime events will
require entry of actual start and stop times, or only the duration. Depending on how the
data is to be used, the actual start and stop times may or may not be valuable
information.

In order to select the requirement for Downtime Event Start and Stop Times:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Options' tab.
» Check or Uncheck the 'Include Start Stop Times’ checkbox.

Setup for Standard Downtime Events

In operations where standard downtime events occur at the same time each day, these
Standard Events may be configured to be included in the Production Activity
automatically. The most common example of these events would be Breaks and Meals;
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however, there are no limitations on how they may be applied.

The Standard Downtime Events feature, when enabled, will automatically add the
Standard Events that correspond to the selected shift and fall within the actual Start
Time and End Time of the Activity.

When entering a Production Activity, the Standard Events will appear when the Activity
Entry (Step 2) window opens. Note that if the activity Start Time or End Time is
adjusted, Standard Events will be added or removed accordingly.

When importing a Production Activity, the Standard Events will be automatically
included.

In order to enable the use of Standard Downtime Events:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Options' tab.
» Check or Uncheck the 'Use Standard Events’ checkbox.

If the Standard Downtime Events feature is enabled, it is necessary to setup the
Standard Events for each Shift:

» Open the 'Edit Shifts' or ‘Edit Downtime Codes' window.

» Press the 'Edit Std DT Events' button at the bottom of the window.

Now, on the 'Edit Standard Events' window:

» Select the desired shift on the left side of the window.

» Add or Edit the Standard Events on the right side of the window.

Each Standard Event must include a DT Code and the Start and End Times.
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Edit Standard Events
Select a Shift: Enter [ Edit Standard Events for Selected Shift:
3 | DT Code 1026 - Break [v] Activefy =
j;_ Min| 10 Start  9:00 AM Emc 9:10 AM 120
DT Code 1024 - Lunch || Active [7
Min| 30 Start 1100 AM End 11:30 AM 240
DT Code 102E - Break [w| Active [7 1
Min| 10 Start  1:00PM End 1:10FPM 360
#| DT Code [« Active 7
Min| 0 Start End i =
shift Start Shift: 1 Duration 480 Min, Shift End
700 AM J:00 PM
| [ [ 1 [ |
lj Done

Standard Events Entry Window

A Shift Timeline graphic at the bottom of the window provides a view of the events that

have been set up.

Note that the 'Standard Downtime Events' feature will not generate automatic downtime
entries for Work Centers that are set up as Mixed Flow.
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s ™

Setup Options for OEE Management

OEE Management |
OEE Management Setup Features

Wiew I Cptions I Calendar | Tooling Setup | OEE Calc | LIser Fields
Output to Excel I Import Path | Local DE Path | Advanced
Auto DT Calc | Case / Bulk Units | Create Forms

Speed Loss Downtime: OEE Application may be set up to automatically
caloulate this Downtime Event based on entry of actual Run Speed.

Select Standard Speed Unitz Calc Speed Loss Downtime [
i~ Usze Std Rate [Units/Hr) DT Name |*Speed Loss
7 (¢ Use Std Rate (Units/Min) Force Actual Run Speed Entry [~

Refresh Standard Speeds Re-Calc Auto OT Events

IUnidentified Time Downtime: OEE Application may be set up to
automatically calculate this Downtime Event based on Unidentified Time.

Calc Unidentified Time Downtime [
k] OEE Category | Performance OT Name |*Unidentified

Load Part Updates | Done |

Setup for Auto Speed Loss Downtime

In some cases, data may be available which will allow the loss due to reduced run speed
to be converted to a downtime event. For example, a line with a standard speed of 100
units per hour runs at 90 units per hour throughout an eight hour shift, with no
downtime. In conventional OEE analysis, this would lead to a Performance metric of
90% (90/100) for that shift.

If, however, the actual run speed is known and is entered into OEE Management
Software, then the shortfall can be converted to a Downtime Event. In the above case,
the downtime loss would be the 10% Speed Loss X 8 hours, or 0.8 hours. The result
woud be a Speed Loss Downtime event of 0.8 hours being entered automatically.

OEE Management Software will perform this calculation if the feature is enabled and if a
standard speed and actual speed exist. The Standard Speeds for the Speed Loss
calculation are maintained in the Part Master Table. The Actual Speed for each
production activity may be entered along with the other data for that production activity.
(The standard speed and actual speed fields are only visible when Speed Loss Downtime
feature is enabled)

The Auto Speed Loss Downtime feature is only available when 'OEE Loss Time
Categorization’ is set to ‘Categorized’. Any calculated Auto Speed Loss Downtime events
will be placed in the Performance element.

The Auto Speed Loss Downtime feature is only functional for Work Centers which are
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not set up as Multi-Stream.
To configure the Auto Speed Loss Downtime feature:

» Select the 'Admin’' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Auto DT Calc' tab.

» Check or Uncheck the ‘Calc Speed Loss Downtime’ box to enable or disable the
feature.

» If desired, enter a new name for the Auto Speed Loss Downtime event in the ‘DT
Name’ box (The default name is “*Speed Loss")

» Select whether or not to ‘Force Actual Run Speed Entry’. Only force the entry when
speed data is always available.

» Select “Standard Speed Units’. This allows the standard speed to be handled as a
per/Hr or a per/Min value.

» Press the ‘Refresh Standard Speed’ button to automatically repopulate the Standard
Speeds on the part master as a function of each parts Standard Rate. Example: If part
123 has a Standard Rate of 600 pieces per hour, a new Standard Speed will be
calculated based on the ‘Standard Speed Units’. A setting of ‘Unit/Min” would lead to a
standard speed of 600. A setting of ‘Unit/Min” would lead to a standard speed of 10.

» Press the ‘Re-Calc Auto DT Events’ button to automatically calculate Auto Speed Loss
Downtime events for all applicable production activities. Note that if the ‘Calc Speed Loss
Downtime’ box is unchecked, followed by pressing the ‘Re-Calc Auto DT Events’, all Auto
Speed Loss Downtime events will be removed.

» Note that the Auto Speed Loss feature will not generate automatic downtime entries
for Work Centers that are set up as Mixed Flow.

Setup for Auto Unidentified Time Downtime

When calculating OEE, any downtime events which are not specifically identified and
recorded will act to lower the Performance metric. Since this unreported time loss is
hidden in the low Performance metric, it is not readily visible.

The Auto Unidentified Downtime feature will quantify and report the 'missing time' as a
downtime event, therefore providing an incentive to insure that downtime events are
captured and recorded. The benefit of this effort is a complete picture of downtime
causes which will allow for their reduction or elimination.

When the Auto Unidentified Downtime feature is used in conjunction with the Auto
Speed Loss Downtime feature, two downtime events will be automatically generated.
First, the Speed Loss event is calculated, then any remaining unreported time loss will
appear as an Unidentified Time event.

To configure the Auto Unidentified Time Downtime feature:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
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» Select the 'Auto DT Calc' tab.

» Check or Uncheck the ‘Calc Unidentified Time Downtime’ box to enable or disable the
feature.

» If desired, enter a new name for the Auto Unidentified Time Downtime event in the
‘DT Name’ box (The default name is “*Unidentified)

» Select ‘OEE Category’ into which the Auto Unidentified Time Downtime events will be
placed.

» Press the ‘Re-Calc Auto DT Events’ button to automatically calculate Auto Unidentified
Time Downtime events for all applicable production activities. Note that if the ‘Calc
Unidentified Time Downtime’ box is unchecked, followed by pressing the ‘Re-Calc Auto
DT Events’, all Auto Unidentified Time Downtime events will be removed.

» Note that the Auto Unidentified Time feature will not generate automatic downtime
entries for Work Centers that are set up as Mixed Flow.

Setup for Rework Downtime Events

Some manufacturing processes may require an intermittent ‘On-Line’ Rework activity
which causes a delay on the line. OEE Management allows this to be handled
automatically. During entry of the Work Center activity, selection of a Rework (Defect)
activity that has an established Standard Rework Time will cause an associated
Downtime Event to be created automatically.

The Downtime Event will only be created if the Rework Downtime Events feature is
enabled and if the selected Rework (Defect) code has an assigned time on the Edit
Defect Codes table. The duration of the Downtime Event is equal to the Standard
Rework Time multiplied by the quantity reworked.

In order to activate this feature:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Options' tab.
» Check or Uncheck the ‘Create Automatic DT Event for Rework’ checkbox.

» Now the Standard Times for the desired Rework Causes, as well as the Downtime
Code for each Rework Cause, may be entered on the ‘Edit Defect Codes’ table.

Setup for Factored Downtime Events

Some manufacturing operations utilize groups of similar machines which perform the
same work simultaneously. As an example, three drill presses may be grouped to
operate as one work center. In this case, the three drill presses must be performing the
same operation, where their combined output represents the total output for the Work
Center. It is up to the Administrator as to whether the three machines are handled as
individual Work Centers, or be grouped into one Work Center. The grouping alternative

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 83



may be chosen to reduce the amount of complexity in data collection and entry.

OEE Management supports this Work Center grouping method by allowing Downtime
Events within the Work Center to be factored to represent the affect of a single machine
on the combined Work Center.

Example of Factoring Downtime within a Parallel Path Work Center...

» A Work Center is comprised of three drill presses - A, B, and C. (Three parallel paths)
» One of the drill presses incurs a 60 minute Downtime Event.

» The Factored Downtime for the Work Center is 20 minutes (60 min / 3 paths)

» For Downtime analysis, the full 60 minute Downtime Event is stored as the downtime
data, but for the purpose of OEE and Availability calculations, the Factored Downtime
value is used.

» Note that Downtime Factoring will not be performed on Activities that run on defined
Tooling.

There are two methods to accomplish this Downtime Factoring:

1) Define Factoring by Work Center

2) Define Factoring by combination of Work Center and DT Code

Each Method is described below. (Note that both methods may be used concurrently)

Define Factoring by Work Center
In order to activate this feature:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Options' tab.
» Check or Uncheck the ‘Use Downtime Factoring — Work Center Level’checkbox.

» Now use the 'Edit Work Centers’ table to set the ‘Parallel Paths’ for applicable Work
Centers. (This number represents the amount of machines grouped in the Work Center
and has a default value of 1)

» Now use the ‘Edit Downtime Codes’ table to set the ‘Allow Factoring” attribute for each
Downtime Code where Factoring is to be allowed. (Some Downtime Codes that generally
affect the entire Work Center would not be candidates for factoring)

This completes the setup for Factoring by Work Center.

Define Factoring by combination of Work Center and DT Code
In order to activate this feature:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
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» Select the 'Options' tab.
» Check or Uncheck the ‘Use Downtime Factoring — DT Code Level’checkbox.

» Now use the ‘Edit Downtime Codes’ table to set the ‘Allow Factoring’ attribute for each
Downtime Code where Factoring is to be allowed. (Some Downtime Codes that generally
affect the entire Work Center would not be candidates for factoring)

» Press the ‘Factor by WC and DT Code’ button.

-

Edit Downtime Codes
Enter or Edit Downtime Codes: -
oT Sched  Allow External =
0T Type DT Description Code Where Used Down? Factoring Active  Index
b Eouipment [+ | Hydraulics 100 *WC Linked - 2 W | notused
| Equiprment || Tester 101 W Linked Rl [ [ [w notused
| Equipment |« | Controller 102 *WC Linked =| v W | notused
Equipment |« | Robot 110 Malding Rl [ [ [w notused
Cperations z Meeting 111 Plantwide z [ [ [w notused
Cperations z Lunch 120 Plantwide z [ [ [w notused
Operations |« | Breal 121 Plantwide Ea [ [ [w notused
* [ / (] T [ ™ notused
_ \ Select ‘Plantwide’, or a specific \Check here if the DT
Select a DT Type for Enter a Shortcut Department, or "W Linked. Event may be
the DT Cause Downtime Code here Far "W Linked' option, the Facﬁnred lI:':'r Parallel
WiZ Select window will appear Path Work Centers
Select WC(s): Selected WC(s) for OT Code: 100 - Hydraulics Factor by WC and DT Code
Press 1 Press 2 !
Press & 5 | |Press3 Check Hete'  Press this button ta st up OT
Press 3 Press 4 if the OT Factaring by Wark Center & 0T Code
F‘rgss 4 Cause is 3
Paint A Scheduled If Standard Events Feature is
Paint B BT in use, then press this butkon
Assembly 1R £ ko build Standard Events yd
Assembly 1L
Assembly 4 g4 Edit Standard DT Events |
Assembly &
Done
w

» Now, the ‘Edit Factoring by Work Center and DT Code’ window will be displayed.

This window will display lists of Work Centers as well as those Downtime Codes that are
allowed for Factoring. When a Work Center is selected, any Factor allowed DT Code,
which is useable at that Work Center will be displayed.

The DT Codes are arranged into three groups (in the center column):

1) Factored Codes (which have a Factor > 1 at the selected Work Center)

2) Non- Factored Codes (which have a Factor = 1 at the selected Work Center)
3) Unlinked Codes (which have no Factor assigned at the selected Work Center)

Unlinked DT Codes may be Factored for the selected Work Center, by selecting the
desired codes, then pressing the ‘Move Up’ button.

The right hand column allows for editing the Factor Values and will update the center
column as Factoring is adjusted.

Once the Factoring is set for the selected Work Center, these conditions will be applied
whenever the Factored DT Codes are used at the selected Work Center.
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Edit Factaring by Work Center and DT Code

1) select Work Center

2) Sselect DT Codes to Factor

Press 1
Press 2
Press 3
Press 4
Paink &
Paint B
Assembly 1R

»

Assembly 4
Bzsembly &

Select a work Center,
Mote that Work,

Center Fackor Yalues
are displaved

Pl B fod PO

Press bo export a matrix af
Work Center - DT Code

Fackaring \

104 - Toal Change
105 - Tool Adjust

DT Codes which are fackored ak
the selected Work Center
(Fackar Walue = 1) are displaved
in this kable

2 Factored
z Mot Factored

Unlinked

3) Adjust Factoring for Linked DT Codes

OT Code Factor

100 - Hydraulics
101 - Tester
102 - Contraoller

Mon-Factored Codes are
displayed in this table

i 101 - Tester
1 102 - Contraller

100 - Hydraulics

104 - Tool Change
105 - Tool Adjust

[ I S R i R

=

/

Code Search ﬂ

This table is used For
making adjuskments to

110 - Raobak

the DT Fackaring ko be
wsed for the selecked
Wiark Cenker

» Once Factoring is set up, the feature will function as described below:

When a DT Event is entered for an activity, it will be automatically checked for
application of Factoring in two steps...

1) If the ‘Define Factoring by combination of Work Center and DT Code’ feature is
enabled, the software will determine if the combined Work Center and DT Code have
a Factor established. If the Factor exists, it will be applied.

2) Now, if the ‘Define Factoring by Work Center’ feature is enabled and Step 1 failed to
find a Factor, then the software will determine if the Work Center has Multiple Paths
>1 and if the DT Code has Factoring enabled. If these two conditions are met, then
Factoring will be applied based on the Multiple Paths set up in Work Center table.

If neither of the above conditions is met, then the DT Event will not be Factored.

© 2001-2015 Capstone Metrics LLC

Setup for Defect or Downtime Costing

OEE Management has built in capability to track the direct financial cost for defects and
Downtime.

The defect cost reporting is based on cost factors for a scrapped part as well as a
reworked part. The cost calculations are based on unit cost values for scrap and rework
which are entered into the Part Master table.

The downtime cost reporting is based on cost for the actual time which was lost. The
cost calculations are based on hourly cost values for each Work Center, which are
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entered into the Work Centers table.

In order to activate this feature:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Options' tab.

» Check or Uncheck the 'Use Defect Cost Tracking' checkbox and/or the 'Use Downtime
Cost Tracking'

If Defect and/or Downtime Cost Tracking is enabled, various windows and report menus
will be automatically adapted to collect and report this data.

The Part Master table will show two additional fields for entry of the unit cost scrap and
rework costs. These fields should be populated to reflect the cost penalty when a part is
scrapped or reworked.

The Work Centers table will show an additional field for Hourly Cost.

The currency format used for reporting this data will correspond to the currency selected
for the Windows Regional Settings.

Setup for Labor Tracking

OEE Management has built in capability to track Labor applied for each Production
Activity. Although the traditional OEE Metric does not take labor into account, some
Users may find it useful to track and report Labor usage against a standard.

In order to activate this feature:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Options' tab.
» Check or Uncheck the 'Include Labor Tracking' checkbox.

If Labor Tracking is enabled, various windows and report menus will be automatically
adapted to collect and report.

Setup for Slide Shows

A feature for Viewing and Creating Slide Show Presentations is available in OEE
Management Software. This feature may be of value in various locations of the factory
where current results may be displayed on a continuous basis.

In order to activate this feature:

» Select the 'Admin’' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
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» Select the 'Options' tab.
» Check or Uncheck the ‘Use Slide Show Features’ checkbox.

At this point the Administrator may also select what User Levels are allowed to creat and
edit Slide Shows, as well as the Slide Display Time Duration

If Slide Show Feature is enabled, an additional tab will be visible on the Filter / Report
Menu window for creating and editing Slide Shows.

Setup for Fiscal Year Reporting

The Fiscal Year Trend window provides a trended view of weekly data which covers a
full Fiscal Year. This feature allows for quick review of success trends which are keyed to
the Fiscal Year. In order to view data by Fiscal Period, information about the Fiscal
Calendar must be entered.

In order to set up Fiscal Years:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Calendar' tab.

Setup Options for OEE Management

OEE Management |
OEE Management Setup Features

Auto OT Calc I Case [ Bulk Units | Create Forms
Output to Excel I Import Path | Local DE Path | Advanced
View I Options | Calendar | Tooling Setup | OEE Calc | IUser Fields

Date and Time Formatting for Reporting: Date [ 2a-1un-13
k1 FirstDay of Week | Monday Time |12 Hr: 2:00 PM | » |
Set Up Fiscal Years: Ref¥r FfMame StartDate Weeks

(I3

2007 2007 | 12/25/2006 52 [+] =
Load ISO Calendar | 2008 1008 12/24/2007 | 52 El
2009 2009 12/22/2008 53 [+
2010 2010 12/28/2009 52 [+ |
a 2011 2011 |12/27/2010 | 52 E =

Enter FY Data |

Load Part Updates | Done |
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For each Fiscal Year, entries are required for:
» Name of the fiscal year, i.e.: "FY2013"”

» Start Date for the fiscal year. Note that the Start Date will be automatically adjusted to
match the First Day of Week which was selected on the View’ tab of the ‘Setup Options’
window.

» Count of Weeks in the fiscal year (typically 52).

After setting up Fiscal Years, the administrator may choose to enter data from previous
fiscal years for display on the FY Trend Charts. This data is displayed as the first (gray)
bar on a FY Trend Chart. If data is not entered, then the gray bar will not be shown.

If prior year data is to be entered:
» Press the ‘Enter FY Data’ button to open the ‘Edit Prior Year Results’ window...

Edit Prior Year Results
Enter or Edit Prior Year Results for FY Trend Repaorts:

select fear I Fr ol 3 Prior Year Results for Dept: Department A
Select Lewvel
Availability ©5.0%
1.0 Plantwide Performance 70.7%
2 @ Department: I Department A ] Quality 59.0%
3 work Center | | OEE 45.5%:

Prior vear Rezults may be entered at any level. For purpozes of reparting | the lowest
level Priar Year Resulks which applies will be used. Done |

Enter Prior Year FY Fesults
» Select the Year, and reporting Level.
» Select the appropriate Department or Work Center as applicable.

» Enter Values for Availability; Performance; and Quality. (OEE will be automatically
calculated)

» Repeat as needed, for other Years or reporting Levels.

Setup for Equipment Hierarchy

OEE Management Software incorporates a two level Equipment Hierarchy which may be
defined just below the Work Center Level.

To enable Equipment Hierarchy:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the ‘Options’ tab.
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» Check the ‘Use Equipment Hierarchy’ box.

Once the Use Equipment Hierarchy Option is enabled, the Equipment Tables may be
defined as described below...

» Select the Tables L3' option on the toolbar. (Note that this option is only visible when
a Level 3 Logon is active)

» Select ‘Edit Equipment’ option. This will open the ‘Edit Equipment’ window.

e

Edit Equipment
Enter ar Edit Parent Equipment: —
External =
Equipment Description Asset Code Linked Work Centers Active  Index
B Molding Press 1 21-034 Mult WC Linked v | | | notused
Robit 14, 35-004 Mult WC Linked |v| | | notused
Robat 16 35-023 Mult WC Linked |y | | | notused
Part Conveyor 22.013 Mult WC Linked |v| | | notused
Link Equipment to Work Centers Child Equipment
Select WC(s): Linked WC(s) Equipment Description Asset Code
Press 1 - Press 1 Hydraulic Pump 21-034-02
Press 2 3 Hydraulic Valves 21-034-03
Prezs 3 JE— Platen 21-034-41
Press 4 Clamp 21-034-46
Press 5 Cantralzs 21-034-30
Press 6
Press 7L <
Press 7R
Press 11 <<
Press 12
Praz= 14 i
Edit Child Equipment
(7 | Equipment Repart //_ quip | Done =
i f it
Edit Child Equipment
External
Child Equipment Description Asset Code  Active  Index
b | Hydraulic Pump 21-034-02 W notused
|| Hydraulic Valves 21-034-03 [w notused
| |/Plsten 21-034-41 [w notused
||| Clamp 21-034-45 [ notused
|| Cantrals 21-034-80 [v notused
* W notused
Done
L y

Now, Equipment may be entered at two levels: Parent and Child. Parent Level
equipment is linked to Work Center(s), with the Child Equipment being linked to Parent
Equipment. For example, a Work Center such as a Molding Cell, could have Parent Level
equipment such as a molding machine, conveyors, a Robot, etc. Below these Parent
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Level pieces of equipment, there may be multiple Child Level items, such as motors,
hydraulic equipment, controllers, etc. At each level, the equipment is defined by name
as well as an asset code.

If the ‘Equipment Hierarchy’ is enabled, then Downtime Entries are assignable to specific
equipment, allowing for more detailed analysis of downtime losses.

Setup for Tooling

OEE Management Software allows for tooling information to be used to ease data entry
and to provide tool focused OEE and loss reporting. For this application, tooling refers to
individual units which are designed to mount on a machine to produce a particular group
of part numbers. The tooling option is most useful when tools are utilized which produce
more than one part number during a single cycle. If the tooling produces several of a
single part number during each cycle, it may not be worthwhile to track by tool.

To enable use of Tooling:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the ‘Tooling Setup’ tab.

I 1

Setup Options for OEE Management

OEE Management |
OEE Management Setup Features

Auto DT Calc I Case [ Bulk Units | Create Forms

Output to Excel | Import Path I Local DB Path | Advanced
View I Options I Calendar | Tocling Setup | OEE Calc | User Fields
|z Tooling Feature [v Allow Cavity Blocking [
Force Tool Level Data Entry [ Blocked OT Mame |*Blocked Cavity
Blocked OT Category: Sched¢™ UnSched &
Tooling Nomendature Tool Handle Cavity Handle
| Tool | Cavity |
d Load Part Updates | Done |

» Check the ‘Use Tooling Feature’ box.
» If desired, check the ‘Force Tool Level Data Entry’ box.
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Setting this option requires that production activity data be entered at the Tool Level,
rather than the Part Level, whenever a Tool is available. If this option is not set, then
production activity entry will be more time consuming (part by part, rather than tool)
and may cause some parts not to be accounted for on a given tool activity. If the Force
option is not selected, then Part Level entry is allowed, however a red flag will be
generated to remind the user to select the Tool Level.

» If desired, check the ‘Allow Cavity Blocking’ box.

Setting this option allows one or more cavities to be ‘blocked’ or ‘shut off’ for a given
multi-cavity tool activity. This condition could be due to rebalancing inventories or a
tooling issue. Note that the name for the related Downtime Event may also be entered.
The default name for this time loss is “*Blocked Cavity'.

Next, select whether the Blocked Cavity Downtime Event should be handled as a
Scheduled or Non-Scheduled Downtime Event.

Blocking a cavity will have the following effect...

A Downtime Event will be automatically generated for the part number associated with
the blocked cavity. The downtime duration will be an allocation of the scheduled time
based on the total cavities blocked vs. the total cavities available in the tool. For
example, if 1 of 4 cavities is blocked and the mold is scheduled for 480 minutes, then
the blocked cavity will be charged with 120 minutes of downtime (or %4 of the tools total
time).

» Enter Nomenclature or Handles for the tooling which is used and the feature which
produces the parts. Examples: Die & Impression; Mold & Cavity, etc.

Once the Tooling Option is enabled, the tooling may be defined as described below...

» Select the Tables L3' option on the toolbar. (Note that this option is only visible when
a Level 3 Logon is active)

» Select 'Tooling Setup' option. This will open the *Tool Setup' window.
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-

Mold Setup
1) Select or Edit a Mold Mold Name:|p1-112 4) Match Part Data to
Active Inactive Description: Gadget M Mold Data
T-101 « | T-188 -
B 2) Add Parts: Mold Level Data |
M-112 R-056 . Cydes Cyde
M-114 R-057 Add Edit Parts per Hr. [Time (sec)
T-141L T-211 120 30
T-141R T-324
- — Part Rates Match Mold F‘.ate
3) Match Mold Cavity )
count to Parts count Muld Level Cavity Count
To resolve Part Rate Mismatch...
Expected Part Rate: 480
- - Edit Attached Parts |
Edit Mold List Mold is Active
Attached Parts with Cavity Count for each Part
Part Level Data
Cavity Count for each Part  [orimsic Totd Cyde
Part Mumber Part Description per Hr. | in Sec.
PH104523 Sample FPart 523 480 7.5
PH104524 Sample Part 524 480 7.5
PH104533 Sample Part 533 480 7.5
PH104534 Sample Part 534 480 7.5
(7 | | Tool Repaort | Done

©

The Tool Setup window provides information on each Tool as well as its Active status.
Inactive Tools may not be used for entry of production data. Tool setup requires
completion of a four step process as guided by the Tool Setup window. Once all steps
have been successfully completed the Tool may be activated.

» Step 1: Select a Tool

The Tools are displayed in two lists at the upper left side of the Tool Setup window. The
Tools are separated into Active (Green list) and Inactive (Red list). This feature allows
the User to see at a glance, any tools which are Inactive — not available for use.

The desired tool may be selected for setup by clicking on it in either the Active or
Inactive list, or if needed, tools may be added to the Tool List by pressing the ‘Edit Tool
List’ button.
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)
Edit Tools
Add or Edit Tools Tl -
Toal Level Data =
Cycles Cyde Std
Tool Mame Tool Description per Hr. [Time (sec)| Manning | Sert
| ] 1oz 63 57.1 0.5 w0 |4
T107 63 57.1 0.5 | 20 | 4
 Ti09 63 57.1 | 0.33 | 30 | 4
 TiiR 172.9 | 29.3 0.5 | 40 | 2
O Ti1L 172.9 | 29.3 0.5 50 || 2
p Tiiz 120 30 1 50 | |2
 Ti14 360 10 033 | 70 || 2
| Ti18A 1111 | 32.4 1 a0 || 2
| T118B 227.8 | 15.8 1 aw |2
- T121 63 57.1 0.5 | 100 || 4
 Tizz 63 57.1 0.5 | 110 || 4
 Tia0 63 57.1 | 0.33 | 120 || 4
T 120 30 0.5 | 130 || 2
Sortlist | Dome |15

s -y

From the ‘Edit Tools” window, tools may be edited or added by entering a Tool Name
and the following data:

a) Either ‘Cycles per Hour’ or ‘Cycle Time (sec)’ may be entered; the other will be cross
calculated. Note that the tool cycle is based only on the time cycling of the tool,
without regard for cavities or part counts.

b) If the Labor Tracking Feature is enabled, then the Standard Manning must be
entered. Standard Manning may be a fraction of one operator, for example use .5 for
a case where one operator is responsible for two processes.

¢) Tool Cavity Count is the total number of parts which are produced with a single cycle
of the mold. (This value is a pure count of parts regardless of what the part numbers
are.)

Filling the Tool Description and Sort Order fields is optional.

» Step 2: Add Parts
Each Tool must have at least one, but no more than four, part numbers attached.
To add or edit attached part numbers, press the ‘Add/Edit Parts’ button.
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-

Part Selector

Available: Selected:

PHOO012349 - Sample Part 349 - PHO012345 - Sample Part 345
PHO012350 - Sample Part 350 PHO012346 - Sample Part 346
PMOD12351 - Sample Part 351 PHO0123247 - Sample Part 347
PHOO012352 - Sample Part 352 PHO012248 - Sample Part 348

PMO012353 - Sample Part 353
PHO012354 - Sample Part 354
PHOC012355 - Sample Part 355
PMO012356 - Sample Part 356
PMO012357 - Sample Part 357
PHO012358 - Sample Part 358
PHOO012359 - Sample Part 359 <<
PMO012360 - Sample Part 360 JE—
PMO012361 - Sample Part 361

PHO012362 - Sample Part 362

PHOO012263 - Sample Part 363

PMO012364 - Sample Part 364 Cancel
PMO012365 - Sample Part 365 i — .
Items Available: 1133

Items Selected: 4

L

To add parts to a tool, select the desired part then double-click it or press the right
arrow button. The part is now moved to the right side of the window and is selected.
Parts may be removed from a tool by reversing the process.

» Step 3: Match Tool Cavity count to Parts count

In the bottom half of the ‘Tool Setup’ window, the Cavity Count field must be completed
for each part which is attached to the tool. The total Part Cavities assigned are then
matched with the Tool Cavities to verify that they are equal.

» Step 4: Match Part Data to Tool Data

The last step of Tool Setup requires that the attached parts be checked to insure that
their standard rates are properly coordinated with the standard rate of the tool. If the
match is successful then the ‘Part Rates Match Tool Rate’ check will appear and the
target will be green.

If a mismatch is detected, the target will be red and the match box will not be checked.
As an aid to resolving the mismatch, the window will display the ‘Expected Part Rate’
value which would correspond to the tool’s rate.

At this point, the mismatch may be corrected by adjusting the tool rate and/or adjusting
the part rates. If the tool rate is to be adjusted, the change may be done on the Tool
Setup window. In order to conveniently change part rates, the ‘Edit Attached Parts’
button may be pressed to open Part Master window. In this mode, the Part Master will
open showing only the parts associated with the selected tool. Once the mismatch is
corrected the target will become green and the tool may be made active.

Note: Part 'Std Rate per Hr.” represents the full capacity for the tool. i.e.: Tool Cycles per
Hour * Tool Cavity Count. The full tool capacity is applied to each part. On first analysis,
this may not seem appropriate, but one must take into account that at runtime, each
part will only receive a partial allocation of the Tools actual operating time.

'Std Manning’ at part level is the fractional portion of the tool’s standard manning
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allocated by cavity.

» Activate Tool

After the 4 steps have been successfully completed, as indicated by all 4 targets
showing green, the Active box may now be checked. The tool may be used for
production only after the Tool Setup is complete and the Tool has been made active.

A tool may be deactivated at any time as desired by the User, however reactivating the
tool will require that the four steps are still showing green status.

» Note on the relationships between Part Numbers and Tools

Using the above methods, a single tool may be related to one or more part humbers
(typical for injection molding), also a single part humber may be related to one or more
tools (typical for die casting).

In order to study or document Tool Setups, the ‘Tool Report’ button (or Excel Export
button) may be pressed to present a full reporting of tooling including attached Parts
and associated Work Centers.

Setup for OEE Combination Rules

I 1

Setup Options for OEE Management

OEE Management |
OEE Management Setup Features

Auto DT Calc I Case [ Bulk Units | Create Forms
Output to Excel | Import Path | Local DE Path I Advanced

View I Options I Calendar | Tooling Setup | OEE Calc | User Fields I

OEE Combination: OEE values are combined for aggregate reporting.
The basis for combining these values can be by 'UNITS Based'
weighting (Recommended) or by TIME Based' weighting. Mare Info...

LINITS Based - weight by OEE Elements (Recommended) ¢+
IJ TIME Based - weight by Earned Hours (See Help) ¢~

OEE Time Loss Categorization: For OEE Calculations, Downtime losses
may all be charged to the 'Availability' Metric (Traditional), or each loss
code may be individually assigned to any of the Three Metrics:
Availability; Performance; or Quality (Categorized).

Cateqarized - Downtime assignable to any Metric ¢~
IJ Traditional - All Downtime charged to Availability &

Load Part Updates | Done |

The OEE Calc tab allows the administrator to set the calculation methods for OEE
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Combination and the method of Categorizing OEE Time Losses.

To make changes to these options:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the ‘OEE Calc’ tab.

When OEE Data is viewed for a single Production Activity, the result is based on looking
at good units produced compared to various standard hourly rates. This is based on
traditional methods for calculating OEE metrics.

See OEE Calculation Methods for more information on basic OEE calculations.

There are many cases, however, where several Production Activities need to be viewed
together for reporting of combined or aggregate results. This case occurs, for instance,
when the performance of a plant is to be evaluated for a certain period of time - across
all Work Centers, Shifts, and Part Numbers.

In the case of combining this information, there are two methods available that may be
selected by the administrator.

» UNITS Based Weighting - Recommended Setting:

In this case, the combined value is based on weighting the OEE values for each work
center based on Units Produced by each of the work centers.

Combining Work Center activities using Units Weighting gives a result which indicates
performance reflecting the net units produced at each work center.

The Units Weighting method can, however, be misleading in plants where different work
centers have very different standard rates. If, for instance, work center A produces 30
widgets per hour and work center B produces 500 gadgets per hour, the OEE weighting
will be skewed to reflect Work Center B - the higher rate line.

» TIME Based Weighting (by Earned Hours):

By selecting the TIME Based Weighting option, the combined value is based on
weighting the individual OEE values by the Earned Hours for each work center.

The Earned Hours metric is calculated as follows:

Actual good units produced are divided by the standard hourly rate to determine how
many hours were earned by a work center.

i.e.: For an 8 hour Production Activity on a work center which has a 50 unit per hour
standard rate; the work center produces 250 good units. The earned hours for that
Production Activity is equal to 250 / 50 = 5.0 Earned Hours. Earned hours, then, is a
metric which rates work center performance but is not influenced by how large or small
the standard rate is.

Combining Work Center activities using Earned Hour weighting gives a result that
indicates performance, reflecting utilization of scheduled time at each work center.
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» Deciding on a Weighting Rule:

In most cases, the UNITS Based weighting will present the most realistic representation
for a group of Work Centers. This is the recommended setup.

In cases where work centers are generic or equivalent, either method can be used and
will give very similar results.

In cases where the Work Center rates vary greatly, TIME Based weighting may be more
useful.

In order to change the weighting method:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Options' tab.
» Click the desired option in the 'OEE Combination' box.

Additional information may be found on the ‘OEE Calculation Options’ window. This
window may be opened from the Setup Window, ‘Oee Calc’ tab; click on ‘more info’. The
window provides sample calculated values, based on actual data, which may be helpful
in comparing the calculation methods.
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- 1

OEE Calculation Options

This window provides additional information on the two options for combining OEE
data. In general the calculation is either UNITS Based or TIME Based as selected in
the Application Setup window.

Current Application Setup

Units Information UMITS Based {+ {— TIME Based Time Information
Scheduled Units Scheduled Hours
7,658,655 16,627.6
Standard Units Availability Available Hours

£,260,139 I 80.39% 13,367.4

Gross Units Performance Grass Earned Hours
5,189,368 I 85.48% 11,426.2
IUnits Based Time Based

Good (Met) Units Earned Hours
5,135,881 1 08.97% 11,261.0

OEE Efficiency

I 65.95% I 68.01%

Units Based Time Based

sz Filter Criteria: (Prod Date 07/31/10 - 08/27/10)

OEE Calculations Options Window

Setup for Time Loss Categorization

The calculation of OEE metrics requires handling of the time losses which occur during
the scheduled run time. There are two approaches as to how to handle these losses and
where to put them. OEE Management Software provides the administrator with two
options for handling of time losses. Each is described below.

» Traditional OEE Approach:

In the traditional approach, all unscheduled downtime events are collected and placed
within the Availability portion of the OEE calculation. In other words, any loss of time is
treated as a loss of Availability and is reported as such.

» Categorized Loss Approach:

Using the Categorized approach allows time losses to be placed within any of the three
OEE elements (Availability, Performance, or Quality). This method allows the
administrator to assign each Downtime Code to one of the three OEE elements. Now,
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when downtime events are entered, they will be shown in various elements, depending
on how the Downtime Causes are set up.

An example of usage might be a Downtime Cause for “Quality Inspection” that would be
set to the Quality element rather than the Availability element.

It should be noted that selection of either the Traditional or the Categorized options has
no effect on the final value for OEE. The two methods will only change the distribution
of losses between the OEE elements.

In order to change the Time Loss Categorization method:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Options' tab.
» Click the desired option in the 'OEE Loss Time Categorization' box.

I 1

Setup Options for OEE Management

OEE Management |
OEE Management Setup Features

Wiew I Cptions I Calendar | Tooling Setup | OEE Calc | Liser Fields

Output to Excel | Import Path I Local DE Path | Advanced
AutoDTCale |  Case /Buk Units | Create Forms
OEE Information may be

entered and reported by
Case or Bulk Padk rather than
individual units.

! Allow Case Reporting; [~

OEE Management may be used to collect bulk production information in
addition to part based data. Bulk information for selected Work Centers is
collected and available for reporting or exporting, itis not used for OEE
caloulations.

Allow Bulk Package Reporting [~

d Load Part Updates | Done |
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Setup for Bulk Units Tracking

OEE Management includes a feature that allows entry, and reporting of Bulk Units. Bulk
Units are collected at a Work Center level and are defined by date and shift.

To set this feature up in OEE Management...

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Case/Bulk Units' tab.
» Check the 'Allow Bulk Reporting' checkbox.

» In the ‘Enter Names for Bulk Units” box, type in each of the standard bulk quantities
which will be used for this feature. i.e.: ‘Pallets’, ‘Racks’, etc.

» Press the ‘Select WC's’ button. This will open the ‘Edit Work Center Options’ window.

» From the ‘Edit Work Center Options” window, check the ‘Enabled’ checkbox for each
Work Center for which Bulk Tracking will be allowed.

» For each enabled Work Center, 'Std Units/Hr’ must be entered, as will as selection of
the correct ‘Units’ type for that Work Center is required.

This completes set up for use of the Bulk Units Tracking feature.

Setup Options for OEE Management

OEE Management |
OEE Management Setup Features

View I Options I Calendar | Tooling Setup | OEE Calc | IUser Fields
CQutput to Excel | Import Path | Local DB Path I Advanced
AutoDTCale |  Case/Bukunits |  CreateForms

The Data Callection Farm may require a Document Mumber to satisfy
Quality System requirements, if so enter the number below:

Document Mumber |

Determine who may create an print blank OEE Data Collection Forms by
setting the reguired User Level:

Required Level|  IENEEITES [+

View Data Form |

d Load Part Updates | Done |

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 101



Setup for Create Forms Options

Data for OEE Management may be collected on preprinted forms, then entered into OEE
Management by another person. There is a built in data collection form which may be
printed and used for this purpose. If the User has rights that allow, the 'Create Form'
button is visible at the bottom of the 'Main' window. See page 25 for further information.

To set features for Form Creation:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Create Forms' tab.

» If there is a standard form number that is desired to be included on the form (i.e.: due
to Quality System requirements), enter the information in the ‘Document Number’ box.

» Select the User Level that will be allowed to create these forms in the ‘Required Level’
box.

Setup Options for OEE Management

OEE Management |
OEE Management Setup Features

Auto OT Calc I Case [ Bulk Units | Create Forms
View | Options | Calendar | Tooling Setup | OEE Calc | Iser Figlds
| Output to Excel | Impart Path | Local DB Path | Advanced

OEE Management may be set up to copy daily OEE Data to an Excel
Spreadsheet. A profile must be created for each spreadsheet in order
for the data to be properly copied.

Allow Copy to Excel [

Select WC's |

Create File Profiles |

d Load Part Updates | Done |

Setup for Copying OEE Data to Excel

OEE Management is designed to directly transfer OEE Data to existing Microsoft Excel
Worksheets as follows:
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» The target Worksheets must be set up with rows containing days of month and
columns containing various OEE data fields.

» Data is grouped by day of month, where user selects desired month.

» Up to 5 target Worksheets may be assigned. Each Worksheet must be defined with a
profile.

To set this feature up in OEE Management...

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.

» Select the 'Output to Excel' tab.

» Check the 'Allow Copy to Excel' checkbox.

» Press the ‘Select WC's’ button. This will open the ‘Edit Work Center Options’ window.

» From the ‘Edit Work Center Options” window, check the ‘Enabled’” checkbox for each
Work Center for which this feature is to be available. Press ‘Done’ after enabling Work
Centers.

» From the 'Setup Options' window, now press the ‘Create File Profiles’ button, this will
open the ‘Setup for Data Copy to Excel Worksheet” window’.

Setup for Data Copy to Excel Spreadsheet
> Profile Mame Department Work Center

1 | PaintLine | Al = Line 2 [~T]
Target Excel File Browse

| R \MonthlyReportsY{OEEMonthly \Paintlines\OEELine 2, xls

Excel Tab Name | OEE Summary Test Link to File |
Assign Data to Excel Columns First Excel Row | 3 =
Excel e EXCERow Excel
Selected Value Column selected Value Column
SchedHrs 1|8 =l | AvaiStdunit= -] |H =]
DTHrs =l jc = |

GoodUnits o=l |
GrossUnits I |F =l |

|
|
| ScrapUnite k=l |
|
|

Ecurd: 14 1 kM of 5

Setup for Data Copy to Excel Spreadsheet Window

» Select the first unused profile (5 are available) by using the arrow keys at the bottom
of the window.

» Enter a ‘Profile Name’ for this profile; it should be descriptive so that users will be able
to select the proper profile.

» Set the ‘Department’ and/or ‘Work Center’ filters for this profile.
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» Press the 'Browse’ button then browse to and select the target Worksheet for the
copied OEE Data.

» Type the desired Sheet Tab Name into the ‘Excel Tab Name’ box.

» At this point the ‘Test Link to File” button may be pressed. This will open the target
Worksheet to allow verification that the File Path and Tab Name are valid.

» Next, from the ‘First Excel Row’ pulldown box, select the first row in the target
Worksheet that contains data. i.e.: A for typical Worksheet with titles in row 1 , Row 2
would be selected for the ‘First Excel Row'.

» Finally, desired OEE data items may be assigned to various columns in the target
Worksheet. For each item, select the data item from a ‘Selected Value’ pulldown box,
then select the desired Worksheet column from the ‘Excel Column’ pulldown box. The
following data items are available...

Scheduled Hours Downtime Hours
Available Hours Gross Units

Good Units Defective Units
Scheduled Std Units Available Std Units

% Availability % Performance

% Quality % OEE

Bulk Scheduled Hrs Actual Bulk Units
Scheduled Std Bulk Units Available Std Bulk Units

» The profile is now complete, at this point the ‘Done’ button may be pressed, or
another profile may be built by selecting another blank profile.

Setup for Email Messaging of Alerts

OEE Management Software will send email alerts to users based on their Alert Rules.
Once Alert condition(s) is identified, OEE will notify, by email message, the Users who
are associated with the specific Alert Rules.

The email message will be sent via an active Microsoft Outlook client on the Users
machine, or by SMTP server.

Select the desired Messaging Mode at top of the Setup window.
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Setup for Email Alert Messaging

Messaging Mode

(* SMTP Server i~ MS Outlook

SHMTP Server Settings
SMTP Server Address: |

Paort: | 25

Authentication Method: Basic Usessl: [

SHMTP Account Settings
User Mame: |

Sent From: |

Password: | Reply To: |

Account Name: |

Text Signature:

7

Send Test Email Done

For Microsoft Outlook Mode, no additional setup is required.
For SMTP Server Mode, the required SMTP Server and Account Settings must be entered

on the Setup window.

A test email may be sent (in either Outlook or SMTP mode) by pressing the ‘Send Test

Email’ button.

Setup for Local DB Path

The OEE Software must create a local database file on the User PC. The local database
file is used for handling data that relates to what the user is doing. A fresh copy of this
file is created each time the user starts OEE Management. This local database file will be
automatically deleted when the user exits OEE. Once created on a PC, this OEELocal

folder will remain.

See page Error! Bookmark not defined. for further explanation of the Local DB Path.
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Setup Options for OEE Management

OEE Management |
OEE Management Setup Features

Auto DT Calc I Case [ Bulk Units | Create Forms
Wiew I Cptions I Calendar | Tooling Setup I OEE Calc | LIser Fields
OutputtoExcel | ImportPath | Local DB Path Advanced

OEE Management needs a location for creating a local database. OEE
will attempt to create a folder based on the option selected below. If all
attempts fail, OEE will report the problem and exit.

Select a location for Local Database

{* |lse Windows AppData Folder (recommended)

"~ Use C:\OEELocall, Folder

" Use Alternate Paths for Local Data File:

Alt 1 |C:\OEELocal\ Browse

Alt 2| Browse

i

Current Local DB Path:
C:\Users\User\AppData\RoamingYOEELocal\OEEG SUSER . mdb

d Load Part Updates | Done |

To set the Location for the OEELocal folder:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Local DB Path' tab.
» Select one the three options.

1) The first option will place the local folder in the ‘AppData’ folder that is automatically
maintained by Windows. This is the recommended option.

2) The second option will create the local folder on the user computers C:\ drive.

3) The third option allows use of an alternate path as defined by the administrator. To
set the Alt 1 or Alt 2 Path, press the 'Browse' button for the appropriate box. Browse
to the desired folder where the local folder should be created. If desired, repeat the
process for the 'Alt 2' box. Note that the alternate path(s) are global to all users;
therefore the path must be one that is valid for any user computer.

If creation of the local folder as defined above fails, OEE will make a final attempt to
place the file directly on the C:\ Drive (C:\). If this fails, OEE will report the issue and
exit.
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Setup for Importing Production Data

See page 128 for further explanation and setup instructions.

Understanding the OEE Data Tables

In order for OEE Management to collect and keep track of data, it uses a system of
tables that provide the necessary structure. The six key tables are:
1) Departments
Work Areas (Optional - User Defined Field: ‘UserPC1")
2) Work Centers
3) Parts
Part Grouping (Optional - User Defined Field: ‘UserPN1")
4) Shifts
5) Defect Codes
6) Downtime Codes

The following graphic displays how OEE Management links the data in each table. The
user need not be concerned about this structure since OEE Management handles it
automatically. It does, however, affect the order in which the tables should initially be
filled with data. This is covered in the next section.

Departments Work Shifts Scrap Codes
Work Areas Downtime
(Optional Codes

Field PC1)
Work Centers _'_'_'__'E_ Parts Part Grouping
— (Optional
Field PN1)

Initial Loading of OEE Tables

Before OEE can begin collecting data, the data tables must first be populated. To
populate these tables, the user has two options:

1. Manually enter initial data into the tables
2. Use Importing Feature to automatically load the tables
These options are described below.

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 107



Option 1 - Manual Table Loading...

Manually loading of tables requires that each table is opened and the appropriate data is
typed in. Tables are accessed from the Tables (L2) and Tables (L3) buttons on the OEE
Management Toolbar (at top of OEE Management window). Note that these buttons are
only available when the appropriate logon has been completed.

1) Enter Departments...
Table accessed from the Tables (L3) button on the Toolbar

Edit Departrnents

Enter or Edit Department: External
P Active Index

[ 2 W | notused
* [ notused

Enter Departments here
Done | =
-

Department Table
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2) Enter Work Centers...
Table accessed from the Tables (L3) button on the Toolbar

Edit Yifork Centers
Enter or Edit Work Centers;

Mixed Parallel External
Work Center Name Department Part Flow Paths Sort Active  Index

Press 1 Malding El - 1 10 "  notused

Hourly Cost|  $33.12
Paint & Painting [ W 1 20 | [ | notused

| Hourly Cost|  £92.58
Press 3 Molding El - 1 30 W | notused

| Hourly Cost|  £59.64
Press 2 Malding El r 1 40 ¥ | notused

| Hourly Cost| $33.12
Drill Center & Machining [ — 3 50 | [ | notused

| Hourly Cost|  £83.12
Drill Center Machining El - 2 &0 [ notused

| Hourly Cost|  £59.64
Press 4 Malding El r 1 70 ¥ | notused

| Hourly Cost|  $59.54
Press 7L Molding [ r 1 80 | W | notused

| Hourly Cost|  £59.564
Assembly 1L Assermbly El — 1 30 [ | notused

| Hourly Cost| 55,98
Assembly 4 Assembly El B 1 100 | W | notused

| Hourly Cost|  $52.90

Sort List Done

Frs

il

o

/

If Downkime Cosk Feature is
enabled, Enter the actual
Hourly Operating Cost For the
‘ork Center.

3) Enter Parts...

If the Waork Center runs a mixktare of parts in

the same Process Stream, then Check the Mixed
Part Flow Box, (Faor example: a Paint Line which
paints several different parts simulbaneousky, )
This will allove mulkiple concurrent: Praoduction
Activites to be created - one for each part that
Flows through the Mixed Process.

Table accessed from the Tables (L3) button on the Toolbar
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Edit Part Master

Enter or Edit Part Data:

Fs
o Data Edited during this session H =
Part Mumber Part Description Std Rate |Std Cyde | Std 5td Spd | Part External
- Cusktomer per Hr. | inSec. |Manning | Unit/Min [Active Index
p [12348BCD Wyidget
60 60 0 0 tused
Acme E| bo Co| motuse
Sorap Cost £0.00 Rework Cost £0.00
D426 IR, Gadget
v gL 207 [ B3 0 0 W 3 notused
Scrap Cost| 0.0 Rework Cost _ £0.00 / \
r " Std Spd Unit/Min Fiegld
Scrap Cost and Rewar N ’ will appear only when
Cosk Fields will appear 2;?:.21;”;?3 ;i_?lla?_l I":lljl!a the Automatic Speed
only whenk]the Defect Lahar Tracking Loss Diownkime
Cosk Tracking Feature is - Feature is enabled
enabled Feature is enabled
Change Log - Selected Part | |
Change Log - All Parts | i Done
-
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4) Enter Shifts...
Table accessed from the Tables (L2) button on the Toolbar

-

Edit Shifts
Enter ar Edit Shifts:
External
shift Mame Start Time End Time Department Sort  Active  Index
> 3 11:00FM 7:00 &M Al [+ 10 ¥ | notused
1 700 AM 3:00 PM All E 20 W notused
2 3:00 PM 11:00 PM Al [+ 30 ¥ | notused
* All E 40 F | notused
If Standard Events Feature is
in use, then press this buktkon
ko build Skandard Events
Edit 5td DT Events Sort List Done

Shifts Table
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5) Enter Defect Codes...
Table accessed from the Tables (L2) button on the Toolbar

Edit Defect Codes

| »

Enter or Edit Defect Codes: (7 | )
Defect Rework Rework Downtime. .. Extemnal
. Defect Description Code  Classification Where Used Default Time(sec) Downtime Code  Active  Index
_» Paint Adhesion 200 Internal =] *WiLlinked [»| [ 0 | Mone v ¥ notused
| Short Shot 201 Internal || Molding - 0 Mone v ¥ notused
Splay 202 Internal  [«|  Molding =] T | 0 MNone 'v| ¥  notused
Mizsing Bracket 203 Internal  [w| Assembly [«| W 20 200 -Rework (Weld) [v| W | notused
___ Scratched 204 Internal  |w| Plantwide [« [~ 0 MNone l»| ¥ | notused
__ Damaged 205 Internal || Plartwide [« [ 0  Mone ~| W notused
* |- | l=| T 0 | Mone | notused
B Select Item ( I'\, = ; :
Enter a Shortout ' ; Select Plantwide', or a specific 2 F IF Reworl For this Defect requires a
if Liser Figld e L chide oy Defeee
Defect Code here { i Department, or "WC Linked,  — oo which are DN Delay, enter the Standard
SC1Marne is . T Fework Time (in seconds), and select
in Lse) For "W(C Linked' option, the ger!e_rally Rework a Downtime Code For which the
WC Select window will appear e Rework time will be charged.
Select WC(s): Selected WC(s) for Code: 200 - Paint Adhesion
Press 1 Paint &
Press 2 5 Paint B
Press 3
Press 4
Paint &
Paink B
Assembly 1R <
Assembly 1L
Assembly 4 €&
Assembly &
Done

Note that the "Where Used’ selection may be utilized to allow a Defect Code to be used
in any area (ie: Plantwide) or it may be attached to a single Department or to a specific
list of Work Centers. This feature allows the administrator to provide different lists of
available Defect Codes at time of data entry, based on the Department or Work Center
which is involved.

For Defect Causes which generally result in On-Line Rework, Check the ‘Rework Default’
Box. This will cause them to default to a Rework Entry during entry of activity data.

For Rework Actions which result in Line Downtime, the Rework Time (in seconds) and
Downtime Code for that Rework may be entered. When this Defect Code is used during
entry of activity data, the Downtime Event and the associated duration (Rework units X
Standard Rework Time) will be automatically entered into a Downtime Event.
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6) Enter Downtime Codes...

Table accessed from the Tables (L2) button on the Toolbar

-

Edit Downtime Codes

OT Type
P Equipment
Equipment
Equipment
Equipment
Operations
Operations
Operations

Enter or Edit Downtime Codes:

the DT Cause

Select WC(s):

Press 1
Press 2
Press 3
Press 4
Paint &
Paint B
Assembly 1R
Assembly 1L
Assermbly 4
Assembly &

FY

oT Sched  Allow External =
OT Description Code Where Used Down? Factoring Active  Index
Hydraulics 100 *WC Linked (=] T v ¥ | notused
Tester 101 =/C Linked =] T v W | notused
Cantraller 102 =WC Linked =] I 2 W | notused
Robot 110 Molding ™ I_ ra W notused
Meeting 111 Plantwide -l r W | notused
Lunch 120 Plantwide | r W  notused
Break 121 / Plantwids v r W  notused
/ = r [ I~ notused
Select 'Plantwide’, or a specific T " heck here F the OT

Enter a Shorfout

Dowrtitne Code

here

Department, or "W Linked,

For "W Linked' option, the
W'C Seleck window will appear

Selected WC(s) for OT Code: 100 - Hydraulics

Press 2
Press 3
Press 4

<L

Check Here
if the DT
Cause is a
Scheduled
Event

Event may be
Factored For Parallel
Path Work Centers

Factor by WC and DT Caode

{
Press this button to set up DT
Factoring by Work Center & DT Code

If Standard Events Feature is
in use, then press this button
ko build Standard Events ),f

Edit Standard DT Events |

Done =

Downtime Codes Table

Note that the "Where Used’ selection may be utilized to allow a Downtime Code to be
used in any area (ie: Plantwide) or it may be attached to a single Department or to a
specific list of Work Centers. This feature allows the administrator to provide different
lists of available Downtime Codes at time of data entry, based on the Department or
Work Center which is involved.
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Option 2 - Automatic Table Loading

Automatically import the table data wusing the pre-formatted Worksheet
'OEETableScheme.xls' that is provided with this application. The remainder of this Help
Subject will deal with automatic importing of table data.

» Preparation of OEETableScheme.xls...

The Worksheet consists of seven tabbed sheets. The first sheet provides an overview of
the data structure and should be read before proceeding. The remaining six sheets
correspond to the six tables mentioned above. The six sheets are set up to deal with the
required information for each table.

Table data may be entered into the six sheets by any means that is convenient to the
user. Generally 'cut and paste' from other sources will be the most efficient method.

Indexing values for each table are optional and are discussed later in this manual on
page 130 (Importing Data — Index Values) as well as in the first sheet in
OEETableScheme.xls.

An Index value is REQUIRED in the Department table, since this is the basis by which
OEE will know how to connect Work Centers to Departments. This field called
'ExtDeptID' must be completed in the '1)Departments' tabbed sheet and corresponding
values must be entered in 'ExtDeptID’ field of the '2)WorkCenters' tabbed sheet.

As a minimum requirement, OEE Management cannot import table data unless the
following information is found:

1) Departments (with ExtDeptID)
2) Work Centers (with ExtDeptID)
3) Parts (with PNRate)

The other three tables are optional for automatic loading, but it is recommended that
they also be completed prior to automatic importing of table data:

4) Shifts
5) Defect Codes
6) Downtime Codes

OEE Management will require that the Shift data exist before production data may be
entered. The user is allowed the option of manually entering this table after
automatically importing the required table data.
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Import Tables
Step 1: Find File Browse to Location of OEETableScheme.xds ...

| Browse
Step 2: Read File  File will be read and checked for errors...

Information found in OEETableScheme.xdls

Departments Parts

ExtDeptiD | DeptName N ExtPNID | Pnum | PNName | PNRate ~
L 1 MOLDING ~ [ »| 102559 102559 HOUSING PLASTIC 17.00038
Record: 14 1 k| Ml |k#k|of 15 Record: 14 1 k| Ml |k3¥| of 998 1 *

Wwork Centers Scrap Codes

ExtPUID | PUName | ExtDeptll ExtSCodelll Scode | SCName -
L 11PRS01 01 INJECTION PRESS 330T M -~ »|AB AB ANODE BURM -
Record: 14 1 k| M |M#|of 95 Record: 14 1k | M| k¥| of 190

Shifts Downtime Codes

ExtShiftlD | ShiftName | ExtDeptlD N ExtDTCID | DTCode | DTCName -
|11 1st Shift 11 -~ P [AA Al Test Code AA -
Record: 14 1 k| M |k¥k|of 15 Record: 14 1 k| M |pk|of 8
Step 3: Load File Data Table Data will be loaded into OEE Management ...
(7 |

Import Tables Window

» Read/Import of OEETableScheme.xls...

Once this Worksheet has been completed, it's data can be imported by following these
steps:

» Select the 'Admin’' option on the toolbar. (Admin Login required)
» Select the 'Application Setup' option.

» Press the 'Load Initial Table Data' button at the bottom of the 'Setup Options' window.
(This button will ONLY appear if OEE Tables are empty.)

» The 'Import Tables' window will open.
» Step 1 - Press the 'Browse' button and locate the completed OEETableScheme.xls file.

» Step 2 - Press the 'Read Files' button. OEE will review the data and proceed if no
critical errors are found. In the case of critical errors, the table will be marked with a red
banner along with a description of the problem. Non-critical errors are marked with a
yellow banner. Loading of data will not proceed until all critical errors are cleared.

» Step 3 - Press the 'Load Data' button. The process will now complete, then the 'Done'
button may be pressed.

Now the imported table data may be viewed by opening the various tables from the
"TablesL2' and 'TablesL3' tabs on the toolbar.
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Editing OEE Tables

There are several underlying tables in OEE Management that define how it is structured
for a given facility. Access to these tables is set in a tiered method as shown below:

Level 2 Tables (Requires Level 2 Rights from Administrator)
» Downtime Codes

» Defect Codes

» Work Shifts

Level 3 Tables (Requires Level 3 Rights from Administrator)
» Monthly Goals

» Part Master

» Departments

» Work Centers

» Work Center Activities (Part Number Associations)
» Tooling

» Downtime Types

» User Defined Work Center Fields (PC1 & PC2)

» User Defined Work Part Grouping Field (PN1)

» User Defined Defect Field (SC1)

Administrator Tables (Requires Administrator Logon)
» Assign User Defined Fields
» User Identities and Rights

Depending on the Rights assigned by the Administrator, a user may be allowed to
access and maintain the above tables.

Access to tables is performed in one of two ways:
» Open the table by selecting the Tables (L2)' or 'Tables (L3)' option on the toolbar.
» Double-click on a data entry field which uses the table data.

Example: While entering a new Production Activity, double clicking the 'Work Center',
Work Center Activity', or ‘Shift’ pull down box will open the underlying Table of items.

The combined table data may be sent to a report for viewing or printing by selecting the
'View Table Contents Report' or 'View Work Center Report' option from the Tables (L2)'
or 'Tables (L3)' list.

If a Table Item becomes inactive, remove the check from the 'Active' checkbox. For the
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purpose of maintaining historical data integrity, it is not allowed to remove these
records, but only to de-activate them.

»» Example: If a particular Work Center is no longer in use, that Work Center should be
deactivated on the Work Center Table be removing the check from the 'Active' check
box. A deactivated Item (in this case, a Work Center) will still exist for the purpose of
historical reporting, but will no longer be available for users to select for new data.
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Chapter A6: Tables and Files (Access Version)

OEE Application Files

This section provides an overview of the files that are used for the OEE Management
application.

Application Database Files:

This application is furnished with three Microsoft® Access Database files...
» 'OEE.mde' which contains data manipulation and reporting tools.

» 'OEEData.mdb' which provides for storage of most of the data.

» 'AOSetup.mdb' which contains application setup data.

Local Database Files:

The application will automatically create a 'Local' Database file. The local database file is
used for handling data that relates to what each particular user is doing. This file is
created for each user that is using the application at any particular time. The filename
for this file will be OEEnnnnnn.mdb, where 'nnnnnn' is the first six characters of the
Network Name for the user's machine. This local file will be automatically deleted when
the user exits the OEE application.

»» Local Database filename example: For a user who is using a network machine which
is named 'NMA2', the Local Database filename will be 'OEENMA2.mdb'

Locking Files:

Additionally, three Locking Files will be created during operation...
» 'OEE.Idb'

» 'OEEData.ldb'

» 'AOSetup.ldb'

These locking files are created automatically by Microsoft® Access whenever the
associated database files are in use. The purpose of these locking files is to establish
who is in the database file and a history of data changes which each user made. These
files are handled automatically and require no intervention by users or administrator.
The locking file will always be located in the directory which contains the associated
database file.

Reading the Locking File 'OEE.Idb'":

OEE Management allows an administrator to read the users who are listed in the
application's Locking File. This capability allows an administrator to see who currently
has the application open, which can be helpful for network or application
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troubleshooting.

To read the Database Locking File:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'View DB Locking File' option. This will open a window that lists each network
Machine and User who is currently running OEE Management.

Important Notes on the Application Files:
» DO NOT rename any of the Data Files - this will make linking impossible.

» Only ONE Active copy of the Data Storage database (OEEData.mdb) may exist. Only
ONE Active copy of the Setup database (AOSetup.mdb) may exist. Backup copies may
be made and kept in same directory - with a different filename.

» The Application database (OEE.mdb), may be shared by all users on a network drive,
or individual copies may reside on each users machine (recommended arrangement).

Update Links to Data Files

OEE Management is comprised of three databases that are linked together. The
Application database (OEE.mde) stores data in the Data Storage databases
(OEEData.mdb and AOSetup.mdb).

Once the link is established between the databases, it is permanent and requires no
maintenance. Certain activities, however, may require that the links be re-established or
updated.

The following are some conditions that will lead to links being broken between the
databases:

» Initial installation of the OEE Management Application.

» Moving a data file (OEEData.mdb or AOSetup.mdb) from one directory folder to
another.

» Renaming any directory names in the path to any of the files.

Every time the OEE Management Application launches, it verifies the link to the data
storage files 'OEEData.mdb' and 'AOSetup.mdb'. If the link is determined to be broken a
window will appear asking whether the user wants to restore the links. If 'No' is Chosen,
OEE Management will close. If 'Yes' is chosen, the following steps will follow:

The 'Update Links to Data File' window will appear.

» Press the top 'Browse' button

» A Browse window will appear asking that the 'OEEData.mdb’ file be located
» Locate and select the 'OEEData.mdb'’ file
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» Press the 'Open' button

» Repeat the above steps for the bottom 'Browse' button for the 'AOSetup.mdb’ file
» Now press the 'Refresh Links' button

» A message box will appear indicating successful re-linking.

Update Links to Data File
Current=R:\OEENOEEDatah
Fath to Data File (OEEData.mdh)
| R:\OEENDEEData\OEEData. mdb Browse
Path to Setup File (AOQSetup.mdb)
| R:\OEEVDEEDatala0setup. mdb Browse
2| Refresh Links! Cancel

Update Links to Data File Window

Note on used of 'Mapped Drives':

If OEE is linked to its Data Files via a mapped network drive on a PC, then that mapping
must exist on ALL user PCs. If OEE is run on a machine without the same drive mapped,
it will not be able to locate the Data Files and will prompt to relink Data Files.

Using a mapped drive to reach the data files will not cause a problem as long as all
users have the same drive mapping set up on their PC’s.

If it is desired to establish links without using mapped drives, then linking should be set
by browsing directly to the correct network folder. When linking to Data Tables, browse
to the top of the network hierarchy then work back down to the target network folder.
Generally it is best to browse all the way up to 'Desktop' then work back down, being
careful not to select mapped drives.

Archiving & Deleting Records

Over time, the OEE Management Database will grow contain many thousands of
records. Although there is no practical limit to the amount of records that can be
handled, at times it may make sense to remove old records. As an example, records
from last year may or not be useful to keep available, records from two years ago are
very unlikely to be used.

Removing old records will improve performance speed as well as reducing disk space
usage. It should be considered as an option for prior year's records.

To remove old records:
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Step 1 - Archive....

» First, archive the current data by making a copy of 'OEEData.mdb' and storing that
file in another directory or on a backup drive.

Step 2 - Delete....

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select the 'Mass Record Delete' option.

Mass Record Delete
Records Found:
Select a Date Rangs: Shifts Found I 262

Prod Date [01/01/10 thru[03/31/10 @ DT Events Found | 1069

Scrap Events Found I 2

Bulk Entries Found 0

WARMIMG: If the records selected above are deleted

they will NOT be recoverable, Records should only be

deleted after they have been archived to alternate Delete selected |
ropies of 'OEEData.mdb’ and 'ParData.mdb. See Help
for more information.

7 Done |

Mass Record Delete Window

» On the Mass Record Delete window, select the Date Range for period where records
are to be deleted. The amount of records found will be displayed and the 'Delete
Selected' button will be activated.

» Press the 'Delete Selected' button and follow the prompts to complete the operation.

ONCE RECORDS ARE DELETED THEY MAY NOT BE RECOVERED. In the event of
mistakes there may be options such as:

» Restore a recent backup copy of 'OEEData.mdb' - assuming it resides on a backed up
network drive.

» The archived copy of 'OEEData.mdb' may be restored by replacing the damaged copy
of 'OEEData.mdb' with the archive copy.

Note: This archive copy of OEEData.mdb will still be available for use by relinking a copy
of OEE.mdb to it. (See Help on Updating Links)

Compacting Application Files

OEE Management is a database application which uses disk space as needed to
manipulate the data. Over time the size of the database files tends to grow. As the file
sizes grow, speed of performance will be affected, as well as the additional use of disk
space.
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This application uses three database files:

» 'OEE.mde' which contains data manipulation and reporting tools.
» 'OEEData.mdb' which provides for storage of most of the data.
» 'AOSetup.mdb' which contains application setup data.

Each of these files is subject to growing in size and need to be periodically compacted.
Compacting is a process of reorganizing all of the elements of a database file into an
efficient and better performing arrangement.

Although there is no hard and fast rule, it is recommended to Compact the files about
once per month.

The procedure is...
OEE Management

Filz Tables (L3) Admin | o&w

E Tableg\g ___(___J_i%@.\ 7 &
Edit Downtime Codes Edit Monthly Goals Application Setup

Edit Scrap Codes Edit Part Master i User Identities

View DB Locking File
Edit Shifts Edit Departments i £

£f Compact OEE.mdb

‘L Compact OEEData.mdb
3% Repair Database

@ Mass Record Delete

View Table Contents Report Edit Work Centers
View Work Center Report Edit Work Ctr Activities
Edit Equipment
Edit Tooling

=5 Update Links

Edit Downtime Types

User Def, Wrk Ctr Field 1
User Def. Wrk Ctr Field 2
User Def. Part No. Field
User Def. Scrap Field

View Table Contents Report
View Work Center Report

Step 1 - Compact OEE.mdb (Application Database)

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select the 'Compact OEE.mdb' option.

Now the Compact activity will take place and OEE Management will automatically
restart.

Step 2 - Compact OEEData.mdb - AOSetup.mdb (Data Storage Files)
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» Select the 'Admin' option on the toolbar.
» Select the 'Compact OEEData.mdb - AOSetup.mdb' option.

Repairing of Data Files

A database file may occasionally become corrupt due to events such as power outage,
or failure of network or disk operations. In the event of an issue with the data files, a
warning will generally appear when attempt is made to open the OEE.mde application...

Microsoft Office Access His _ x|

' Unrecognized database format .. \OEEData.mdhb'.
o 5

r

...............................

Should this occur, the data file can be repaired as follows:

» All users must exit the OEE Management application.

» Navigate to the directory where the data file ('OEEData.mdb") resides.
» Now, the data file may be opened by double clicking.

» If the file is corrupt, a message box will announce this and ask for permission to
repair.

» Permit the repair then close the file.
» Now OEE Management may be restarted.

If problems persist, follow the same procedure for the Setup File ('"AOSetup.mdb')

It is highly recommended that this or any network application is backed up frequently to
offer protection in the event of file damage.
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Chapter A7: Tables and Files (SQL Server Version)

OEE Application Files

This section provides an overview of the files that are used for the OEE Management
application.

Application Database Files:
This application is furnished with one Microsoft® Access Database files...
» 'OEE.mde' which contains data manipulation and reporting tools.

Local Database File:

The application will automatically create a 'Local' Database file. The local database file is
used for handling data that relates to what each particular user is doing. This file is
created for each user that is using the application at any particular time. The filename
for this file will be OEEnnnnnn.mdb, where 'nnnnnn' is the first six characters of the
Network Name for the user's machine. This local file will be automatically deleted when
the user exits the OEE application.

»» Local Database filename example: For a user who is using a network machine which
is named 'NMA2', the Local Database filename will be 'OEENMA2.mdb'

Additionally, a Locking File will be created during operation: 'OEE.|db'

These locking file is created automatically by Microsoft® Access whenever the
associated database file is in use. The purpose of the locking file is to establish who is in
the database file and a history of data changes which each user made. The file is
handled automatically and requires no intervention by users or administrator. The
locking file will always be located in the directory that contains the associated database
file.

Reading the Locking File 'OEE.Idb'":

OEE Management allows an administrator to read the users who are listed in the
application's Locking File. This capability allows an administrator to see who currently
has the application open, which can be helpful for network or application
troubleshooting.

To read the Database Locking File:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'View DB Locking File' option. This will open a window that lists each network
Machine and User who is currently running OEE Management.
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Manage SQL Server Connection

OEE Management is comprised of the Access application database (OEE.mde) which
maintains data within a SQL Server Database (typically named CapstoneOEE). Once the
connection is established to the SQL Server Database, it is permanent and generally
requires no maintenance.

Certain activities, however, may require that the connection to SQL Server Database be
re-established or updated. The following are some conditions that will lead to the
connection to the SQL Server Database being lost:

» Initial installation of the OEE Management Application.
» Changes made to the SQL Server Connection String.

A blank SQL Server Database is provided with the original OEE Management application
in the form of a database backup file named CapstoneOEE.bak. This database backup
file must be restored to your SQL Server installation using the methods and tools which
are provided by SQL Server Management Studio. Typically, the restored database is
named CapstoneOEE.

The specific Microsoft SQL Server application is chosen by the client as several options
are available. Clients who already use one of the Microsoft SQL Server applications will
find the addition of this new database to be a fast and simple process. Note that this
application will perform well on the entry level SQL Server Express product, which is a
free download at Microsoft.com.

Every time the OEE Management Application launches, it verifies the connection to the
SQL Server Database. If the connection is determined to unavailable, a window will
appear for the purpose of establishing a connection to the SQL Server Database. If this
operation is not successfully completed, OEE Management will close. To establish
connection to the SQL Server Database, the following steps are required:

The ‘Manage Your SQL Server Connection” window will appear.
» Enter the SQL Server Name
» Enter the SQL Server Database Name (typically named CapstoneOEE)

» Check/Uncheck Trusted Server as appropriate for your SQL Server configuration (If
unchecked then entry of User and Password is also required)

» Press ‘Update Primary Conn. String’ to generate the SQL Server Connection String
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Manage Your SQL Server Connection [ 23]

Primary Server lﬁ.lternate Server

Server: |Y|:-L|r Server Mame

DE Mame: |Datal:-ase Mame {typically CapstoneDEE) Lizer- |o|-,|-:l.- Reguired when

Use Trusted Server: 7 Password: | option is NOT used

Conn String: | Connection String will be automatically created after above data is provided and this
Button is pressed
IUpdate Primary Conn String |
;‘:{“\ Microsodt Connect to SOQL Server Mow |
i - SQL SEI’VE‘I’ Connect on next ReStart [~ JDO"E

» At this point, the connection to SQL Server may be established immediately by
pressing ‘Connect to SQL Server Now’, or the ‘Connect on next Restart’ box may be
checked in order for the connection to be made when the application is restarted.

Compacting Application File

OEE Management is a database application which uses disk space as needed to
manipulate the data. Over time the size of the database files tends to grow. As the file
sizes grow, speed of performance will be affected, as well as the additional use of disk
space.

It is recommended that the OEE.mde file be periodically compacted. Compacting is a
process of reorganizing all of the elements of a database file into an efficient and better
performing arrangement. Although there is no hard and fast rule, it is recommended to
compact about once per month.

The procedure is...
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OEE Management

Filz Tables (L3) Admin | o&w

E Tableg\g ___(___J_i%@.\ 7 &
Edit Downtime Codes Edit Monthly Goals Application Setup

Edit Scrap Codes Edit Part Master i User Identities

View DB Locking File
Edit Shifts Edit Departments i £

‘£ Compact OEE.mdb
% Repair Database
) Mass Record Delete

View Table Contents Report Edit Work Centers
View Work Center Report Edit Work Ctr Activities
Edit Equipment
Edit Tooling =g SQL Setup

Edit Downtime Types

User Def, Wrk Ctr Field 1
User Def. Wrk Ctr Field 2
User Def. Part No. Field
User Def. Scrap Field

View Table Contents Report
View Work Center Report

Step 1 - Compact OEE.mde (Application Database)

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select the 'Compact OEE.mdb' option.

Now the Compact activity will take place and OEE Management will automatically
restart.
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Chapter A8: Importing Daily Data

Importing Data - Overview

OEE Management is capable of importing Production Activity Data from properly
formatted files. With this capability, data may be imported from the Business System for
direct entry into OEE or Work Center automation can be programmed to collect real time
data, and then write it to an import file.

Importing may be performed only by Level 3 Users.

Import Requirements:
» Data Importing must be enabled.

» Files must be written to a pre-defined network directory in order to be located and
imported.

» Files must be named and structured exactly as specified herein.

Importing Data - File Structure

The following describes how the import files must be named and structured.

File Naming:

» 'OEEP####.csv' or "OEEP### #.txt' Production Activity Data - REQUIRED

» 'OEES####.csv' or 'OEES# # ##.txt' Defect Data - Created only if Defect Data exists

» 'OEED####.csv' or 'OEED# ###.txt' Downtime Data - Created only if Downtime Data exists
Where: #### = a pseudo-unique number which is used for a given day.

» The above file naming convention should be implemented in such a way to insure that
each filename will be unique within a 30 day period.

File Specification:
» File must use comma-delimited records.
» File extension must be .csv or .txt

» File Header Row is optional, ie: the first record may contain the field names or may be
the first data record. If Header Row is used the field names MUST match the names
described below in File Record Structure. (Names are not case-sensitive). The chosen
Header Row mode MUST be selected on the Application Setup window so that it
corresponds to the structure of the Import Files.

File Record Structure:

File 'OEEP# ###.csv' or 'OEEP####.txt' (Production Data)
Record Structure...

Field Name Typ. Data Format/Notes
field 1: Pdate 9/3/2005  m/d/yyyy - four digit year
field 2:  ShiftID 1 Shift index - see Index Values
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field 3: PUID 9 Work Center index - see Index Values

field 4: PNID 45 Part Number index - see Index Values

field 5: GdUnits 264 integer (Units of Good Production)

field 6: Stime* 07:00 hh:mm - 24 hour format (Shift Start Time) Optional
field 7: Etime* 15:30 hh:mm - 24 hour format (Shift End Time) Optional/
field 8:  Sdur* 480 integer (Duration of Shift in minutes) Optional

field 9: Puserl 123abc alphanumeric — (User Defined Lot Code) Optional
field 10: ActLabor 1.5 single — (Actual Labor Headcount) Optional

field 11: ActSpeed 1.5 single — (Actual Process Speed) Optional

field 12: MatchIndex 6 long integer — (to match Defect/DT data) Optional

»» Sample Record: 9/3/2005,1,9,45,264,07:00,15:30,,,,,

e Stime & Etime data should be provided when available. If not available send null fields (,,)

e Sdur may be set as alternate. If not available send null field (,)

e If neither of the above is sent then the default shift times from the Shifts Table will be used.

File 'OEES# ###.csv' or 'OEES# ## #.txt' (Defect Data)
Record Structure...
Field Name Typ. Data Format/Notes

field 1: Pdate 9/3/2005  m/d/yyyy - four digit year

field 2:  ShiftID 1 Shift index - see Index Values

field 3: PUID 9 Work Center index - see Index Values

field 4: PNID 45 Part Number index - see Index Values

field 5:  ScodelD 23 Defect Code index - see Index Values

field 6: Sqty 6 integer (Amount of Defect)

field 7: SCAttrib True Boolean (User Defined Attribute) Optional

field 8: Rwrk False Boolean (Rework Flag) Optional

field 9: MatchIndex 6 long integer — (to match Production data) Optional

»» Sample Record: 9/3/2005,1,9,45,23,6,,,

File 'OEED####.csv' or 'OEED### #.txt' (Downtime Data)
Record Structure...
Field Name Typ. Data Format/Notes

field 1: Pdate 9/3/2005 m/d/yyyy - four digit year

field 2:  ShiftID 1 Shift index - see Index Values

field 3: PUID 9 Work Center index - see Index Values

field 4: PNID 45 Part Number index - see Index Values Optional
field 5: DTCID 22 Downtime Code index - see Index Values

field 6: Stime* 12:53 hh:mm - 24 hour format — (DT Start Time) Optional
field 7: Etime* 13:32 hh:mm - 24 hour format — (DT End Time) Optional
field 8: DTdur* 39 integer (Duration of Downtime in minutes) Optiona/
field 9: MatchIndex 6 long integer — (to match Production data) Optional

»» Sample Record: 9/3/2005,1,9,45,22,12:53,13:32,,

e Stime & Etime data should be provided when available. If not available send null fields (,,)
e DTdur may be set as alternate. If not available send null field (,)

e Either Stime/Etime or DTDur must be sent.

All data must be comma-delimited.

Timing of File Creation:

» Timing of creation for Import Files is not critical as long as a pseudo-random filename
is being used. OEE can import any and all files that are available at any given time.
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Action after Import Files have been imported:

After an Import Files file has been successfully imported into OEE Management, it needs
to be handled in such a way that it cannot be imported again. This eliminates the
possibility of a Production Activity being imported redundantly. Two options are available
for handling old Import Files files...

» Delete File - If this option is selected, the file will be deleted after it has been
successfully imported.

» Prefix Filename with 'x' (Recommended) - If this option is selected, the file name will
have a leading 'x' added after it has been successfully imported.

»» Example of file renaming: File 'OEEP1234.csv' changes to 'XOEEP1234.csV'

Importing Data - Index Values

An understanding Index Values is important if data is to be directly imported into OEE
Management.

In nearly all database applications, Indexed Data Tables are used to improve speed of
access, while reducing memory and disk space usage. An Index is a number (generally a
long integer but may be alpha-numeric) that corresponds to each record in a table. This
allows a particular record to be found or handled using the integer reference rather than
having to use text expressions for this purpose. Also, this method greatly reduces
redundant data.

For the purposes of importing data into OEE Management, the user need only know
what the Index Values are for the data selections which are to be included in the Import
file.

»» Example of Index Usage:

For the following Table of Downtime Codes it can be seen that each record (or list item)
has an Index Value which corresponds to the actual Text Value. (Note that this is only
an example and that Index Values will vary for each application based on how the user
sets the system up.)

INDEX DOWNTIME CODE
1 Hydraulic Problem
2 Electrical Power Outage
3 Scheduled Down
n etc..

Within the OEE Management application, all references to the 'Hydraulic Problem'
downtime code are handled by using the Index Value of 1, NOT the text description.
Index Values are determined at the time that a new record is added to a |list. For
instance, the Index Value of 1 was automatically established for 'Hydraulic Problem' at
the time that that code was first added to the 'Edit Downtime Codes' Table.
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» Which Index Values to Use:

OEE Management must use Index Values in order to reliably import data. There are two
options as far as which Index Values are to be used. OEE Management maintains a set
of Index Values for every Table Item - these may be used for importing of data. Or,
another set of 'User Furnished' Values may be used, such as the Index Values which
reside in an ERP or Business System. This decision is based on a few factors and is
discussed below.

» Use of EXTERNAL Index Values:

This is generally the recommended approach when importing data from a Business
System or ERP. Using this approach allows OEE to integrate with the ERP without
making any changes to the ERP table designs. The data can be exported from the ERP
using a common Query Editor.

In order for OEE Management to operate on ERP Index Values, these values are added
to the OEE tables (in addition to the automatically generated OEE Index Values) Once
completed, the two systems are now reliably linked.

» Use of INTERNAL Index Values:

Use of OEE internal Index Values is recommended when the data is being imported from
Shop Floor Automation systems. Since these systems are generally independent it
makes sense to program them with the OEE Index Values.

In order for Shop Floor PLCs or computers to use OEE Management Index Values, OEE
can provide reports and Microsoft® Excel exports which contain the values.
Programmers may then build this data in at the shop floor level.

» How to Get Internal OEE Index Values:

In order to implement Shop Floor Data Collection, the tables of Index Values must be
exported and used for the design of the Work Center's data collection package. The
index information may be exported to a Microsoft® Excel Worksheet. To export these
tables:

To Export Index Values to a specified Directory:

» Select the 'Admin' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Import Path' tab.

» Be sure that the 'Path for Export of Index Lists' box contains the target directory (or
hit 'Browse' to select a directory).

» Press each of the four buttons to save each Excel File to the target directory.
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» Now the Excel Worksheets may be used to set up the Shop Floor Data Collection
package.

Files Containing Index Values:

INDEX WHERE FOUND
ShiftIndex 'OEE_Idx_Production Activitys.xls' (Scheduled Production Activitys)
WCIndex 'OEE_Idx_WorkCtrs.xls' (Work Centers)
PartNumIndex 'OEE_Idx_PtNums.xls' (Part Numbers)
DTCauselndex 'OEE_Idx_DTCodes.xls' (Downtime Causes)
DefectCauselndex 'OEE_Idx_ScrapCodes.xls' (Defect Causes)

Matching Imported Records

OEE Management will attempt to attach each Defect, Downtime, and Adjustment Events
to the appropriate Production Activity.

Rules for matching records...
Defect Events:

1) OEE will attempt to find a Production Activity which matches: Date-Shift-WC-PN for
the Defect Event - if found, the Defect Event will be attached. (Note: If Match Index
Values are included in the Defect File and the Production File, then matching will be
made as follows: Date-Shift-WC-PN-MatchIndex)

a. If the above fails, OEE will attempt to find a Production Activity which
matches: WC-PN, with Date on or before the Defect Event Date - if found,
the Defect Event will be attached.

b. If the above fails, OEE will attempt to find a Production Activity which
matches: PN with Date on or before the Defect Event Date - if found, the
Defect Event will be attached.

c. If the above fails, the Defect Event will be ignored.
Downtime Events:

2) OEE will attempt to find a Production Activity which matches: Date-Shift-WC-PN - if
found, the Downtime Event will be attached. (Note: If Match Index Values are
included in the Downtime File and the Production File, then matching will be made
as follows: Date-Shift-WC-PN-MatchIndex)

1)
a. If the above fails, the Downtime Event will be ignored.
Production Adjustments:

1) Any imported Production Record with a negative GdUnits value is assumed to be an
adjustment to Net Production.

2) OEE will attempt to find the last Production Activity which ran that Part Number, on
or prior to the adjustment Date.

a) If no prior Activity for that Part Number is found, the Adjustment will be
ignored.

3) If a valid Production Activity is found, the Adjustment will be subtracted from the Net
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Production for that Activity.

a) If the Production Activity can absorb the total adjustment, then the
adjustment is made and the process is complete.

b) If the Production Activity Net Units is smaller than the adjustment, then
i. The Activity will be reduced to 0 Net Production, and...

i. The remaining adjustment will be subtracted from the next prior
Activity which is found for that Part Number.

Use of the Match Index

In cases where more than one Production Activity may exist for a particular Date-Shift-
WC-PN combination, then the Match Index may be used to keep Defect and Downtime
records synchronized to the appropriate Production Activity. For example, when the
same part may run more than once during a shift, use of the Match Index is
recommended.

The Match Index is a number (long integer) that is shared by all records that should be
matched. The number must be unique for a given Date-Shift-WC-PN combination.

Set Options for Importing Daily Data

OEE Management is capable of importing Production Activity Data from properly
formatted files.

See page 128 for further explanation of importing production data.
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Setup Options for OEE Management

OEE Management |
OEE Management Setup Features

Auto DT Calc I Case [ Bulk Units | Create Forms
Wiew I Cptions I Calendar I Tooling Setup | OEE Calc | LIser Fields
OutputtoExcel | ImportPath | LocalDBPath | Advanced

Impaort Indexing: ¢ Int {w Ext
Enable Importing [~

IIse Header Row: Y: M
Path for Import File; N LA

|C: YOEE\ImportTables), Browse

;__l Action after .txt file is imported: © Delete @& Prefix Filename with '

Open Import Assistant

d Load Part Updates | Done |

To Enable Importing and perform Setup:

» Select the 'Admin’' option on the toolbar. (Note that this option is only visible when the
Administrator Logon is active)

» Select 'Application Setup' option. This will open the 'Setup Options' window.
» Select the 'Import Path' tab.

» Check or Uncheck the 'Allow Data Import' checkbox.

» Select the Indexing Method (see page 130 for more information)

» Select the File Header preference (see page 128 for more information)

» Press the 'Browse' button, then navigate to the directory where import files will be
placed.

» At bottom of page, select either the 'Delete' option or the 'Prefix Filename with 'x"
option. (see page 128 for more information)

» For assistance in setting up import files, press the ‘Open Import Assistant’ button to
open the Import Assistant shown below. The Import Assistant will allow user to select a
specific Activity then to see exactly what an import record for that Activity would look
like.
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e

Import Assistant

Select a Production Activity... SetView: [~r1gday [ Yesterday | Import Indexing: ¢ Int ™ Ext |

the correct impart records will be

displayed. F'.EFIQEI 02-May-13 _I 02-May-13 @I | IUse Header Row: ¢ Yes ¢ Mo |

T Day | shift | Prod | Part Mumber | Wark Center | Department

02-May-13 1 9:50 AM | 2:30 PM U] 835351E Press 1 Injection

02-May-13 1 2:00 AM | LOOPM | 240 [835350G Assy 1 Aszzembly

02-May-13 3 6:00 PM | 7:05 PM 5 AZ1IK Assy 5 Assembly

02-May-13 3 L:OOPM | Z:03PM | 30 |AL120M Assy 1 Assembly

p| 02-May-13 3 3:45 AM | 5:03 AM 33 (89433 Press 1 Injection

02-May-13 3 S:13 AM 6:08AM | 20 [8320A Assy 1 Assembly

Production File Use Match [~
Fieldl1  Field2 Field3 Field4  Field5 Field6 Field7 Field8 Field9  Field 10 Field 11 Field 12
PDate ShiftiD PUID  PNID GdUnits  STime  ETime  SDur PlUserl Actlabor ActSpeed Match

522013 3 13 213 35 5:45 2:038 23 0 0
notused notused notused

Sample Production Record Pdate, ShiftiD, PUID, PMID, GdUnits, Stime, Etime , Sdur Puser 1, ActLabor  ActSpeed, MatchIndex
5/2/2013,3,13,218,35,05:45,06:08,23,,,,

Defect File Field5 Fieldeé Field7 Fieldd Field 9
SCodelD SOty SCAtrib  Rwrk Match
First Defect Event 95 2 False | 95 - ~SPLAY
Sample Defect Records pdate, ShiftID, PUID, PMNID, ScodelD, Sqty, SCAtrib, Rwrk, MatchIndex
5/2/2013,3,18,218,95,2,,False,
Downtime File Field 5 Fieldé Field7 Field8 Field 9
DTCID STime  ETime  DTDur Match
First Downtime Event 11 5:45 5:50 5 105 - Start Up
Sample Downtime Records Pdate, ShiftID, PUID,PNID, OTCID, Stime, Etime, Sdur ,MatchIndex
5/2/2013,3,18,218,11,05:45,05: 50,5,
d Done

Import Assistant Window
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Chapter A9: Maintenance

Updating of OEE Part Table

Periodically, it may be desirable to make updates to the OEE Part Table based on
changes in the business. These updates may stem from changing standards for existing
parts or from addition of new parts.

To perform this update, the user has two options:

1) Manually type data in using the built in Part Table form. This is generally not
recommended due to the large amount of data which is generally involved.

2) Automatically import the new and revised part data using the pre-formatted
Worksheet 'OEETablePartUpdate.xls' that is provided with this application. The
remainder of this Help Subject will deal with automatic importing of part table updates.

@Eile Edit View Insert Format Tools Data Window Help

DR SRAY BRI v-o- @A 83 @.ﬂwO%v@,i Arial

B7 ~] =

_A‘
>

W~ W =
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EXtPNID | Pnum PNName | PNRate | PHLabor | StdSpeed | ScrapCost |ReworkCost| OptCost

1234abcd Jwidget 60 1 1.53
3987drte  |gadget 43.71 345 1.074 0.56

\.

Any NondBlank Fields in these columns will be used to revise the current Part Master

Sample of OEETablePartUpdate.xls ‘\Worksheet

» Preparation of OEETablePartUpdate.xls...

The Worksheet consists of two tabbed sheets. The first sheet provides an overview of
the data structure and should be read before proceeding. The remaining sheet named
'PartUpdates’ is for entry of the actual data.

Table data may be entered by any means that is convenient to the user. Generally 'copy
and paste' from other sources will be the most efficient method.

Part Table Update Data - For REVISED Parts:

For revised part data, the Part Number field (PNum) is required to be correctly filled with
values that will correspond to Part Numbers which already exist in OEE Management.
The part number is used to relate the new data to the current part records, and
therefore must be correct.

n addition to the part number field, only the revised fields need be populated...
PNName, PNRate, PNLabor, StdSpeed, ScrapCost, and/or ReworkCost

Whichever field(s) are populated will be used to replace the existing data in OEE
Management Part Table. The importing process will only apply changes the PNName,
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PNRate, PNLabor, StdSpeed, ScrapCost, and/or ReworkCost, all other fields are ignored.

Part Table Update Data - For NEW Parts:

For new part data, all data is required as described in the above Help Subject named
'Initial Loading of OEE Tables'.Part Table Update Data - For NEW Parts:

For new part data, all data is required as described in the above Help Subject named
'Initial Loading of OEE Tables'.

Note that REVISED and NEW part information should be combined in the
OEETablePartUpdate.xls Worksheet. OEE will determine if each record is revised or new
based on whether the part humber already exist in the OEE Management Part Table. In
other words, filling the Worksheet with your current part data is all that is required, OEE
will sort out what is a revision and what is a new part.

» Make a backup copy of AOSetup.mdb...

Since this process will make changes to the OEE Management Part Table, it is
recommended to back up the AOSetup.mdb file before beginning the import. (This file is
used to store part data.)

This extra step provides a way to return to the old data if the revised / new data is
found to be incorrect or otherwise unusable. In this case, the backup copy of
AOSetup.mdb can be used to return to the previous values.

Import Part Table Updates
Step 1: Find File Browse to Location of OEETablePartUpdate.xls ...

| Browse
Step 2: Read File File will be read and checked for errars...

Information found in OEETablePartUpdate.xls

Part Updates Part Statistics
ExtPNID | Pnum | PNName | PNRate | PNLabor

Record: 14

Step 3: Load File Data Updated Part Data will be loaded into OEE Management ...

a

Import Part Table Updates Window

» Read/Import of OEETablePartUpdate.xls...

Once this Worksheet has been completed, it's data may be imported by following these
steps:
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» Select the 'Admin' option on the toolbar. (Admin Login required)
» Select the 'Application Setup' option.

» Press the 'Load Part Updates' button at the bottom of the 'Setup Options' window.
(This button will ONLY appear if OEE Tables are already populated.)

» The 'Import Part Table Updates' window will open.

» Step 1 - Press the 'Browse' button and locate the completed OEETablePartUpdate.xls
file.

» Step 2 - Press the 'Read Files' button. OEE will review the data and proceed if no
critical errors are found. In the case of critical errors, the table will be marked with a red
banner along with a description of the problem. Loading of data will not proceed until all
critical errors are cleared. Also, statistics will be reported on the Worksheet data
indicating the counts of Revised; Unchanged; and New records.

» Step 3 - Press the 'Load Data' button. The 'Confirm Part Data Changes' window will
open. This window allows final review of the changes and additions to the part table.
When satisfied that the changes are acceptable, press the 'Confirm' button. After
completion of final confirmation, a message window will pop up indicating that part
changes are complete.

» Step 4 - The process is now complete, the 'Done' button on the 'Import Part Table
Updates' window may now be pressed.

Now the updated Part Table data may be viewed by opening from the TablesL3' tab on
the toolbar.
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Chapter A10: Microsoft® Trusted Locations

Overview of Trusted Locations (Microsoft® Access 2007 and
2010)

Microsoft® Access 2007 and 2010 versions protect users by encouraging that the
software being run (in this case, OEE Management Software) resides in a “Trusted
Location”. This feature may cause warnings and multiple permissions at startup of the
OEE Application if it is not running in a Trusted Location.

For more information on Microsoft Access 2007/2010 Security, please visit...
Get started with Access 2007 security - Access - Microsoft Office

For the OEE Management Software application is run correctly, certain locations must be
set up as Trusted Locations...

» In all cases, each user’s local drive (typically C:\ and its subfolders) must be a
Trusted Location. The OEE Management software stores local files an that location.

» In cases where the OEE Management Software is run from a network location,
that network folder, and its subfolders, must be Trusted Locations.

OEE Management Software will attempt to set up these Trusted Locations automatically
when the application is run for the first time on a machine.

When the OEE Software is started it will check to insure that the necessary Trusted
Locations are established. If the Trusted Locations are missing, OEE Software will open
a popup 'Trust Center' window to display the status of the Trusted Locations and allow
for them to be automatically registered...

I "
Trust Center
Registry Folder: HKEY_CURREMT _USER\SoftwareMicrosoft\Officel 14, 0Vaccess \Security {Trusted
Locations L ocation
Add Trusted Locations

OEE App Location: C:\Users\User\Desktop

. [ KeyFound [ Kew'wiitten [ KewVenfied Key Mame;
OEE Local Location: C:\OEELocal

. [ KeyFound [ Kew'wiitten [ KewVenfied Key Mame;
1J Done

Trust Center Window

If the Trust Center opens on start up, just press the 'Add Trusted Locations' button. The
locations will be set and verified and reported on the window as shown below...
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s "

Trust Center

Registry Folder: HKEY _CURREMNT _USER \Software \Microsoft\Office’ 14, 0\Access \Security {Trusted
LocationsLocation

OEE App Location: C:\Users\User\Desktop

. [ KeyFaound W Eewwiitten [V EepVerfied Key Name: Location2
OEE Local Location: C:\OEELocal
. [ KeyFaound W Eewwiitten [V EepVerfied Key Name: Location3
L ~

Trust Center Window

If, after pressing the 'Add Trusted Locations' button, either location continues to show a
Red status, please seek assistance from IT Administration to resolve. This issue usually
stems from network security settings.

If the OEE Management Software application is run without establishing the necessary
Trusted Locations then the following warning can be expected at startup...

Microsoft Dffice Access Security Nokic 2 x|

@ A potential security concern has been identified.

Warning: It is not possible to determine that this
content came from a trustworthy source. You should
leave this content disabled unless the content provides
critical functionality and you trust its source.

File Path: <. .. \Desktopt OEEYOEE . mde

This file might contain unsafe content that could harm your
computer. Do you want to open this file ar cancel the operation?

Mare information

Cpen i Cancel
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Manually Set User’s Local Drive as a Trusted Location

The following steps may be taken to set a PCs Local Drive as a Trusted Location:

» Start Microsoft® Access 2007 or 2010 from your 'Start' Menu

» Now press the round ‘Office Button’ at the top left corner of the /.
Microsoft® Access window. a2y

» Press ‘Access Options’ to open the ‘Access Options’ window

41

j Recent Documents

1 Part Mumber Query

.‘H Manage >

_] Access Options . ;X Exit Access |
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» On the ‘Access Options’ window, press the ‘Trust Center’ button
» Press the ‘Trust Center Settings...” button

Access Options 2=

Papul
apular @ Help keep your documents safe and your computer secure and healthy,

Current Database

Datasheet Protecting your privacy
Chject Designers Microsoft cares about your privacy, For mare infarmation about how Microsaft Office Access helps to protect your privacy,
please see the privacy statements.
Proofing . . .
Show the Microsoft Office Access privacy statement
Advanced Microsoft Office Online privacy statement

Customer Experience Improvement Pragram

Customize

Add-ins Security & more
 Trust Center —..| Learn more about protecting your privacy and security from Microsoft Office Online,

A o { AT P ’ i

Resaurces Microsoft Windows Security Center
Microsoft Trustworthy Camputing

Microsoft Office Access Trust Center
@ The Trust Center cantains security and privacy settings. These settings help keep your computer .
secure. We recommend that you da not change these settings. Trust Centgr Settings... |

&3

{ Second Click )
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» On the ‘Trust Center’ window, press the ‘Trusted Locations’ button
» Press the ‘Add New Location...” button

Trust Center ﬂﬂ

Trusted Publishers Trusted Locations

- Trusted Locations
| ‘1 Warning: All these locations are treated as trusted sources for apening files, If you change or add a location, make sure that

the new lacation is secure,

Add-ins
Path | pescription | pate Modified |

Macro Settings \
Message Bar

First Click
Privacy Options <©

Path: “laonetfily
Description:

CSecond Clik™

Date Modified:
Sub Falders: Allowed
Add wlocation... | Remove | Modify... |
)

v Allow Trusted Locations an my netwaork (not recommended]
I~ Disable all Trusted Locations, Only files signed by Trusted Publishers will be trusted.
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On the *Microsoft Office Trusted Location” window...

» Type in or Browse to the C:\ folder (the computer’s hard drive), press ‘OK’
» Place a check in the box for ‘Subfolders of this location are also trusted’

» Press ‘OK’

Trusted Publishers

Trusted Locations

“ Trusted Lacations
| | Warning: All these locations are treated as trusted sources for opening files, If you change or add a location, make sure that

Add-ins the new location is secure,
Path | pescription | pate Modified |

Macro Settings
Message Bar

Privacy Optians

Microsoft Office Trusted Location 2=

Warning: This location will be treated as a trusted source for opening files. If you
change or add a location, make sure that the new location is secure.

Path:

ICI'\
h&nt&er 'Y or browse to it Browse... |

W Subfolders of this [ncation are also trusted!

Dé(ipﬁon:
<ZBe sure to click here_» When done, click here

Date and Time Created:  12/22/2010 2:48 PM

Cancel
Path: “aanetfil
Description:
Date Modified:
Sub Folders: Allowed
Add new location... Bemaove | Modify... |

I Allowy Trusted Locations on my network (not recommended}
r Dizable all Trusted Lacations., Only files signed by Trusted Publishers will be trusted,

QK | Cancel |
F

© 2001-2015 Capstone Metrics LLC www.capstonemetrics.com User Manual for OEE Management - Page 144



» On the 'Trust Center’ window, press ‘OK, then ‘OK’ to complete the setup of the
Trusted Location

Trust Center 2=

Trusted Publishers Trusted Locations

Trusted Locations o i i ) ) .
Warning: All these lacations are treated as trusted sources for apening files, If you change or add a location, make sure that
Add-ins the new location is secure,

Path | pescription | Date Modified |

Macro Settings

=y
Message Bar t
Privacy Options Moy, T3y is setup as a Trusted@

12/22/2010 2:49 PM

Path: o
Description:

Date Modified: 12/22/2010 2:49 PM

Sub Folders: Allowed
Bemaove | Modify... |
I Allow Trusted Locations on my netwaork (not recommendeadj
r Dizable all Trusted Lacations., Only files signed by Trusted Publishers will be trusted,
OK | Cancel |
— p.

Manually Set a Network Folder as a Trusted Location

In cases where the OEE Management Software is run from a network location, that
network folder, and its subfolders, must be Trusted Locations.

The steps required to set a network folder as a Trusted Location are the same as
described above for a local drive. The folder where the OEE Management Software
resides, as well as its subfolder(s) should be handled in the same manner as was C:\.

Note that some network configurations may not allow users to make this change. In this
case, please contact your IT representative for assistance.
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Chapter A1l: Using the Microsoft® Access Runtime
For users who want to run OEE Management Software without the expense of
purchasing Microsoft® Access...

You may choose to run Capstone OEE Management Software using the Microsoft®
Access Runtime Version, which may be obtained from microsoft.com as a FREE
download.

eThis download is intended to run any Microsoft® Access application without the
requirement of purchasing a licensed copy of Microsoft® Access.

e¢Once the Microsoft® Access Runtime Version is downloaded and installed on your
machine just run Capstone OEE Management Software.

eNote that Access Runtime Version is supported by OEE Management Software 6.0
and greater.

Downloading the Access Runtime

To download the Runtime Version, please use this link to visit Microsoft website.
Download Access 2010 Runtime

Then follow the webpage steps as shown below...

l] Microsoft Access 2010 Runtime

Step 1: Select Language;
then press Download

Select Language: English |Z| ‘ Download ]

The Microsoft Access 2010 Runtime enables you to distribute Access
2010 applications to users who do not have the full version of Access
2010 installed on their com puters.

@ Details

@ Systermn Requirements
@ Install Instructions

@ Related Resources
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Step 1 is to select a language then press Download button.

®
Choose the download you want
I File Name Size
W 212.4 ME

Step 2:
Check AccessRuntime.exe;
Then press Next

Step 2 is to check the AccessRuntime.exe file, then press Next.

(Do not download the AccessRuntime_X64.exe file)

To install the download:

1. Download the file by clicking Download and saving the file to your hard disk.

2. Double-click the AccessRuntime.exe file on your hard disk to start the Setup program.
3. Follow the instructions on the screen to complete the installation.

Using the Access Runtime

After installing the Access Runtime file, it will reside on your machine and will start
automatically when you run a Microsoft® Access application. To run Capstone OEE
Management Software, just double-click your OEE.mde file.

There is one difference between Microsoft® Access Runtime Version and the fully
licensed Access 2007 and 2010 versions...

Microsoft® Access Runtime Version does not provide the user with a method to
establish trusted locations, as do the licensed versions. For more information, please
refer to Chapter A10: Microsoft® Trusted Locations
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